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Foreword 

 

The National Vocational & Technical Training Commission (NAVTTC) developed a National Skills 
Strategy (NSS) after extensive research and consultation with experts and stakeholders including policy 
makers and representatives from Industry, Academia and the Provincial Government departments 
dealing with technical and vocational training. The strategy aims at establishing a regime that facilitates 
competency-based and demand-driven training and assessment.  
 
NAVTTC has developed competency-based training programs with the technical support of TVET Reform 
Support Programme (TVET-RSP), which is funded by the European Union, the Kingdom of the 
Netherlands, the Federal Republic of Germany and the Royal Norwegian Embassy. The Programme has 
been commissioned by the German Federal Ministry for Economic Cooperation and Development (BMZ) 
and is being implemented by the Deutsche Gesellschaft für Internationale Zusammenarbeit (GIZ) GmbH 
in close collaboration with NAVTTC. These vocational training programs have been approved by the 
National Curriculum Review Committee (having representation from all over the country from TEVTAs 
and industry) for implementation in Public and Private Training institutions. 
 
The purpose of developing competency-based training programs is to equip the learners with modern 
skills and knowledge for each of the trades to meet the requirements of local as well as international 
markets. These training programs include competency standards, qualification, curriculum, assessment 
material and teaching & learning material that will aid in implementation of competency-based and 
demand driven training in the country.  
 
This Teaching and Learning Material is part of the competency based training program exclusively 
developed to support the implementation of CBT curricula. This Material is intended for the use of learners 
undertaking training in National Vocational Certificate Level-4 in Information Technology (Computer 
Graphics - Motion) under the guidance of experts and appropriate trainers. This Teaching and Learning 
Material has been designed in consultation with industry, academia and researchers to ensure that the 
material is relevant and current.  
 
On behalf of the Federal Government/NAVTTC, I wish to express my sincere appreciation and gratitude 
to all subject matter experts, industry representatives and TVET-RSP experts who have diligently 
contributed in producing this valuable Teaching and Learning Material. 
 
 
 
 
 
 
 
 
 
 
 

Executive Director 
National Vocational & Technical Training Commission 

(NAVTTC) 
  



Introduction 

 

Computer Graphics Motion is an area in information technology that helps in producing colorful videos, 
animations, and illustrations. A Computer Graphics Motion Designer can be employed in variety of 
government and private organizations dealing with electronic media.  
 
The National Vocational & Technical Training Commission (NAVTTC) has developed a national 
qualification entitled, “National Vocational Certificate Level-4 in Information Technology (Computer 
Graphics - Motion)”. Relevant industry and employers were consulted in the design and validation 
processes in order to come up with a national qualification that fulfills the requirements of the sector in 
general and the occupation in particular.  
 
This Teaching and Learning Material (TLM) is developed based on competency standards and curriculum 
of the Computer Graphics (Motion) national qualification. It carries a learning volume of 80 credits and 
includes nine learning modules which are as under:  
 

Module 1: Familiarization with Terminologies and Tools  
Module 2: Develop Design Concept 
Module 3: Analyse Cost Effective Solution  
Module 4: Photo editing and graphics development  
Module 5: Video Editing and Motion Development  
Module 6: Prepare for rendering  
Module 7: Perform Software/ Hardware Maintenance  
Module 8: Communicate with Others  
Module 9: Duties and rights at the workplace 

 
This TLM provides support for more effective training and productive learning. Each of the learning 
modules contains learning outcomes and information regarding learning elements in the form of 
knowledge, skills and attitudes. At the end of every learning module are Frequently Asked Questions 
(FAQs) and Test Yourself which will help learners in self-assessment before proceeding to modular or 
final assessment. 
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Module 1: Terminologies and Tools 

Learning Outcomes 

After completion of this learning module, you will be able to: 

 Understand the elements of design and their application in 
different designs 

 Select respective elements of designs, all designs will contain 
most if not all the elements 

 Produce designs concept for any given product/ service, 
appropriately 

 Know colour theory and composition, how to select colours based 
on requirements or branding guidelines 

 Understand applications of design principles and the difference in 
a good or bad design 

 Use design principles (most of them if not all) to help make visual 
layout pleasing and interesting for a product or service 

 Understand how perspective is used to introduce the illusion of 
depth in an image 

 Use perspective in a design to make the design appear real by 
altering of size, location of objects on a canvas 

 Use perspective to draw attention to certain objects of interest or 
concept 

 Understand how colour in a design is very subjective 

 Know how something as simple as changing the exact hue or 
saturation of a colour can evoke a completely different feeling 
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 Interpret importance of certain colours with respect to culture and 
mood depiction 

 Use appropriate colour combination 

 Select and apply relevant colour scheme and theme 

 Understand and know in terms of colour job for printing 

 Choose appropriate fonts relating or reflecting the design concept 

 Understand the anatomy of Typeface 

 Study and make use of graphics development software 

 Study and make use of sound editing software 

 Study and make use of video editing and development software 
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Learning Unit 1: Elements of Design 

Overview 

In this leaning unit, you will learn the use of basic elements of design. Design elements are the building 
blocks used to create work art. After the completion of this learning unit, you will be able to describe 
the significance of dot, line, colour, texture, shape, size, value of tone, positive and negative spaces 
etc.  
 

1. Dot / Point  

Dot/Point is the smallest and the most basic element of design. These can be used in different sizes, 
values, colours, alone or in groups making lines or shapes in the design. Dots can be used to develop 
a pattern as if these are placed close, it gives a darker look and if placed apart, it gives lighter look. 
Many painters use patches and dots in there artwork. 

COLOUR 

RGB Colour Model 

Media that transmit light (such as television) use additive colour mixing 
with primary colours of red, green, and blue, each of which stimulates one of 
the three types of the eye's colour receptors with as little stimulation as 
possible of the other two. This is called "RGB" colour Model.  

CMYK Colour Model  

The CMYK colour model is a subtractive colour model, used in colour 
printing, and is also used to describe the printing process itself. CMYK refers 
to the four inks used in some colour printing: cyan, magenta, yellow, and 
key (black). Though it varies by print house, press operator, press 
manufacturer, and press run, ink is typically applied in the order of the 
abbreviation 

SIZE 

Size of graphic design matters as well as the size of dot, lines and other shapes makes different 
designs. 

RESOLUTION  

Resolution refers to the number of pixels in an image. Resolution is sometimes identified by the width 
and height of the image as well as the total number of pixels in the image. For example, an image that 
is 2048 pixels wide and 1536 pixels high (2048X1536) contains (multiply) 3,145,728 pixels (or 3.1 
Megapixels).  
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Resolution 

PIXEL DOTPITCH  

Dot pitch is a specification for a computer display, computer printer, image scanner, or other pixel-
based device that describes the distance, for example, between dots (sub-pixels) on a display screen. 
It is measured in millimeters. 

 

Pixel DotPitch 

Lines 

A line is a series of dots adjacent to each other. Where a dot has no dimension, a line has one 
dimension with length.  

 

Lines 

Relationship Between Line and Lines 

When two lines are joined they create an angle between them. This joint or point of connection 
becomes the starting point to move in two different directions along two different lines. Multiple joints 
create a sense of altered direction. When the angle between lines is acute (less than 90 degrees) the 
movement and change in direction is perceived to be rapid. 

Pixel 

The pixel (a word 
invented from 
"picture element") is 
the basic unit of 
programmable color 
on a computer 
display or in a 
computer image 

Pixel 
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Relation between Line and Line 
 

2. Characteristics of Lines  

The characteristics of lines are many, lines may be short or long, think or thick, straight or curved, direct 
or meandering, zigzag or serpentine, distinct or blurred. These characteristics have certain built in 
associations that the learner may make use of. 

Measure 

Measure refers to the length and width of line, its measurable properties. A line may be of any length 
and breadth. An infinite number of combinations of long, short, thick, or thin lines can, according to 
their application, unify, divide, balance or unbalance a pictorial area. Thick lines tend to communicate 
more of a sense of stability than thinner lines. Thin lines are generally more elegant, or delicate. 

Type 

There are many different types of line. If the line continues in only one direction, it is straight; if changes 
of direction gradually occur; it is curved; if these changes are sudden and abrupt, an angular line is 
created. There are some basic types of line are: 

1. Implied Line 

A series of points or figures that the eye automatically connects and forms an imaginary line, some 
examples are: 

 A trail of crumbs 

 A group of cars behind one another 

 Group of people in line at a concert 
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Example of Implied Line  

2. Psychic Line 

A psychic line has no existence at all except as an imaginary ray of light joining, for example, a person's 
eyes to the object they are looking at, or the line that extends into space from the tip of a pointing finger. 
Artists and designers use psychic lines to guide the viewer around a picture and direct their viewing 
experience.  

 

 

Psychic Line 

An invisible line from one element to another followed by our eyes and created in our minds. Some 
examples are: 

 A sign pointing in a certain direction 

 Someone’s eyes staring in a certain direction 

3. Contour Lines 

Used to make up forms and figures in a drawing. Describe the outlines in a drawing. 

TVET RSP does not secure copyright of these pictures
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Contour Lines 

4. Horizontal lines 

Lines that go from left to right convey a feeling of stillness and lack of motion or rest. Horizontal lines 
are normally associated with sleep because normally a sleeping figure is parallel to the earth 

5. Vertical Lines 

Convey a sense of height and alertness, can be associated with a person standing up. 

 

6. Diagonal Lines  

Associated with movement or lack of stability, can also indicate depth when 
using perspective. Think of a tree that has just been axed.  

A line is a mark between two points. Artists use lines to create edges, the 
outlines of objects. A line is created by the movement of the artist's pen. Line 
can be considered in two ways.  

The linear strokes made with a pen or brush or the edge created when two 
shapes meet.  

   

       Lines as Edge      Lines as Linear Strokes 

Shapes also 
communicate ideas. 
For example, an 
international 
company may use a 
circle in their logo 
that could suggest 
the earth. 

Remember 

TVET RSP does not secure copyright of these pictures

TVET RSP does not secure copyright of these pictures
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Lines act as borders between ideas, concepts and steps in sequence. 

 

 

 

By using basic structure the concepts or ideas depicted through line drawing 
are easy to understand thus they are effective in learning. 

 

 

3. Categories of Shapes  

A shape is a self-contained defined area of geometric or organic form. A shape is created when a lines 
is enclosed. Shapes have two dimensions, length and width, and can be geometric or free-form. In 
painting the design basically a planned arrangement of shapes in a work of art. All the shapes are 
divided into two categories which are described below: 

Geometric Shapes 

Geometric shapes or regular shapes are easy to recognize. Math can be used to find information about 
these shapes and these shapes generally have a specific name associated with them. Examples 
include: circle, triangle, square, and trapezoid. 

 

Organic Shapes 

Organic or freeform shapes are shapes that seem to follow no rules. Organic shapes generally do not 
have a name associated with them and are typically not man-made. 
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Positive and Negative Shapes 

A negative shape is an empty shape or space, and is the background or surround of the subject. In a 
picture the shapes that an artist places are called positive space and the spaces around the positive 
space are called negative space. A positive shape in a painting automatically creates a negative shape. 

 
Negative and Positive Space 

 

4. Direction of Lines in Concept of Graphics  

The direction of a line can convey mood or emotion. The different directions of lines used in design 
work are Horizontal, Vertical and oblique. Each of them develops different effect. 

Horizontal lines 

Horizontal suggests calmness, stability and Tranquility. They symbolize rest 
and relaxation.   

 

Vertical Lines 

Vertical gives a feeling of balance, formality and alertness. They also equate to 
power and strength.  

 

Oblique Lines 

Oblique give a feeling of movement and action. Diagonal lines are dynamic and 
action-oriented. 

 

5. Size  

Size means how big or how small should an element be in the design. When designing a piece, size 
plays an important role to make design functional, attractive and organized. 
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The first factor is should be the size of paper to be printed like for a 
brochure, what size should be appropriate. 

Second factor is to attract, you can use elements of different size in 
your design to attract your audience. 

Third factor is organization: the most important element should be largest and the element of the least 
importance should be smallest. Headings are the largest element in a text document and sub-headings 
and normal text are smallest elements. 
 

6. Texture  

Texture gives your design piece a specific look and feel. They help to develop 
a mood in the layout and help to add liveliness and activity to the design. There 
are two types of textures which are as under: 

1. Tactile Texture 

The textures that can be felt for example think about the different type of paper 
you handled.  

2. Visual Texture 

Visual texture is used to create the illusion of texture on a printed piece of design. For example, 
wallpapers etc. Pattern is a type of visual texture which is created by repeating a particular design 
element, shape or line. More dimensions can be added to the surface using light and dark elements. 
 

7. Value / Tone  

Value means the darkness or the lightness of something. It also refers to the 
colour of a design element. Every element of the design has a value. When 
laying out pages, an element's value will be affected by its background and 
other elements that are around it. For example, if you use a lot of text in a small 
area, it will make the paper look like it has turned gray. 

Value is also an important tool for expressing the theme or mood of your design. 
If you use values of black, white and gray in a design, you add power or change 

the mood of the design. 

Value also helps to develop contrast by subtly blending shades of colour. 
 

8. Positive and Negative Space  

Shapes defined by objects are positive shapes (space). Shapes defined around objects are negative 
shapes (space).The relationships between the positive and negative shapes help the brain of our 
viewers understand what they are seeing.  

 

Texture 
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Negative and Positive Space 

The negative space is defined by the edges of the positive space and the frame or border. So, part of 
our negative space is by the positive space. Sometimes the negative space is completely bounded by 
the positive space. You can understand the positive and negative space with the help of following 
shape. Take a look at the image below. Do you see faces or a vase?  

 

If you are seeing a vase, then you are seeing the white area as the positive space. The black areas 
become the negative space. If you are seeing faces, then you are seeing the black areas as the positive 
space and the white area as the negative space.          

 

Negative and Positive Space 
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Learning Activity 
 

Develop the following by using Positive and negative spaces concepts 

 

 

 

Description:   This activity requires all the students to project their design ideas using basic 
elements of the design like dots, lines, shapes, etc. 

Time Guideline: 90 Minutes 

Purpose:  To highlight the importance of design elements and their usage. 

Presentation:  
 

1. Ask the learners to select a design and project their ideas on white 
paper. 

2. Encourage the learners to make maximum use of design elements. 
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Learning Unit 2: Principles of Design 

Overview 

In this learning unit, you will learn principles of design and its implementation. After completion of this 
learning unit you will be able to define balance, recognize symmetric and Asymmetric balance, apply 
gradation, explain the importance of repetition, contrast harmony, and describe the use of dominance 
and unity.  
 

1. Balance  

Balance in design acts just like balance in Physics. If there is a large shape 
near the center than it can be balanced by a small shape near the edge. 
Balance means the weight distributed in your design by the design elements. 
Balance provides structure and support to the design. 

You can have balance in your design by adjusting the graphical weight of your 
design elements in terms of colour, size, contrast etc. 

 
 

Balance in a Design 

Balance is a 
psychological sense 
of equilibrium. 

Balance 
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There can be two types of balance in your design which are: 

1. Symmetric 

 

2. Asymmetric 

Symmetric Balance 

Symmetric balance occurs when visual weight of the design element in your design is equally divided 
either horizontally, vertically or radially. This sort of balance acts as same design element on both sides 
of the central point of design.  

  
 

Examples of Symmetric Balance 

Asymmetric Balance 

Asymmetric balance occurs when the visual weight of the design elements are not equally divided for 
the central axis of the design. This style depends upon visual weight for example it uses scale, contrast 
and colour to achieve balance in the design. In our daily life we observe many design containing big 
images offset (out of the line) with small text not at balanced locations but balanced because of visual 
games.  

  
 

Examples of Asymmetric Balance 

Informal balance is 
more dynamic than 
formal balance and 
normally keeps the 
viewer's attention 
focused on the 
visual message. 

Do you know! 
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Balance by Value 

Balance by value is achieved through small dark colour element is balanced 
with wide bright area.  

In this example the prominent fire balloon on the top right corner is balance by 
wide sky blue area surrounding it.   

Balance by Shape 

Balance by shape is achieved by complex and detailed area balanced with flat 
and simple area on the opposite side. 

In this example, one corner of the poster is tough with complex shapes and 
colours but it is balanced by the flat area around it. 

Balance by Texture 

Small area with texture looks beautiful and balanced with wide area without 
texture. 

In this example, water ripple texture appears balanced with the wide area 
without texture.  
 

2. Gradation  

Gradation gives different perspectives to objects in your design. Gradation in size means a gradual 
change from small to large. Gradation in direction means a gradual change from vertical to horizontal. 
A gradation of size and direction at the same time produces linear perspective.  

For example when we apply gradation to the size and direction, it gives an illusion of increase in 
distance.  

 

Gradation of Size and Direction Produce Linear Perspective 

Gradation can add interest and movement to a shape in your design. A gradation from dark to light will 
cause the eye to move along a shape. Gradation is one of the most useful principles of design and the 
one that can be applied most easily. 

Gradation of color 
from warm to cool 
and tone from dark 
to light will produce 
aerial perspective. 

Remember 
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Arial Perspective 

Gradation of colour and tone, from warm to cool and dark to light produce aerial perspective. As tone 
becomes lighter and colours become cooler, apparent distance increases. 
 

3. Repetition   

Repetition is a common concept in natural scenes from veins on a leaf to trees in the forest. The most 
important factor to be considered is variations in repetition. 

In the examples below, you can notice the variations in the nature’s repetition designs. 

 

Repetition 
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Repetition 

If there is no variation in a design with repetition, our brain will have just one look at the design and will 
understand that rest of the shapes are identical. That will add a monotone (unchanging) effect to the 
design. 

When variation is introduced, mental activity is required to absorb the repeating elements. This 
removes monotony and adds interest even when the variation is minor. It causes the viewer to 
subconsciously engage with the art work.  

 
 

Repetition without Variation    Repetition with Variation 
 

If you are using repeating elements as an area of relief in a design, variation is not necessary. If the 
repeating elements are to add to the interest of a design or painting, variation is important. 
 

4. Contrast  

Contrast is the juxtaposition of opposing elements. It can be a contrast in:  

 colour (opposite colours on the colour wheel),   

 value ( dark vs light ),  

 texture (smooth vs rough) or 

 direction ( horizontal vs vertical ).  
 

Juxtaposition is the 
fact of things being 
seen or placed close 
to other with 
contrasting effect. 

Do you know! 
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The major contrast should be at the center of interest in the design. Too much contrast scattered 
around in the design destroys unity, creates confusion in the design and makes it difficult to look at. 

Contrast simply tells us where to look first. Without contrast the design appears to be uninteresting, 
and hard to access because its not clear for the viewer where to look first.  

 
Contrast in Size 

While using contrast in size, small image makes large image to appear large and large image makes 
small image to appear small. 

Contrast helps objects in the design to stand out. Lack of proper contrast is the reason of simple 
camouflage.  

 
 

Improper use of Contrast created camouflage making Frog almost invisible 

 

5. Harmony  

Harmony in visual design means all parts of the visual image relate to and complement each other. 
Harmony keeps the pieces of visual elements in your design together. Repetition and rhythm develop 
harmony in your design. Repetition reemphasizes visual units,  

connecting parts and creating an area of attention. Rhythm is the flow shown in a visual. Rhythm helps 
direct eye movement. 

Camouflage is the 
use of specific 
combination of 
coloration or 
contrast for hiding 
something or 
preventing it from 
being known.  

Do you know! 
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Patterns or shapes can help achieve harmony. By repeating patterns in an 
interesting arrangement, the overall visual image comes together. 

If your composition was using wavy lines and organic shapes you would stay 
with those types of lines and not put in just one geometric shape. 
 

6. Dominance  

The principle of dominance occurs where you need to emphasize on some design element. No 
dominence between design element creates a comparison between them.  

For example if there are two red circles of equal size in your design, which should I look at first?. Every 
design should have a central and primary point that acts as the way into the design. From central point, 
design flow can be achieved by using elements with secondary or tertiary dominence. 

For example a dominent element at the center of the design develops symmetry and formal look. On 
the other hand a dominent design element close to the edge develops an out of balance design. 

 
Dominance in Size 

 

 

Dominance will 
create an entry point 
on the page from 
which you can lead 
the viewer to other 
parts of the page. 

Remember 
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In the above example, without dominence, the picture is not that interesting, our brain tries to follow 
confused paths around the photograph. 

 

By adding some dominence through a large size boat this picture is now able to direct our attention to 
the large size boat. 

 

By adding warm colours to the boat instead of dominent cool colour, the visual impact of the design is 
increased with balanced symmetry. 

You can add more visual weight to elements through: 
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 Size – As you would expect larger elements carry more weight 

 Colour – It’s not fully understood why, but some colours are perceived as weighing more than 
others. Red seems to be heaviest while yellow seems to be lightest. 

 Density – Packing more elements into a given space, gives more weight to that space. 

 Value – A darker object will have more weight than a lighter object. 

 Whitespace – Positive space weighs more than negative space or whitespace. 

 

7. Unity  

Unity means that all the components and design elements in your design 
support each other and all work together towards a common goal. 

All the elements should look like they belong to one another not that they are 
temporarily placed in the design. 

You can think of unity in two ways: 

1. Visual Unity where all the shapes or elements are aligned along the same axis and the 
colour and style of elements work together to create a meaning. 

2. Conceptual Unity where all the images in the design follow the same concept. For example 
diamond, a mansion and a pile of money together give a concept of wealth. 

 

Unit develops completeness and a single idea in the design. Too much unity in the design can develop 
dullness and lifeless effect in the design so variety must be added to create interest and energy to the 
design. Too much variety can lead towards distortion and difficulty to read. There should be a balance 
between unity and variety in the design. 

We can use the basic concepts of design to achieve unity: 

In design working 
toward the same 
unified goal is the 
idea of unity. 

Remember 
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 Contrast: Helps to add variety to unity. 

 Repetition: Things that look alike are more related to one another. 

 Alignment: Elements that appear to be on the same axis apear more related to each other. 

 Proximity: object closer to each other appear to be more related. 

Similarly our selection of colours, images, style and contrast all should conceptualy be related to the 
central idea of design. 

 

 

Learning Activity 

Understanding the importance of principle of design 

Description:   This activity consists of an assignment for each student to review the design 
developed in the previous activity keeping design principles of design in mind.  

Time Guideline: 30 min 

Purpose:  To highlight the importance of design principles. 

Presentation:  
 

Ask each student to review his previous design and make improvements 
according to the design principles. 
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Learning Unit 3: Understanding the Concept of 
Perspective 

Overview 

In this learning unit, you will learn the use of perspective to arrange elements in the design so that they 
look realistic, perspective as a learned meaning of relationship between objects, use of perspective to 
draw attention of audience towards a visual so you can achieve perspective in your design. 

 

1. Perspective  

The concept of perspective means use of techniques to draw a three dimensional scene on two 
dimensional surface as close to the real world as possible. It helps to control the illusion of depth in the 
image from a few inches to many miles. 

 
 

The Concept of Perspective 

Perspective is a great way to create realistic or measured designs.  

Perspective can be linear or atmospheric 

Linear Perspective 

Linear perspective is achieved by drawing line that converge toward and look 
like to meet at some vanishing point in the horizon. 

Horizon is also known as eye level if the person is looking straight ahead. For 
example a person sitting on a chair looking straight will not have the same 
view of the room as the person standing and looking straight.  

The objects that are parallel to each other have same vanishing point. 

Horizon is an 
imaginary line 
across the scene at 
your eye level. 

Horizon 
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  Vanishing Point as Seen from Different Horizons 

Atmospheric Perspective 

Atmospheric perspective gives a view of scene or image from top.  

   
 

Atmospheric Perspective 

Atmospheric perspective deals with how the appearance of an object is affected by looking at it through 
a layer of air. Moisture, dust and pollutants in the atmosphere act to filter the visual information. 

The changes follow the following simple rules:   

Contrast 

The contrast of the close objects is high and that of far object is low. 

Colour 

Colours are also more visible on the close objects. Warm colours also appear clearer on close objects. 
As we get farther away colours fade and eventually turn to blue and grey tone. 

Focus 

Close objects have sharper focus than the far objects as our mind sees objects with soft edges as 
farther away than the sharp edged objects. 

 

Vanishing points are 
points on the 
horizon line where 
receding lines 
converge. 

Do you know! 
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Details 

Because of the above reason the details are visible for the closer object. As the distance increases 
scene become fade making details invisible. 

 

2. Objects Relationship Perspective  

Perspective is a learned meaning of the relationship between different objects seen in space. For 
example look at the picture below. 

 
 

Visual and Perceptive Reality 

We can look at this picture as a black circle partially hidden by the red circle (a natural way). But in 
actual may be it is a half black circle placed with a red circle as shown on the right.  

In perception drawing, the concept is very much affected by what we experience in our daily lives that 
makes the design as much related to the real life as possible. 

 

3. Use of Perception to Draw Audience to a Visual  

Perspective allows the designer to use third dimension to place objects and draw the audience into a 
visual. It adds realism to the design and makes it less abstract to the audience. 

 
 

Converging Lines Indicate Distance 

This is a very useful tool when introducing a new idea or concept to the audience. The more concrete 
and less abstract a design is, easier it is to relate and understand.  



Module 1: Terminologies and Tools 

26 |                                                        Teaching and Learning Material: Information Technology (Computer Graphics - Motion)      

We can use converging lines to draw the audience vision to the vanishing point representing the main 
idea or concept. 

 
 

Drawing Audience’s Attention to a Vision 
 

4. Achieving Perception in the Design  

Perception can be achieved in your document in many ways. 

Through Relative Size Objects 

Perception can be achieved by using objects of relatively different sizes. Large size object make the 
smaller objects to look even smaller and give an effect of being far away. Similarly small object make 
the large objects look larger and give closer effect. 

 

Perception through Relative Sized Objects 
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Through Overlapping Objects 

Overlapped objects indicate the relative positions of the objects. For example from audience’s point 
of view, objects that appear on top are nearer and close while objects beneath the top object appear 
to be at a position after the top objects and are farther. 

 
 

Perception through Overlapping Objects 

Blurring or Sharpening Objects 

As seen from horizon whether in linear or atmospheric perspective, the objects or element that needs 
to appear far, are blurred in terms of contrast, colour, sharpness and details. They turn to be dull with 
blue or grey colour. The closer objects can be sharper to draw audience visual to them 

 
 

Perception through Sharpening Objects 
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Learning Unit 4: Colour Theory 

Overview 

In this unit, you will learn about the colour theory, warm colours, cold colours, and neutral colours. After 
completion of this learning unit, you will be able to define different terminologies of colour like hue, 
saturation, tones, shades and tints. 

 

1. Human Eye  

Although we see colours in our brain, it is the eye that has the receptors that 
tell your brain what you are looking at. There are two sets of receptors in the 
retina in the back of the eye: rods and cones. 

There are about 125 million rods (named for their shape). They are very 
sensitive to light but are mostly colour blind. We use them in dim light and so 
the saying: "all cats are gray in the dark." 

The colour detectors in the eye are the cones. There are about 7 million of 
these in three forms concentrated in the center of vision. Individual cones can 
only sense one of three narrowly defined frequencies of 
light: Red, Green and Blue.  

 

Colour Physics 

Colour is a property of light. Our eyes see only a small part of the electromagnetic spectrum. Visible 
light is made up of the wavelengths of light between infrared and ultraviolet radiation (between 400 and 
700 nanometers). These frequencies, taken together, make up white (sun) light. 

In the seventeenth century, Sir Isaac Newton was the first to discover phenomenon of “Light is 
separated by wavelength and a spectrum of colour formed”. 

 

Colour Physics 

If the ends of the spectrum are bent around and joined a colour circle (colour wheel) is formed with 
purple at the meeting place. 

 

 
Color Physics 

Power of Red 
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Colour 

Colour has three distinct properties: hue, value and saturation. To understand colour you must 
understand how these three properties relate to each other. You will do a project exploring each in this 
part of the course. 

Hue 

The traditional colour name of a specific wavelength of light is a hue. Another description is: spectral 
colour. All of the colours of the spectrum are hues. There are only limited hue names: red, orange, 
yellow, green, blue and violet. Magenta and cyan are also hues.  

Value 

Value is concerned with the light and dark properties of colour. All colours exhibit these properties. The 
hues have a natural value where they look the purest. Some colours, like yellow, are naturally light. 
Some, like violet, are darker. 

Saturation 

Saturation is concerned with the intensity, or the brightness and dullness of colour. A saturated colour 
is high in intensity -- it is bright. A colour that is dull is unsaturated or low in intensity. Another term for 
saturation is Chroma. A colour without any brightness (no hue) is achromatic (black, white and/or 
gray. 

The colour wheel diagrams the relationship between hues (around the outside) and saturation (center 
to outside). It is the territory in the center of the colour wheel that must be understood in order to be 
able to control the brightness of colours. 

  

Saturation 

The triangle diagrams the relationship between value (vertically) and saturation (horizontally). 

Colour Theories 

There are two theories that explain how colours work and interact. 

Light Theory 

Light theory starts with black -- the absence of light. When all of the 
frequencies of visible light are radiated together the result is white (sun) light. 
The colour interaction is diagramed using a colour wheel 
with Red, Green and Blue as primary colours. Primary here means starting 
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colours. These are the three colours that the cones in the eye sense. This is an RGB colour system 
(Red, Green and Blue). 

Pigment Theory  

Pigments behave almost the opposite of light. With pigments a black surface 
absorbs most of the light, making it look black. A white surface reflects most 
of the (white) light making it look white. A coloured pigment, green for instance, 
absorbs most of the frequencies of light that are not green, reflecting only the 
green light frequency. Because all colours other than the pigment colours are 
absorbed, this is also called the subtractive colour theory. 

The primary colours in the pigment theory have varied throughout the centuries 
but now Cyan, Magenta and Yellow are increasingly being used. These are 

the primary colours of ink, along with black, that are used in the printing industry. This is a CMYK colour 
system (Cyan, Magenta, Yellow and (K) black). These are the  

 

Secondary Colours of the Light Theory 

Colour Interaction 

Much has been said about how colours interact. You rarely see only one colour. When you see two or 
more colours together they have a profound effect on one another. There are a lot of different 
possibilities but these three examples will suffice: 

 

In this example the center bar experiences a hue shift. 

 

In this example the center bar seems to changes in value. 

 

In this example the center bar appears to change in saturation 
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Colour Temperature 

The colour wheel is useful in that it shows the relationship between warm and cool colours. This is 
called colour temperature and relates to the sense of temperature each colour imparts. 

The colours on the red side of the wheel are said to be warm because they are associated with warm 
phenomena. The green side implies cool phenomena. These colour temperature designations are 
absolute. 
 

2. Warm Colours  

Warm colour makes you think of sunlight and warmth. Warm colours include 
red, orange, yellow and the variations of these three colours.  Red and yellow 
are both primary colours, and the orange colour comes in the middle, which 
means warm colours are all truly warm and aren’t created by combining a 
warm colour with a cool colour. Warm colours are used to reflect happiness, 
passion, enthusiasm, and energy in your design. 

 

 

Red (Primary Colour)  

Red is a very hot colour. It is associated with fire, violence and warfare. It is also associated with 
importance. 

Red colour has physical impact on human; it raises blood pressure and respiratory rate. Red colour 
can also be associated with anger and danger as well. 

 

Red colour acts very powerful in a design. It can have an overpowering effect if it’s used too much in 
designs. It’s a great colour to use when power or passion want to be shown in the design.  

 

Orange (Secondary Colour) 

Orange is a vibrant and energetic colour. It is associated with earth and autumn. As orange describes 
change of season, it can be thought of to be a sign of change and movement. As orange is also a 
name of a fruit so it can be associated with health and energy. Orange colour takes attention without 
being overpowering like red.  
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Yellow (Primary Colour) 

Yellow is considered to be the brightest and most energizing of the warm colours. Yellow colour can 
be associated with hope and to some extent for danger. 

In your designs, bright yellow can develop a feeling of happiness and cheerfulness.  Softer yellows are 
commonly used as a gender-neutral colour for babies and young children. Dark yellows and gold-hued 
yellows can sometimes look antique so we can use these colours in the designs where we want to give 
an effect of long life and stability. 

 

3. Cool Colours  

 

Cool colours are the colour which are related to night, water, nature. Cool colours are calming, 
relaxing and closer to nature. 

Cool colour include green, blue and purple. Among the cool colours, blue is the only primary colour. 
Other colours are created by combining blue colour with some warm colour. For example blue with 
yellow for green and with red for purple colour. 

Cool colour develop a feeling of relaxation and clamness in your design. 

 

Green (Secondary Colour) 

Green colour is the sign of growth, renewal and beginning. Green colour can also represent lack of 
experience. Green colour is calm like blue but it also have energizing effect of yellow. It has a balancing 
and harmonizing effect. It can used  in the designs representing wealth, stability, renewal and nature. 

 

Blue (Primary Colour) 

Blue is used to represent calmness and responsibility. Light blues can be refreshing and friendly. Dark 
blues are more strong and reliable. Blue is also associated with peace. 

The meaning of blue is affected depending on the shade and hue. In design, the exact shade of blue 
you select will have a huge impact on how your designs are perceived. Light blues are often relaxed 
and calming. Bright blues can be energizing and refreshing. Dark blues are excellent for corporate sites 
or designs where strength and reliability are important. 
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Purple (Secondary Colour) 

Purple is associated with royality. It’s a combination of red and blue, and has the attributes of both. It’s 
associated with creativity and imagination. 

In Thailand, purple is the colour of mourning for widows. Dark purples are traditionally associated with 
wealth and royalty, while lighter purples are considered more romantic. 

In design, dark purples can give a sense wealth and luxury. Light purples are softer and are associated 
with spring. 

 

4. Neutral Colours  

Neutral colours often serve as the backup colours in design. They’re commonly combined with brighter 
colours. But they can also be used on their own in designs, and can create very sophisticated layouts. 
The meanings and impressions of neutral colours are very much affected by the colours that surround 
them in the design. 

Black 

Black is the strongest neutral colour. On the positive side, it’s commonly associated with power, 
elegance, and formality. On the negative side, it is associated with evil, death, and mystery. Black is 
the traditional colour of mourning in many countries. 

Black is commonly used in edgier designs, as well as in elegant designs. It can be conservative or 
modern, traditional or unconventional, depending on the colours it’s combined with. In design, black is 
commonly used for typography and other functional parts, because of its neutrality. Black can also be 
used to add a sense of sophistication and mystery in your design. 

White 

White is at the opposite of black, but like black, it can be used successfully with any other colour. White 
is associated with purity, cleanliness, and virtue. In the West, white is commonly worn by brides on 
their wedding day. It is also associated with the health care industry, especially with doctors, nurses 
and dentists. White colour is associated with goodness, and angels are also portrayed in white. 

When white is used with other colours in design, it increases their effect. It gives a feeling of cleanliness 
and simplicity. White can represent winter or summer depending upon the colour it is used with. 

Gray 

Gray is a neutral colour, gives a cool effect. Light grays can be used in place of white in some designs, 
and dark grays can be used in place of black. 

Gray adds a formal effect to design, but can also be modern. It’s commonly used in corporate designs, 
where formality and professionalism are important. It can be a very sophisticated colour. Pure grays 
are shades of black, gray shades may also have brown or blue effect in them. In design, gray 
backgrounds and gray typography are very common. 
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Brown 

Brown is the colour of the earth, wood, and stone. It is a completely natural colour and a warm neutral. 
Brown can be associated with dependability and reliability. It can also be considered dull. 

In design, brown is commonly used as a background colour. Sometimes used in wood textures and 
sometimes in stone textures. It helps bring a feeling of warmth to designs.  

Beige and Tan 

Beige is a unique colour, as it can take on cool or warm tones depending on the colours around it. It 
has both the warmth of brown and the coolness of white. It is mostly used for backgrounds and is 
commonly seen in backgrounds with a paper texture. It will take on the characteristics of colours around 
it, has little effect in itself on the final impression a design gives when used with other colours. 

Cream and Ivory 

Ivory and cream are sophisticated colours. They have a little warmth of brown and a lot of the coolness 
of white. These colours are normally quiet, and give a sense of history.  

In design, ivory can add a sense of elegance and calmness. It can also be used to lighten darker 
colours. 
 

5. Concepts and Terminologies of Colour  

The properties of colour help us to define a colour. The better you understand these terminologies the 
better you will be able to adjust the colours according to your needs. Following colour terminologies 
are important. 

Hue 

Hues are the family of twelve purest and brightest colours. 

 Three Primary Colours 

 Three Secondary Colours 

 Six Tertiary Colours  

These colour make the full spectrum of primary colour wheel. From these 
twelve colours you can make infinite number of colour schemes by mixing 

these hues with other colours. 

They can also be used in their purest form too, making a multicolour exciting and cheerful theme. For 
example children rooms or corners in your advertisement to gain attention 

Tones 

All the colours we see around us in the world are toned a little or more. This 
makes them even more pleasing. Tone is created by adding grey to a colour. 
Any colour that is “greyed down” is said to be toned. Tones are more 
interesting because they are complex and sophisticated. Painters add a little 
grey to each colour to adjust the value and intensity. 

 

 

Hue 

 

Tones 
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Saturation 

Saturation can also be called intensity of a colour. It is a measurement of difference from a pure colour 
to pure grey colour. Saturation is not exactly about light and dark, but it means how pale or strong the 
colour is. The saturation of a colour is not the same, but it changes depending on the surroundings and 
what light the colour is seen in. 

Shades 

Shades are created by adding black to a colour. You can mix hue colour 
together and add a little black to it making the shade on the mixture. Shades 
vary from the darkest even black to pure hue colour. 

Artists don’t use shades often because black can destroy the main colour 
quickly. Shades are deep, powerful and mysterious. Too much use of black 
can add overpowering. 

Chroma 

Chroma is the perceived strength of a colour, the degree of visual difference from a neutral grey of the 
same lightness. Chroma is defined as "colourfulness" of an object relative to the brightness of a white 
object similarly illuminated. 

Tints 

Tints are created by adding white to a colour. For a complex tint, mix the 
desired colours from hues and then add a little white to it.  

Tints can vary from pure hue colours to extremely pale or nearly white colour. 
Artists use tints to give a little body to the colours.  

Value 

Value refers to the lightness or darkness of a colour. It indicates the light 
reflected. 

 
  

 

Shades 

 

Tints 
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Learning Unit 5: Typography 

Overview 

In this module, you will learn about concept of typography, the expressions of different fonts, their 
families and the use of typography in design. After completion of this learning unit, you will be able to 
choose a typeface, make it work with layout, colour scheme and grid design theme. 

 

1. Typography Anatomy, Expression of Different Fonts, their Families and its 
Use in Graphics Design  

Typography  

Typography is, quite simply, the art and technique of arranging type in your design. Typeface anatomy describes 
the graphic elements that make up printed letters in a typeface. In order to become skilled in typography, you 
need to learn the basic rules. 

Anatomy of Typography 

Counter 

Fully or partially enclosed space within a letter.  

 

Aperture 

Opening at the end of an open counter. 

 

Arm 

A horizontal stroke not connected on one or both ends. 

 

Ascender 

An upward vertical stroke found on lowercase letters that extends above the 
typeface’s x-height.  

 

Baseline 

The invisible line where letters sit. 

 

Bowl 

A curved stroke that encloses a letter’s counter. 
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Crossbar 

A horizontal stroke. 

 

Descender 

A downward vertical stroke found on lowercase letters that extends below the 
baseline. 

 

Diagonal Stroke 

An angled stroke. 

 

Ear  

A small stroke projecting from the upper right bowl of some lowercase g’s. 

 

Finial  

A tapered or curved end. 

 

Ligature 

Two or more letters are joined together to form one glyph. 

 

Link  

A stroke that connects the top and bottom bowls of lowercase double-story g’s. 

 

Loop  

The enclosed or partially enclosed counter below the baseline of a double-story 
g. 

 

Lowercase  

The smaller form of letters in a typeface. 
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Serif 

“Feet” or non-structural details at the ends of some strokes. 

 

Shoulder 

A curved stroke originating from a stem. 

 

Small Caps 

Uppercase characters that appear as a smaller size than the capital height of a 
typeface. Short for “small capitals”. 

 

Spine  

The main curved stroke for a capital and lowercase. 

 

Spur 

A small projection from a curved stroke. 

 

Stem 

Primary vertical stroke. 

 

Tail 

A descending stroke, often decorative. 

 

Terminal 

The end of a stroke that lacks a serif. 

 

Uppercase 

A letter or group of letters of the size and form generally used to begin sentences 
and proper nouns. Also known as “capital letters”. 
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x-height 

The height of the main body of a lowercase letter. 

 

Font Families Expressions and their Use in Design  

Below are the most used families in design works. 
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2. Colour Scheme and Design Theme (Typeface, Layout, Grid)  

Following are the most important typographic considerations that a designer should keep in mind while 
choosing an appropriate font for the design. 

Readability 

The type is to read so try hard not to make is difficult to read by using tiny font sizes, crowded line-
height or simple plain ugly looking font.   

Size 

All the typefaces are not equally created. Some are fat and wide others are thin and narrow. Different 
typefaces occupy different space in the design. So it is important to choose the right type size that fits 
perfectly in the design. 

The most common method to measure the size is point. One point is equal to 1/72 inches. Type size 
may also be measured in inches, pixels and millimeter.  

Leading 

Leading is the vertical distance between the lines of type. If there is rich text in your design, in order to 
make it comfortable to read, use leading greater than the font size used. Normally it is 1.25 to 1.5 times 
of the font size. 

Tracking and Kerning 

Kerning means adjusting the space between characters to develop a harmonious effect. For example 
when an uppercase A meets uppercase V. Their diagonal strokes are kerned so that the top left of V 
sits at the bottom right of A. 

Tracking deals with the spacing of all the character and is applied evenly. 

Measure 

Measure means the width of the text block. It is important for a good reading experience. 

 

 

 

Leading 
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Hierarchy and Scale 

If all the text is of same size then reader will not be able to know which of the text was most important 
so to guide the reader, headings are a bit larger in size, then sub headings are a bit smaller and the 
regular type is even smaller. 

Colour Scheme 

While adding type to your design colour scheme is very important part. It is not only about the overall 
look of the design but also about the readability of text. For example black text on white background is 
known to be the most readable format. Whatever colour scheme you use, make sure the type is 
readable. 

Grid 

Using grid helps you a lot in formulating the layout of your design. If you use the best font, spacing and 
colours but the layout is not good then your design will be distorted and hard to understand. 

Fonts 

When choosing a font for your website, your font should be unique. Not only unique but the font should 
also work well with the design theme and the real feeling of the design. 
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Learning Unit 6: Tools and Software for Graphics and 
Artwork Creation 

Overview 

In this unit, you will learn about and use tools in different graphic software like, Tools in Adobe 
Photoshop for creating and editing images, graphics, pictures, etc. Tools in Adobe Illustrator for 
creating and editing type, and text/shapes, tools in Corel Draw. Tools in Adobe Premiere used for 
collecting, arranging and editing videos. 

 

1. Procedures of Using Tools in Adobe Photoshop 

Adobe Photoshop is the most commonly used photo editing software used in 
the world. When you start Photoshop, the Tools panel appears at the left of the 
screen. You can expand some tools to show hidden tools beneath them. A 
small triangle at the lower right of the tool icon signals the presence of hidden 
tools. 

 

 

Adobe Photoshop is 
a raster graphics 
editor developed 
and published by 
Adobe Systems for 
Macs and Windows 
PCs. 

Adobe Photoshop 
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Open an image in Adobe Photoshop as 

 

1- Open Adobe Photoshop and click at File->Open 
2- Select the image file to be opened and click at open. The file will be opened in Adobe Photoshop 

and now you can use different tools on it. 

Using Selection Tools 

Marquee Tool (make rectangular, elliptical, single row, and single column selections.) 

1- Select the marquee tool by clicking at the icon in the toolbox. 

 

2- Clicking and holding on the Marquee icon will give you a small popup menu where you can 
select the variations: Rectangular marquee, Elliptical marquee, for selecting circles and ovals 
and a single-pixel marquee for both horizontal and vertical. 
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3- For now, select the Rectangular marquee, place your cursor somewhere in the upper left of the 
image, then click and drag the mouse. You will see the selection expands with the pixel values 
to the right of the selection. 

4- From here, you can copy the selection, move it, and apply filters to it. Almost everything you do 
in Photoshop starts with a selection. 

Lasso Tool (make freehand, polygonal (straight-edged), and magnetic (snap-to) selections.) 

1- Select lasso tool from toolbox. Its variants include the Polygonal Lasso tool, and the Magnetic 
Lasso tool. 

 

2- Click and hold the mouse button and then draw around some object on the image. As you reach 
the last point, release the mouse button and the selection will auto-complete. 

 

3- Polygon Lasso Tool works in the same way. Click at some point after selecting polygon lasso 
tool. As you move your mouse you will notice that the starting point is pinned and a dashed line 
extends towards cursor. Click again, and that next point becomes pinned. You can continue 
clicking until your selection is complete. At the end double click and the selection will auto 
complete. 

4- Press the Escape key at any time to cancel the selection in progress. 
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Using the Crop Tool (The Crop tool trims images) 

 

1- Select the crop tool from toolbox as 
2- To crop an image, either drag the handles to surround the part of the image you wish to keep, or 

click and drag inside the image to draw the area to crop.  

 

3- Then press Enter 

 

Using the Text Tool   Select the text tool from toolbox 

1- Click anywhere in the image, a box with a blinking cursor will appear. 
2- Adjust the font setting at the top. Containing, font size, family, color, wrap, justification etc. 
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Using the Brush Tool (Paints the brush strokes) 

1- Select the brush tool from toolbox as 

 

2- Pick a color for the brush by clicking at the foreground color chip a color picker window will 
appear. Select a color. 

3- Select the size and softness of brush from top left corner 

 

4- Draw the strokes on the canvas. 

Using the Clone Stamp Tool (paints with a sample of an image.) 

1- Select the clone stamp tool from toolbox. 
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2- Select the brush type from the top left corner. 

 

3- Before you can clone the image, you need to select what you're actually copying. Holding down 
the Option (Alt) key, and click on the image about where you want to set the source as shown 
by the red target. 

4- Click and hold the mouse button and paint on the other side of image as shown in the about 
right image. 

Using Spot Healing Brush (paints with a sample or pattern to repair imperfections in an image.) 

1- From the toolbar, select the spot healing brush. 
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2- Alt-click (click holding down [Alt] key) somewhere on your image to define a sampling point. 
3- Paint with the Healing Brush Tool on the damaged area. 

Using Dodge Tool (lightens areas in an image.) 

 

1. Select the Dodge tool from toolbox. 

 

2. Adjust the size, hardness and exposure in the brush palette. 
3. Drag the dodge tool on the image and it will lighting effect on the image as in the below image 

a lighting effect is added at the white boat. 
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2. Using Tools in Adobe Illustrator for Creating & Editing 

Type on a Path 

1- Open Adobe Illustrator. 
2- Open your image as File->Open->Click at the image->Open. 
3- Draw a straight line using pen tool from the Tools Panel. 
4- Select convert anchor point tool, and drag the handles of one anchor point to a 45 degree 

angle. This will create a small arc. 

 

5- Hold the mouse on the Type Tool (T) in the Tools Panel to view the fly out menu. Select the 
Type on a Path Tool and click on the top of the arc in the image. 

 

6- From the top menu, choose Window > Type > Paragraph. In the Paragraph Menu, select Align 
Left. Type a phrase and the text will begin on the left side of the arc and follow the path. 
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7- To move the text on the path, select the Direct Selection Tool (A) from the Tools Panel and 
click on the left bracket (near the anchor point). A small perpendicular icon will appear. 

 

Text on a shape 

1- Draw a circle using the Ellipse Tool from the Tools Panel. Select the Type on a Path Tool as 
before in above method. 

 

2- Click on the top center of the circle and begin typing. Again, use the brackets and perpendicular 
icon to drag the text along the circle. 
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3- Repeat the same steps for text on polygon, square etc. 
 

Create a Text Box 

 

1- Select type tool Icon from Toolbar 
2- Drag mouse to create the size of your text area. 
3- Type the text in text box. 

 

 

Changing Font Color 

1- To change your font color, look at the color icon, you will see a fill and stroke. Click at the part 
you want to change color, for example, if you want to change a fill color, click at fill icon before 
choose a color. Below picture shows a font with fill color and stroke set to none. 
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2- The below picture shows text with stroke only. 
3- To change the font color, click on your font and then select which part you want to change (fill 

or stroke). Select the color from Color panel. 

 

Character Panel 

This is a panel in Adobe Illustrator where you can alter the appearance of your type character by 
character.  

 

1- Open character panel as window->type->character 
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2- In the character panel, you can make following changes 

 

 Font family (in this case Myriad Pro) 

 Font style (version of the font such as Regular, Bold, Light, Condensed etc.) 

 Leading (line-height) 

 Kerning (spacing between two characters) 

 Tracking (character spacing across a selection) 

 Horizontal scale (character width) 

 Vertical scale (character height) 

 Baseline shift (height of baseline upon which text sits) 

 Character rotation (rotation in degrees of specified characters) 
 

Paragraph Panel 

 

1- Open paragraph panel as window->type->paragraph 
2- You can make following changes to paragraph in this panel 
3- You can change here indentation, alignment, and spacing above and below paragraphs. 
4- You can also put hyphenation On or Off. 
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3. Using Tools in Corel Draw  

 

Snap to Grid 

To force an object that is being drawn or moved to align automatically to a point on the grid, a guideline, 
or another object.  

1. Click View Snap to objects setup. 

 

Snapping 
Mode 

Description 
Snap 

Indicator 

Node  Snap to an object’s node   

Intersection  Snap to a geometric intersection of objects   

Midpoint  Snap to a line segment midpoint   

Quadrant  
Snap to points that are at 0°, 90°, 130°, and 270° on a circle, ellipse, 
or arc   

Tangent  
Snap to a point on the outside edge of an arc, circle, or ellipse 
where a line will touch but not intersect the object   

Perpendicular  
Snap to a point on the outside edge of a segment where a line will 
be perpendicular to the object   

Edge  Snap to a point that touches the edge of an object   
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Center  
Snap to the center of the closest object (arc, regular polygon, or 
curve centroid)   

Text baseline  Snap to a point in the baseline of artistic or paragraph text   

Working with Basic Shapes 

There are four basic shapes in Corel Draw which are: 

1. Freehand Tool            
2. Rectangle Tool 
3. Ellipse Tool  
4. Polygon Tool 

 

 

 

Command Effect 

The Weld Command 

 



Module 1: Terminologies and Tools 

56 |                                                        Teaching and Learning Material: Information Technology (Computer Graphics - Motion)      

The Trim Command 

 

The Intersect Command 

 

Pick Tool Selection 

1. Click at the pick tool from the toolbox. 
2. Click at the object. 
3. Now you can resize the object by dragging the handles. 

 

 

Move Object  

1. Click at the object. 
2. Click and drag the object to desired location. 
3. Leave the mouse. 
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Rotate Object 

1. Double click the Object. 
2. The handles will change into double headed arrows.  
3. Click and drag any arrow to rotate from that corner. 
4. Hold Ctrl key to rotate with 15 degree angle increments. 

 

 

Skew Object  

1. Double click the rectangle. 
2. Double-ended selection arrows will appear.  
3. Click and drag on one of the side handles to skew the 

rectangle. 
4. Release mouse button when desired effect is created. 

 

Shape Tool Selection 

1. Draw a rectangle.  
2. Choose the Shape Tool from the Toolbox and click on 

the rectangle.  
3. Note the selection now appears as four corner handles 

and dotted lines. This indicates that the object is active 
with the Shape Tool.  

4. Click and drag on one of the corner handles. Note how 
the corners become round. 

Create Rectangle  

1. Choose Rectangle Tool.  
2. Click and drag to create rectangle of the shape and 

size you desire. 

Create and Ellipse or Circle 

1. Click at ellipse tool from toolbox. 
2. Draw an ellipse or hold down ctrl button and draw a circle. 
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Create a Spiral Object 

1. Choose Spiral tool from toolbox. 
2. Draw a spiral by holding and dragging mouse. 

  

Smudge Brush  

Change the shape of an object by dragging along its outline.  

1. Click at the smudge brush in toolbox.  
2. Click at the inner side of shape to move it inwards 
3. Click at the outside of shape to move it outwards 

Roughen Brush Tool 

Distort the edge of an object by dragging along its outline. 

1. Click at roughen brush tool in toolbox.  
2. Point the brush along the outline of object to rough its outline. 

Twirl Tool   

Add swirl effects by dragging along the outline of an object. 

1. Click at twirl button in toolbox.  
2. Click at the object’s outline and hold until twirl is of desired size. 

 

Knife Tool 

Slice an object to split it into two separate objects. 

1. Click at knife tool. 
2. Point the knife at the outline of the object where to want to start cutting. 
3. Click and drag the knife along the path towards the target point. 
4. Release the mouse. 
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Eraser Tool  

Remove unwanted areas in a drawing. 

1. Click at the erase tool.  
2. Drag over the part of object where you want to erase. 

Bezier tool  

Draw curves one segment at a time. 

1. Select the Bezier tool.  
2. Start drawing by clicking at drawing area. 
3. To draw a straight line point to the end point and click. 
4. To draw a curve, drag to define it.  
5. Use shape tool to redefine the shape later. 

Blend Tool 

Blend objects by creating a progression of intermediate objects and colours. 

1. Draw to objects in the drawing. 
2. Select the blend tool. 
3. Click at the first object and then drag towards the second object. 

 

4. A series of blended objects will be created from starting point to ending point. 
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4. Adobe Premiere - Work Interface 

 

Interface of Adobe Premiere 

Each workspace item appears in its own panel, and multiple panels can be combined into a single 
frame. Some items with common industry terms stand alone, such as Timeline, Audio Mixer, and 
Program Monitor. The main user interface elements are as follows: 

1. Timeline Panel:  

This is where you’ll do most of your actual editing. You view and work on sequences (the term 
for edited video segments or entire projects) in the Timeline panel.  

2. Tracks:  

You can layer or composite video clips, images, graphics, and titles on an unlimited number of 
tracks. Video clips on upper video tracks cover whatever is directly below them on the Timeline. 
Therefore, you need to give clips on higher tracks some kind of transparency or reduce their 
size if you want clips on lower tracks to show through. 

3. Monitor Panels:  

You use the Source Monitor (on the left) to view and trim raw clips (your original footage). To 
view a clip in the Source Monitor, double-click it in the Project panel. The Program Monitor (on 
the right) is for viewing your sequence.  

4. Project Panel: 

This is where you place links to your project’s media files: video clips, audio files, graphics, still 
images, and sequences.  

5. Media Browser: 

This panel helps you browse your hard drive to find footage. It’s especially useful for file-based 
camera media. 

 

TVET RSP does not secure copyright of these pictures

TVET RSP does not secure copyright of these pictures
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6. Effects Panel:  

This panel contains all the clip effects, you will use in your sequences, including video filters, 
audio effects, and transitions (docked, by default, with the Project panel). Effects are grouped 
by type to make them easier to find. 

 

Effect Panel 

7. Audio Mixer:  

This panel (docked, by default, with the Source and Effect Controls panels) is based on audio 
production studio hardware, with volume sliders and panning knobs. There is one set of controls 
for each audio track on the Timeline, plus a master track. 

 

Audio Mixer 

8. Effect Controls Panel: 

This panel (docked, by default, with the Source and Audio Mixer panels, or accessible via the 
Window menu) displays the controls for any effects applied to a clip you select in a sequence. 
Motion, Opacity, and Time Remapping controls are always available for visual clips. Most effect 
parameters are adjustable over time, allowing you to animate effects. 
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9. Tools Panel: 

 Each icon in this panel represents a tool that performs a specific function, typically a type of 
edit in a sequence.  

10. Info Panel:  

The Info panel presents information about any asset you select in the Project panel or any clip 
or transition selected in a sequence. 

11. History Panel:  

This panel tracks the steps you take and lets you back up easily. It is a kind of visual Undo list. 
When you select a previous step, all steps that came after it are also undone. 

 

5. Sound Forge Pro for Audio – Work Interface  

Sound Forge Pro is the application of choice for a generation of creative and prolific artists, producers, 
and editors. Record audio quickly on a rock-solid platform, address sophisticated audio processing 
tasks with surgical precision, and render top-notch master files with ease. 

 

Work Environment of Sound Forge Pro 
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1. Menu Bar 

Displays the menu headings for the available functions. 

2. Standard Toolbar 

Provides quick access to some of the most common tasks in the application.  

3. Transport Bar 

Provides quick access to basic audio transport functions.  

4. Status Bar 

Help and processing information is displayed on the left side. The boxes on the right side display 
the playback sample rate, bit de path, channel configuration, length of the active data window, 
CD time remaining, and total free storage space. 

5. Workspace 

This is the area located behind the data windows. Audio selections dragged to the workspace 
automatically become new data windows. Windows such as the Regions List and Playlist can 
be docked along the edges of the workspace or in floating window docks. 

6. Channel Meters 

Displays the level of the output audio signal. These meters can be toggled on/off by choosing 
Channel Meters from the View menu. Right-clicking the channel meters displays a shortcut 
menu that allows you to precisely configure the appearance of the meter. 
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Summary of Module 

  Dot/ Point is the smallest and the most basic element of design which catch the attention. A 
line is a series of points. A shape is a self-contained defined area of geometric or organic 
form. 

  Horizontal suggests calmness; Vertical gives a feeling of balance, formality and alertness. 
Oblique give a feeling of movement and action. 

  Size means how big or how small should an element be in the design. Texture gives your 
design piece a specific look and feel. Value means the darkness or the lightness of 
something. It also refers to the colour of a design element. 

  You can have balance in your design by adjusting the graphical weight of your design 
elements in terms of colour, size, contrast etc. Gradation applies to the incremental change 
in the state of a design element. 

  Contrast simply tells us where to look first. Harmony in visual design means all parts of the 
visual image relate to and complement each other. The principle of dominance occurs where 
you need to emphasize on some design element. 

  Perspective means use of techniques to draw a 3 dimensional scene on 2 dimensional 
surfaces. 

  Warm colour make you think of sunlight and warmth. Cool colours are calming, relaxing and 
closer to nature. Neutral colours often serve as the backup colours in design. 

  Hues are the family of twelve purest and brightest colours. Tone is created by adding grey 
to a colour. Saturation can also be called intensity of a colour. Shades are created by adding 
black to a colour. Tints are created by adding white to a colour. Value refers to the lightness 
or darkness of a colour. 

  Typography is, quite simply, the art and technique of arranging type in your design. While 
choosing a type for your design. you need to keep in mind the readability, size, leading, 
measure, hierarchy, colour scheme, grid and font etc. 
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Frequently Asked Questions (FAQs) 

FAQ 1:  What is straight line? 

Answer: 
The notion of line or straight line was introduced by ancient mathematicians to 
represent straight objects having no curvature with negligible width and depth.  

FAQ 2:  What is a Mechanical shape? 

Answer: 
Mechanical shapes are those made with straight lines, circles and/or parts of circles -- 
the shapes you can make with a ruler and a compass. These are man-made shapes 
sometimes called geometric shapes. 

FAQ 3:  

Identify positive and negative spaces in the following shape? 

 

Answer: 

Positive and negative spaces are Label as below. 

 

FAQ 4:  What feelings do the directions of lines convey? 

Answer: 
Horizontal lines convey the feeling of relaxation and calmness. Vertical lines give a 
feeling of balance and formality. Oblique lines give a feeling of movement and action. 

FAQ 5:  What are the types of texture? 

Answer: 
There are two types of texture. Tactile texture is a texture that can be felt. Visual texture 
is the illusion of texture printed on paper. 

FAQ 6:  How can we achieve balance in the design? 

Answer: 
Balance can be achieved in design by adjusting the graphical weight of the design 
elements in terms of colour, size and contrast. 
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FAQ 7:  What are the types of balance? 

Answer: Symmetric Balance and Asymmetric Balance.  

FAQ 8:  

Identify dark to light perspective concept in the following shapes?  

 

Answer: 

The label shows the dark to light perspective concepts 

 

FAQ 9:  What is gradation and what happens when we apply gradation by size and direction? 

Answer: 
Gradation means the gradual change. When we apply gradation to the size and 
direction, it gives an illusion of increase in distance. 

FAQ 10:  Why is variation important in repetition? 

Answer: 
If there is no variation in a design with repetition, our brain will have just one look at the 
design and will understand that rest of the shapes are identical. That will add a 
monotone effect to the design. 

FAQ 11: Where can we apply contrast in design? 

Answer: 
Contrast can be used in colour (opposite colours on the colour wheel), in value ( dark 
vs light ), in texture (smooth vs rough) or in direction ( horizontal vs vertical). 

FAQ 12: Define Harmony? 

Answer: 
Harmony in visual design means all parts of the visual image relate to and complement 
each other. 
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FAQ 13: What are the types of unity? 

Answer: 
Visual Unity where all the shapes or elements are aligned along the same axis and the 
colour and style of elements work together to create a meaning. 
Conceptual Unity where all the images in the design follow the same concept. 

FAQ 14: How to achieve perception in design? 

Answer: 
Perception can be achieved through the use of relative size objects, overlapping 
objects, blurring or sharpening objects. 

FAQ 15: What is the effect of different colours in design? 

Answer: 
Warm colours make you think of sunlight and warmth. Cool colour. Cool colours are 
calming, relaxing and closer to nature. Neutral colours often serve as the backup colours 
in design 

FAQ 16: What is typography? 

Answer: Typography is the art and technique of arranging text in your design. 
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key 
at the end of this module. 

1.  Which of the following is NOT a design element? 

a.  Line b.  Balance 

c.  Point d.  Shape 

2.  Which of the following is an organic shape? 

a.  Square b.  Triangle 

c.  Tree d.  Circle 

3.  How is the negative space added to the design. 

a.  Artist adds negative space  himself b.  
Positive space automatically creates 
negative space 

c.  
Developed by the colour around the 
shape 

d.  Present inside the positive shape 

4.  Tactile texture is _____________. 

a. The texture that is of bright colours b. The texture that can be seen 

c. The Texture that can be felt d. 
The texture that can be used at many 
places 

5.  ________________ is the illusion of texture printed on paper. 

a. Tactile Texture. b. Natural Texture 

c. Artificial Texture d. Visual Texture 

6.  
In __________________ visual weight of the design element in your design is 
equally divided. 

a. Symmetric Balance b. Asymmetric Balance 

c. Balance by value d. Balance by shape 
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7.  Gradation means. 

a. Decrease in size of object b. Increase in size of object. 

c. Gradual Increase in distance d.  Gradual change in the state of objects 

8.  Using variations, we can avoid ___________ in repetition. 

a. Distortion  b. Monotone effect 

c. Ambiguity  d.  Balance  

9.  Lack of ___________ is the reason of camouflage. 

a. Repetition b. Balance 

c. Unity d.  Contrast 

10. Conceptual unity means __________________. 

a. 
All the images in design following the 
same concept 

b. 
All the images in design are at the 
same location 

c. All the images have the same colour d.  All the images have the same contrast 

11. Unity is important in design to _______________. 

a. Make design Unique b. Change the overall look 

c. Convey a single idea d.  Dominate and element 

12. _____________ are on the horizon line where receding lines converge. 

a. Convergence  b. Atmospheric Perspective 

c. Linear Perspective d.  Vanishing Points 

13 Find the INCORRECT option, Perspective can be achieved through. 

a. Relative size objects b. Introducing vanishing points 

c. Overlapping Objects  d.  Blurring and sharpening Objects 
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14. _________________ is created by adding a little black to a colour. 

a. Tint   b. Hue 

c. Shade  d.  Tone    

15. 
An upward vertical stroke found on lowercase letters that extends above the 
typeface’s x-height. 

a. Ascender  b. Descender 

c. Crossbar  d.  Baseline  

16. ________________ means adjusting the space between characters. 

a. Leading  b. Tracking 

c. Measure   d.  Kerning  
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Answer Key 
MCQ No. Correct Answer 

1 b 

2 c 

3 b 

4 c 

5 d 

6 a 

7 d 

8 b 

9 d 

10 a 

11 c 

12 d 

13 b 

14 c 

15 a 

16 d 
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Module 2: Develop Design Concept 

Learning Outcomes 

After completion of this learning module, you will be able to: 

 Have an understanding of requirements and needs of target 
market/ audience 

 Identify the unique selling point of product or service 

 Express implement the idea in visual form as design and/or video 
depending on client’s requirement 

 Design effective brand guidelines 

 Develop colour themes based on brand guidelines 

 Use of brand guidelines in their design creation 

 Create story board showing individual scenes to compose video 

 Draw thumbnails to show composition of scenes 

 Allocate time duration in seconds to each scene 
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Learning Unit 1: Identify Unique Selling Point (USP) of 
Product / Service 
 

Overview 

In this learning unit, you will learn different concepts involved in understanding the needs of client to 
identify the unique selling point of product. After the completion of this learning unit, you will be able to 
demonstrate the analysis of need of the market and client’s emotional needs to be met. You will be 
able to understand client’s buying decision and design your unique product or service. 
 

1. Extraction of USP 

Unique Selling Point 

When we look around us, very few businesses are found to be unique. For example there is a plenty 
of clothing retailers, hardware stores, air conditioning installers and electricians. When your service or 
product is similar to those around you, you need to find out unique factor about your product of service 
that makes it stand out in competition.  

Unique selling point is the key to effective selling. Unless you point out what makes your product unique 
in a world of homogenous products, you cannot target your sales efforts effectively.  

Extraction of USP 

Identifying USP requires a lot of searching and creativity. One way is to start 
analyzing how other companies use their USP for their benefit. You can 
understand what other companies say they sell. In this way you can learn what 
makes these companies different from their competitions.  

USP can be based upon the following: 

 Product characteristics,  

 Price structure,  

 Placement strategy or  

 Promotional strategy.  

These are also called the “4 Ps” of Marketing. They are used to give your product a market place.  

For example, Blue Band is a daily source of essential fats and vitamins that help children to grow, 
develop and thrive. So they based their USP at product characteristics. Some airlines sell friendly, 
while others sell on-time service. “Metro Cash & Carry” & “Hyperstar” use “4 Ps” for selling products at 
its stores. 

The factor presented 
by a seller as the 
reason that one 
product or service is 
different from and 
better than that of 
the competition is 
called Unique 
Selling Point. 

USP 
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Find Unique Selling Point for your Product 

 
 

2. Analyze Needs of Target Market / Audience 

In order to make your product successful, you need to satisfy the needs of your 
target market. For this purpose, step back from your daily operations and 
carefully inspect what your customers really want. Suppose customers 
purchase your product but you should know, is the product only thing they 
want? What can make your customers to come again and again to you? You 
can improve the quality of product, convenience, friendliness, cleanliness, and 
courtesy or customer service.  

Price is never the only reason people buy. If your competition are ahead of you 
in pricing because they are larger, you have to find another sales feature that 

addresses the customer's needs and then build your sales and promotional efforts around that feature.  
 

3. Decide What Emotional Need is Being Specifically Met by your Product or 
Service 

In order to not get lost in the crowd of competitors, you need to think from client’s perspective and 
decide what emotional need is specifically met by your product. Thinks about your offer. What kind of 
need does it satisfy? Focus on your existing and potential customers and think about what they are 
searching for. 

A need is all about benefits a customer wishes to be in the product or services, it can be functional or 
emotional. The emotional benefit can always be a stronger driver for customer because functional 
benefits can easily be copied by competitors.  

On the other hand, a customer desire is what he wants to be there in the product which is not necessary 
but he wishes it in the product. For example, food is considered as a need. However, a dessert is 
considered as consumer’s desire, as these things are not necessary in order to live.  

If you can better assess the emotional need of customer and add it to your product or service it can set 
you apart from competitors. 
 

4. Motivate Customer towards Product 

For effective marketing you need to act like a psychologist. You need to know what drives and 
motivates customers. You need to look at their motives for buying your product/services, is it the quality 
or convenience.   

Design your unique product

Identify unique aspects of your product

Know what motivates clients purchase behavior

Decide client's emotional need to be met

Analyze the needs of target audience

Demand is the 
economic principle 
that describes a 
consumer's desire, 
willingness and 
ability to pay a price 
for a specific good 
or service. 

Remember 
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Cosmetics and liquor companies are great examples of industries that know the value of 
psychologically oriented promotion. People buy these products based on their desires (for pretty 
women, luxury, glamour and so on), not on their needs. 

Factors affecting Clients buying behavior: 

There are four basic factors that affect the customers purchasing behavior:  

1. Cultural Factors 

Cultural factors come from the different cultures or cultural 
environments the consumer belongs to. For a brand, it is important to 
understand the cultural factors fundamental to each market in order to 
adapt its product and its marketing strategy. As these will play a role in 
understanding the habits, behavior or expectations of consumers. 
Sometimes customers purchase to follow a new trend in the market or 
society to be a part of innovation. 

 
2. Social Factors 

Family is the most influential factor for an individual which develops an environment where his 
behavior and personality grows. For example if during your childhood, your parents described 
coke as not good for health, there is a little chance that you will develop a habit of drinking coke 
as adult. So a brand needs to seem as a family brand to become consumer’s habit. The social 
role and status influences the consumer behavior and his purchasing decisions. 

 
3. Personal Factors 

The lifestyle, values, environment, activities, hobbies and consumer habits change throughout 
his life. A consumer does not buy the same products or services at 20 or 70 years. The 
purchasing power of an individual will have, of course, a great influence on his behavior and 
purchasing decisions based on his income. The lifestyle of a consumer will influence on his 
behavior and purchasing decisions. 

 
4. Psychological Factors 

To increase sales and encourage consumers to purchase, brands should try to create, make 
conscious or introduce a need in the consumer’s mind so that he develops a purchase 
motivation. Through the experience the customer had, his learning and his external influences 
(family, friends, etc.), he will develop beliefs that will influence his buying behavior. 

 

Brands target the 

influence such as 

some celebrity, actor 

or musician to 

spread the use and 

purchase of their 

product in different 

social groups. 

Do you know! 
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5. Identify Unique Aspects of Product 

Differentiating the product or service in a competitive environment develops an 
element in your business that your competitors cannot imitate.  

For this purpose, list the features and benefit that are unique about your product 
or service. There is a difference between feature and benefit. For example 
having bakery in your store is a feature not a benefit but if you see it as having 
a bakery that can deliver sandwiches and other stuff in 2 minutes can definitely 
be a benefit.    

Identify aspects of your product or service that your competitors cannot imitate. 
It can be the location of your business that is idea to the customers, it can be 

the quality of product that is matchless or it can be the customer service with unique and creative ideas. 
Whatever it may be, list them. Highlight anything that cannot be copied, reproduced or duplicated by 
your competitor. 
 

6. Unique Design for the Product 

Design opens up valuable opportunities for businesses. Its importance is often underestimated, but 
good design can bring some significant business benefits.  

Development of a design for your product can create new product ideas and allow you to understand 
your customer’s needs and preferences. A unique design can be a powerful way of retaining customers 
and positioning your business for a move into new markets. 

Design Process 

The development of design should be managed like any other business process. The key is to co-
ordinate those people who are involved like designers, managers and employees to have their 
suggestion about design requirements. It will also ensure that your design delivers the outcomes you 
require at the cost you have budgeted. 

Key tips for managing the design process: 

 First of all you should be clear about the goal of the design, such as raising brand awareness 
or improving a product or service offering. 

 Carry out research about market needs and trends both before and during the designing 
process. Keep focused on what your customers want.  

 Set a budget and a timetable with measurable milestones. 

 Create design about your unique product or service that is clear, and concise. Use the ideas 
from unique selling point. Be sure that your design can communicate the exact idea that you 
want to share with the customers. 

 Choose your designer and prepare an outline about the project's aims, budget, schedule and 
any legal, technical or other constraints on developing the design.  

 Make sure that your production, marketing and sales departments are prepared for any new 
product, service or branding you develop. 

 Monitor the process as it develops - if the project deviates from the brief, investigate and make 
sure it's for a good reason. 

 Remember that your designs will be the unique identification and representation of your USP 
and Product/ Service so it needs to be protected. 

Design development 
shouldn't only be 
focused on your 
existing customers - 
it can also be used 
to help you target 
new customers and 
move into new 
markets. 

Remember 
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When the process is finished make sure you gather as much feedback as possible from those involved 
and some of your customers so that you know if your design is developed properly. 

Measuring the Success of Your Design 

You should set clear targets to measure the success of your design. 

In many instances customer response will be a crucial factor for that purpose. For example, if you 
design a new product or a new website interface, the key point to know its success will be its 
performance in the market. 

If problems arise, deal with them as quickly as possible. Revise the design brief if important new 
information or priorities emerge – try hard not to develop a design that delivers the wrong message 
instead of your unique selling point. 
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Learning Unit 2: Brand Guidelines and Themes 

 

Overview 

In this learning unit you will learn about the importance of techniques used to define the branding 
guidelines. After the completion of this unit, you will be able to find out the idea that describes the 
brands and integrate the guidelines into the look and feel of the design. (Perspective, Typography and 
Color theory).  

 

1. Permeates the Brand 

Define your brand and set it apart in the market.  A big idea is the powerful, 
merging force behind marketing efforts of the brand. While picking up big idea 
of your brand, keep these characteristics in mind that should be followed by 
your brand. 

Transformation 

Can the idea change attitudes, beliefs and behaviors? Open up new ways of 
thinking? Change the course of customers, markets and companies and be a 
“game changer” on a grand scale? If yes, then it’s a big idea and it can affect 
the market (customers, competitors, influencers) through its transformations 
and also alter your company and its people. 

Ownability / Uniqueness 

The idea should be tightly bound to your product / Service.  The idea behind 
ownability is unique in the market and only belongs to you. For instance, you 
can’t own the idea: “We have the best people.” Every competitor probably says 
the same thing. But an idea like, “Our aerospace company was founded by the 
first two human beings to land on the moon,” is hard to copy. 

Simplicity  

Big idea should be simple and easy to understand. A lack of simplicity is against 
human nature. Customers always have many options so you can’t take risk to 

confuse them. Idea should be truly creative because truly creative ideas don’t confuse. 
 
Originality 

Human are hard wired to focus on new, unique and original. We are programed to unconsciously ignore 
the familiar, direct thought to new and unique idea. So your brands big idea should use this universal 
truth for its benefit. 
 
Likeability  

In advertising communication, the factor of likeability contributes to the effectiveness more than any 
other factor.  

An attempt to 
communicate a 
brand, product, or 
concept to the 
general public, by 
creating a strong 
message that 
pushes brand 
boundaries and 
resonates with the 
consumers. 

Big Idea 

Big ideas grab you 

to the point where 

you can’t forget. 

Infectious ideas stick 

in our 

consciousness and 

never leave. 

Do you know! 
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2. Guidelines to Live the Brand 

Live the Brand 

A lot of planning and management is required in marketing a new brand. The 
first step a new brand should take when developing their marketing strategy is 
making sure that they have a strong understanding of their target customer. If 
you are not aware or the target, there are a great chanches that your message 
will not be conveyed to the actual customers. 

The design of your office, reception area says something about your brand, 
similarly your voicemail announcement and the way you answer the phone. The 
way you and your employees dress makes a brand statement; the music you 
play and sometimes even scent can contribute to branding. Your brand 
succeeds when your work matches the promises you make with the customers. 

Why to Design Guidelines 

Guidelines are necessary because 

 In the form of guidelines, you will have an easy guide to refer to when handing over the project. 

 Makes you look professional. It shows that you did everything for a reason. 

 You maintain control of the design. When someone does something awful, you can refer them 
to the document. 

 Forces you to define your style, making for a more solid design. 
 
Designing the Guidelines for the brand 
 
Brand Guidelines also called brand standards, style guide or brand book are a set of rules that explain 
how your brand works. These guidelines typically include: 

 An overview of your brand’s history, vision, personality and key values. 

 Brand message or mission statement it will also include examples of 
‘tone of voice’. 

 Logo usage – where and how to use your logo including minimum sizes, 
spacing and what not to do with it. 

 Colour palette – showing your primary and secondary colour palettes 
with colour breakdowns for print, screen and web. These colors will 
describe the look and feel of your brand. 

 Type style – showing the specific font that you use and details of the font family and default 
fonts for web use. 

 Image style/photography – examples of image style and photographs that work with the brand. 

 Business card and letterhead design – examples of how the logo and font are used for standard 
company literature. 

If you are just starting out and need only a few key elements, then focusing on the above area is 
enough. But to make sure that all the areas are covered, you need to develop detailed brand guidelines 
that will include: 

 Design layouts and grids 

 Social media profile page applications 

 Brochure/flyer layout options 

 Website layout 

 Signage specifications 

 Advertising treatments 

When you launch a 

brand, you are 

introducing an 

image, presenting a 

value proposition 

and communicating 

how your products 

are different. 

Do you know! 

A logo identifies a 
business in its 
simplest form via the 
use of a mark or 
icon. 

Logo 
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 Merchandising applications 

 Copywriting style  

 Editorial guidelines 

Brand guidelines should be quite flexible for designers to be creative, but rigid enough to keep your 
brand easily recognizable.  

3. Colour Themes Based on Brand Guidelines 

Guidelines should be designed keeping all the design element, design principles in mind. Brand 
Guidelines and Manuals should include following details 

1. Strategic Brand Overview 

This should be short and sweet. In as few words as possible, make the vision clear for this design and 
if there are any keywords, people should keep in mind while designing. Most people will probably move 
straight to the picture pages, but they may read a few sentences here. 

In the above picture the photography used, balanced backgroud image, readability of text, color 
contrast is perfect. Text is short and to the point. 

2. Logos 

For print and Web, most brands revolve around the logo. Make sure you provide logo variations and 
clarify minimum sizes. 

Logo Design and Variation of Logo Sizes 

The variations of logo sizes should be provided as in the above example because logo could be used at 
many places. 
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Correct Usage of Logos  

Correct variations of the logos in different colors should also be provided so 
that it can avoid recreation of logos as in the below example 

       

Variation of Logo Colors 

Spacing 

Many non-designers underestimate the need for white space. Include a spacing detail, especially for the 
logo.  

Rather than specifying inches or centimeters, use a portion of the logo (a letter or a shape) to explain the 
spacing in the logo.  

As in the blackberry logo, there is always a clean little space around the logo so they measure it with 
letter “B” from the logo.  

 

Spacing in BlackBerry Logo 

Typography 

You’ll need to define the typefaces to use: sizes, line height, spacing before and after, colors, headline 
versus body font, etc.  While choosing the type face, keep in mind the readability, elegance of text and 
contrast. 

Variations of logos 

are used at different 

places like black and 

white documents, 

social media, 

packaging, attire etc.  

Do you know! 
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Typography Information  

 

Color 

Always include color palettes and what the colors should be used for. And 
include formats for both print and Web: CMYK, Pantones (if they exist) and RGB 
(or HEX).  

Colors should be selected according to overall design theme. The warm colors 
should be used to attract attention. Cool colors to give an effect of calmness, 
neutral colors as backgrounds. Meaning of different color should be considered 
for example greys and black for professional subject websites, greens, blues for 
nature and white for health etc. 

 

For printing 
purposes, always 
provide CMYK and 
RGB replacement of 
pantone colors so 
that if they can’t find 
pantone, they can 
go ahead with 
CMYK or RGB  

Remember 
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Colors in Kerr Recruitment Logo 
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Icons 

Defining size and spacing and where to use icons is another great way to promote consistency. Icon set 
should also work with the theme of Brand.  

 

Icon set in Skype Brand Guideline 

Putting it all Together 

Show a few examples of what the logo, photography and text look like together and the preferred 
formats. 

  

Beside the elements 

defined in 

guidelines, there are 

certain concept 

which are also 

related to brand like, 

tone of voice, music 

associated, smell 

and texture if any.  

Do you know! 



 Module 2: Develop Design Concept 

Teaching and Learning Material: Information Technology (Computer Graphics - Motion)                                                      | 87 

Learning Unit 3: Visualize Concepts of Brand 

Overview 

In this learning unit, you will learn about techniques and concepts involved in visualizing the layout of 
the big idea of your brand designed according to the guidelines. After the completion of this learning 
unit, you will be able to understand and demonstrate the designing and organization of the canvas 
following the brand guidelines and the concepts of graphic designing.  

 

1. Develop Thumbnails of Objects and Design 

The first visual forms of an idea are thumbnails which are small sketches or 
simple drawings. When you develop fresh ideas in your mind about the design 
then it is important that you draw them quickly so that you can record those idea 
before forgetting.  
 

 
Thumbnail examples of BioTrekker logo 

Once you draw an image, you will be able to evaluate your design more efficiently. It is not necessary 
to draw each of all of a thumbnail. You can just draw a few samples of the repeated pattern to get the 

Thumbnail sketches 
(called thumbnails) 
are one of the most 
powerful tools 
available to an artist. 
This is where the 
image is invented. 

Thumbnails  
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idea. These thumbnails are not meant to be the final product they only 
communicate their meaning with the designer. Draw as many ideas as you can 
keeping your project in mind to get variations of design. 

Initially a series of thumbnails will be drawn with a lot of unrelated ideas. As you 
get in the process, the sketches will start to center around one or two major 
ideas. Ideas will develop in your mind about the design of different aspects and 
areas of brand designing.  

Evaluate your sketches relative to your concept. Do as much planning as possible using thumbnails. 
Change the concept if it does not match the assignment. 

Decide the sketch that you are most likely to develop. Select the sketch based on the reasons that it 
fully expresses the main idea of your project. It is able to represent your brand with full strength. Put a 
rectangle around it. That will be used as your design book page. It will give you an idea how large 
should your image be. You can experiment with how the image will fit on the design in the thumbnail 
stage. 

This is the best place to experiment with value, color, perspective, typeface, balance, design elements 
and design principles relationships. It is much faster to color and make changes in a thumbnail than a 
full size drawing. Choose colors for contrast and impact.  
 

2. Design Based on Brand Guidelines 

Whether you’re designing a page for print, or a website, there are some common principles you should 
follow. These approaches will help you to create a balanced layout. 

1. Use a Grid 

One of the easiest ways to ensure your page or canvas layout is balanced, is 
to use a grid system. Grids used to be preserved for printed pages only, but 
now idea of using grid is also popular in the digital medium.  

By using a grid to define the position of different elements on a page, you'll 
create a connection between the different elements that make up your page. 
This can help provide a sense of order to your layout, providing the reader with 

a clear structural reference to look at. This is important because when all your page elements have a 
feeling of connectivity with each other, the overall effect feels more comfortable to the reader, helping 
to put them at ease, and facilitating their access to the important stuff that is the content. 

When you have 
developed some 
sketches you will 
develop a style that 
works for you. 

Remember 

Using Grids is one 
of the most common 
practices to develop 
a balanced design. 

Remember 
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2. Choose a Single Focal Point 

One of the most effective ways to provide a sense of balance is to choose a single focal point for your 
layout. A good example of this in practice is the use of a large image as the biggest single element on 
a page. That can be the logo of your brand just like how it is defined in the guidelines. 

A strong visual can provide a powerful way to lead the reader into your page, acts as a structural 
element around which you can arrange the remaining content in your layout. If you have multiple visual 
elements, you will have to group them together, aligning them in the same way. 

 
Use of Focal Point in Design 

Use of Grid in Designing Page Layout 
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Another great idea is to use a main heading or quote at the page. This heading will draw the attention 
of the audience in the same way as does the image. It can also provide a structure to the layout of your 
page. 
 

3. Use the Rule of Thirds 

One of the best ways to provide a sense of balance is to use the Rule of Thirds or Golden Ratio. 
According to the rule of thirds, if you divide your page into three, both vertically and horizontally, the 
points at which the grid lines intersect provide the natural focal points. By aligning your design elements 
to these four points, you'll achieve a more pleasing composition than aligning your elements centrally. 

 
 

Use of a Rule of Thirds 

A common approach is to place the most important elements of your page in the upper third of the 
page. 

 

4. Use white Space 

It is not the right approach to fill in the every single space on the page. 
Sometimes it is more appealing to leave some space around the elements 
instead of stuffing them together tightly.  If too much space is 

used in the layout, it 
can cause a 
disconnection 
between objects. 

Remember 
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Use of Space 

The most common way to make use of white space is by enlarging the page margins and gutters. On 
the web, simply providing plenty of space around elements can help make the layout feel composed 
and balanced. Using negative space works best when you have a clear structure that keeps content 
together (such as that provided by a grid).  

 

5. Repeat Design Elements 

 
Repetition of Design Elements 

 
Repetition can provide a strong sense of connected design and balance to a layout. The idea is that 
by identifying and re-using a design element throughout your layout, you can provide a reference for 
the reader so that different areas feel connected and part of the same overall composition. 

Repetition can also 
provide a focal point 
in your design. 

Remember 
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6. Use of Hierarchy 

 
Hierarchy in the Design 

It is also a good approach to make correct use of hierarchy of elements. Heading text should be more 
visually important then the paragraph text. Focus on the most important element in the page and 
structure your document accordingly. 

 

7. Use Scale, Contrast and Harmony 

 
Repetition in Design 
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Finally, the use of scale can be a very effective method for achieving a good 
visual balance in your layout. By making some elements larger than others, a 
sense of order and hierarchy will develop. This helps create a comfortable 
layout because the viewer will automatically look at the larger elements within 
the layout first, progressing to the smaller elements as they read.  

Increased contrast to isolate an element in the design makes it more prominent. 
This acts as a way into the design and supports the structure of the design. 

Use the principles of harmony to make the others feel connected and 
accentuate the focal point. 
 

3. Composition of Elements 

Once you have developed the layout of the canvas or design, the next and the most important step is 
to check if it satisfies the needs of the project as we learned earlier. Below is the check list of 
requirements that a layout must full fill: 

 

1. The design layout should cover the complete idea so that your USP can be better 

comprehended by the customers.  

2. It should represent the emotional needs of the target audience. For example in the case of 

cosmetics brand, it should capture the psychology of customers for a wish of being pretty or to 

follow a latest trend in the market. 

3. The layout should be effective enough that it can change the purchase behavior of the customer 

and motivate them to come towards your brand. 

4. It should outline all aspects of your product or service which are unique and can’t be imitated 

by the competitors. The expression of the design should be unique instead of inspired design 

from some other brand. 

5. The colors used in the design layout should be according to the guidelines of brand. 

6. Typography, line height, typeface, font size used should also be according to the defined 

guidelines. 

7. The final layout should be balanced, properly aligned, readable, united, perfectly contrasted, 

with proper harmony, appealing, with clear perspective so that I can lead the audience to the 

focal point. 

 
 
 
 
 
 
 
 
 
 
 

Both scale and 

contrast work best 

when they apply to 

one element, 

making it stand out 

from the other parts 

of your layout. 

Do you know! 
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4. Page Layout 

Page layout is the part of graphic design that deals in the arrangement of visual elements on a page. 
The material/information needed to develop a layout includes the following:  

 
1. Size of the Design Layout 

You should be clear about the size of the layout needed. It depends on the size 
of idea you want to deliver and media where the design layout will be used in 
future. After confirmation of size, organize all the design element into that size 
area balanced. Size specification will also include margins and gutter 
measurements. 

 
2. Typeface 

Typeface used in the layout is of great important. You need to select a typeface 
that is readable, appealing and fits to your subject at the same time. A large 

number of extra ordinary fonts are available to be used free for example Squares Font, Taurus Mono 
Font, Primiterus Font, Garnata Font etc. you can use any of them. Other than these fonts, there are a 
large number of paid fonts available. You can purchase a typeface which is best suited to your design. 
Typography should be used correctly with proper font, font size, font style, line height, balance and 
location. 

 
3. Display Type 

Display type is the type that conveys the main message of the layout. It is intended to draw attention. 
Newspaper and magazine headlines are typical examples of display type. The display line is key to the 
success of a message. If the display type creates interest, the reader will proceed to the body. It can 
be a heading outlining the USP or an image like logo representing the identity of Brand and USP. 
Display type should be collected from guidelines of Brand and used at the focal point of layout. 

 
4. Illustrations 

The illustrations in a layout include the decorations, photographs, and artwork, such as line art. 
Illustrations are common in most printed materials. Small icon to be used and buttons are taken from 
the guidelines. The photographs to be used should be properly contrasted, original and well cropped. 
All the illustrations should be well suited to the topic and used at balanced locations in the layout. 

 
5. Colors 

Colors are one of the most influential elements of layout. Colors to be used should be according to the 
subject represented in the layout and guidelines. Colors chosen should be easily available for printing.  

If each layout 

applies valid 

principles of design, 

it might be 

impossible to say 

one is better than 

another. Layouts 

may be judged 

differently by 

different people. 

Do you know! 
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Intended Meanings of Colors 
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Learning Unit 4: Storyboard Using Thumbnails and Time 
Duration 

Overview 

In this learning unit, you will learn the steps of creating a storyboard, composing videos, drawing 
thumbnails. After completion of this learning unit, you will be able to create story board showing 
individual scenes, draw thumbnails to show composition of scene and allocate time duration in seconds 
to each scene. 

1. Use of Story Board  

Storyboards 

A storyboard is a graphic organizer in the form of illustrations or images displayed in sequence for the 
purpose of pre-visualizing a motion picture, animation, motion graphic or interactive media sequence. 
It is created prior to video production, and serves to visualize the main elements of the video in 
sequence, thereby organizing the story and scenes and simplifying overall editing and planning.  

In some ways, it is similar to an outline for a written paper, in that it allows the narrative to be organized 
and thought through ahead of time. Knowing ahead of time all the scenes you need to film allows for 
more efficient planning, resource gathering, and set/location development and use. 

Storyboard is often based on sketches that are intended to depict what will be shown on screen. In lieu 
of sketches, storyboards could contain photographs, screen captures, or text descriptions. If only text 
is used, the storyboard becomes something more like an annotated script, where the narration text is 
placed next to notes about the various visual and audio clips that will be associated with it. 

 

Layout of a Storyboard 
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Drawing Thumbnails to Represent the Scene                        

Illustrating Images or Scenes in Sequence  

When you are planning a video, there are eight steps in the process so you can bring your script to life 
and present it to other people. These are as follows: 

1. Choose Part of the Problem 

First we have to draw a user story diagram. Look at it together as a team. If the user story is more than 
two steps long (and it probably is) as shown in picture below, you are going to need to divide it up 
before you start sketching: 

 

User Story Diagram 

Now decide which part to focus on first. It usually makes sense to have everybody in the sprint focus 
on the same part of the problem at once. If you take that approach, you will do one cycle for each part 
of the problem, with everybody collaborating on each part as you go. 

2. Take notes (5 minutes) 

At this point the whiteboards and pin boards are probably covered by diagrams, notes, and sticky notes. 
Now everyone takes a piece of paper and jots down anything they think is useful. 

3. Mind map (10–15 minutes) 

Now you are going to add all the other ideas that are in your head, mix them with the notes you just 
took, and loosely organize them on paper. The mind map is going to be your "cheat sheet" you can 
use when you are sketching UI (user interface) ideas. 

Here is an example: 

 

Mind Map 
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4. Crazy Eights (5 minutes) 

Fold a blank sheet of paper in half three times, then unfolds it, so you get eight 
panels. Then you have five minutes total to draw eight sketches, one in each 
panel. Yes, you did the math correctly, that’s about 40 seconds per sketch.  

Since you have only 40 seconds for each drawing, you will need to turn off the 
self-editing and just get your ideas on paper.  

 

 

Eight Panels’ Layout 

 

5. Sticky Notes Storyboard (10–20 minutes) 

Start with a blank sheet of paper, and put three sticky notes on it. Each sticky note is one frame in the 
storyboard. It is kind of like a comic book that you are going to fill in. Look back at your mind map and 
your Crazy Eights and find the best ideas.   

 

Story Board using Sticky Notes 

 

 

Practice of folding 
a blank paper 
sheet to create 
eight panels for 
story board.  

Crazy Eight 

Fold a Blank paper 
sheet in a half only 
3 time to get eight 
panels for 
sketches of story 
board.  

Remember 

By folding a blank 
paper sheet thrice in 
different style, you 
can get eight panels 
as well as 6 panels, 
and the number of 
story board panel 
can be increased or 
decreased by the 
folds. 

Do you know! 
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6. Story board Analysis (5–10 minutes)  

Put a dot sticker on every idea or part of an idea you like. There are no limits to 
how many stickers you can use, by the end, you have got a kind of heat map, 
and some ideas are already standing out. 

7. Minute Analyses (3 minutes per idea) 

Everybody gathers around the storyboards one at a time. First, they talk about 
what they liked, and then ask the person who drew it if they missed anything 
important. This process works far better than letting people explain their ideas 
first—which almost always uses up a lot of time. 

8. Super vote (5 minutes) 

Once looking at all the ideas, everybody gets one or two "special" stickers These are "super votes" for 
the ideas you think are the very best. Between the original heat map and these super votes, it is very 
easy to see which the strongest concepts are. 

 

2. Time Duration in a Motion Video  

Using the Timeline 

The Timeline is where you control all timing aspects of the project. Whether you want to line up multiple 
objects to begin or end together, lengthen or shorten an object, or change which portion of a clip is 
used, the Timeline provides the tools you need. You can organize your objects to begin and end on 
the frames you choose. You can also align multiple effects so they occur simultaneously. You can 
control objects’ durations and even perform common trim operations to edit the objects as you would 
in a nonlinear video editing application. 

 

Adjustment Timeline 1 

 

  

Usually the best, 
most popular ideas 
are the ones people 
can understand 
without an 
explanation, so the 
author of the 
storyboard often 
does not have 
anything else to add. 

Do you know! 
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Procedure of Creating a Story Board       

The procedure of creating a story board has the following steps: 

1.  Draw a user story diagram on a paper (using pencil/pen) 

2.  Take Notes from group participants  

3.  Add the ideas of your mind on a paper as Mind map 

4.  Take a blank paper sheet for creating storyboard panels.  

5.  Fold the sheet in the half thrice to get 6 panels for sketches  

6.  Draw sketches on each panel 

7.  Write your story scene against each sketch  

8.  Analyze storyboard using dot stickers  

9.  Gather the group members for minute analyses  
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Summary of Module 

 Unique Selling Point is the key to effective selling. Unless you point out what makes your product 
unique in a world of homogenous products, you cannot target your sales efforts effectively. 

 In order to make your product successful, you need to satisfy the needs of your target market. So 
you need to inspect carefully what your customers really want. 

 If you can better assess the emotional need of customer and add that to your product or service it 
can set you apart from competitors. 

 A purchase decision of a customer is the result of cultural factors, social factors, personal factors 
and psychological factors. 

 Identify aspects of your product or service that your competitors cannot imitate. It can be the quality 
of product that is matchless or it can be the customer service with unique and creative ideas. 

 Big idea is the idea that defines your brand and set it apart in the market.  A big idea is the powerful, 
merging force behind a brand’s marketing efforts. 

 Your brand not necessarily what you want it to be but, it all about what the customers experience. 
And what consumers think of your brand may be very different from the message you're putting out 
there. Simply, your brand isn't the work you do, but it is how you do it. 

 Brand Guidelines also called brand standards, style guide or brand book are a set of rules that 
explain how your brand works. They incude breif overview of brand, logos, variation of logos, 
spacing details, typeface and color details for brand, icon sets etc. 

 The first visual forms of an idea are thumbnails which are small sketches or simple drawings. When 
you develop fresh ideas in your mind about the design then it is important that you draw them quickly 
so that you can record those ideas before forgetting. 

 After developing the layout check if it meets the requirements and is according to the guidelines 
defined for the brand. 

 Storyboard is often based on sketches that are intended to depict what will be shown on screen. In 
lieu of sketches, storyboards could contain photographs, screen captures, or text descriptions. 
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Frequently Asked Questions (FAQs) 
FAQ 1:  What is Unique Selling Point? 

Answer 
The factor presented by a seller as the reason that one product or service is different 
from and better than that of the competition is called Unique Selling Point. 

FAQ 2:  Why USP is important for a brand? 

Answer 
USP is the key to effective selling. Unless you point out what makes your product 
unique in a world of homogenous products, you cannot target your sales efforts 
effectively. 

FAQ 3:  Which factor motivates the customers to purchase? 

Answer 
A purchase decision of a customer is the result of cultural factors, social factors, 
personal factors and psychological factors. 

FAQ 4:  How feature is different from benefit? 

Answer 
Feature is what your brand does. Benefit is how your brand does its job better than 
others. 

FAQ 5:  How to measure the success of your design? 

Answer 
In many instances customer response will be a crucial factor for that purpose. For 
example, if you design a new product or a new website interface, the key point to 
know its success will be its performance in the market 

FAQ 6:  What is a big idea for an organization? 

Answer 
A captivating expression of the needs & wants a brand best satisfies and that 
simultaneously conveys the brand’s ultimate purpose or commitment. 

FAQ 7:  What is Brand Guidelines? 

Answer 
Brand Guidelines also called brand standards, style guide/brand book are a set of 
rules that explain how your brand works. It includes overview of brand, color details, 
typography details, logo usage etc. 

FAQ 8:  What is a thumbnail? 

Answer 
Thumbnail sketches (called thumbnails) are one of the most powerful tools available to 
an artist. This is where the image is invented. 

FAQ 9:  What is the purpose of using Grid in the layout? 

Answer 
By using a grid to define the position of different elements on a page, you'll create a 
connection between the different elements that make up your page. 

FAQ 10:  What does too much use of space do in the layout? 

Answer If too much space is used in the layout, it can cause a disconnection between objects. 

FAQ 11:  Can I Share My Storyboards? 
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Answer 
Absolutely! You are encouraged to share your storyboards digitally, physically, via 
email, social media, linking, and any other way you can think of. 

FAQ 12:  How Do People React At Work When You Use A Storyboard? 

Answer 
Most people are visual people and react very positively to a new and refreshing way to 
consume information. Storyboards provide that novel approach. 

FAQ 13:  What can you do with a mind map? 

Answer 

 You can place each new idea in the right place, regardless of the order of 
presentation.  

 It encourages the reduction of each concept to a single word.  
 The resultant mind map can be 'seen' by the eye and memorized by your visual 

memory which has been shown to be almost perfect 
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key 
at the end of this module. 

1.  Four Ps of Marketing are 

a.  
Product characteristics, Price 
structure, Placement strategy and 
Promotional strategy 

b.  
Product characteristics, Policy 
structure, Placement strategy and 
Promotional strategy 

c.  
Product characteristics, Price 
structure, Presentation strategy and 
Promotional strategy 

d.  
Product characteristics, Price 
structure, Placement strategy and 
Performance 

2.  A customer’s desire is ____________________ 

a.  That’s necessary for the product b.  Related to the product 

c.  
What he wishes to be in product but 
not necessary 

d.  Both a and b 

3.  Lifestyle that affects the customer’s behavior belongs to __________ Factor 

a.  Psychological  b.  Personal 

c.  Social  d.  Cultural 

4.  Feature and Benefit of a product is ________________ 

a. Same b. Compulsory 

c. Different d.  Optional 

5.  Transformation characteristic of an idea mean that ______________ 

a. Idea can be easily replaced b. 
New changes can easily be made in 
the idea 

c. idea can easily be spread d.  
Idea can change attitudes and 
behaviors 

6.  Choose INCORRECT option, Guidelines are necessary because ________________ 

a. 
It is an easy guide to refer to when 
handing over the project 

b. 
When something awful happens, you 
can refer them to the guidelines 

c. 
Contains documentation of products 
in a business 

d.  Helps to make the design more solid 
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7.  A logo is  __________________ of a Brand 

a. Identity b. Structure 

c. Need d.  
Backbone 
 

8.  A thumbnail of an object is _____________ 

a. Final design b. Layout of design 

c. Design Prototype d.  Rough sketch of ideas 

9.  Rule of thirds is ____________________ 

a. 
Divide the page into halves and use 
the intersection as focal point 

b. 
Draw two diagonal lines and use the 
intersection as focal point 

c. 
Divide the page in three and use the 
middle section as focal point 

d.  
Divide the page into three both 
vertically and horizontally use the 
intersection of line as focal point 

10.  Choose the INCORRECT option, A design layout should _______________ 

a. Properly printed b. Represent USP 

c. Meet customer needs d.  Balanced 

11.  
By folding a paper 3 times in a half you will have _______________ story board 
panels 

a. 8 b. 6 

c. 12 d.  4 

12.  Everybody gets one or two "special" stickers These are  _______________ 

a. Vote b. Super Votes 

c. Lower Vote d.  Minor Vote 

13.  A storyboard is a _______________organizer in the form of illustrations or images 

a. Sticky Note b. Mind Map 

c. Graphic d.  Timeline 

 

  



Module 2: Develop Design Concept 

106 |                                                      Teaching and Learning Material: Information Technology (Computer Graphics - Motion) 

Answer Key 
MCQ No. Correct Answer 

1 a 

2 c 

3 b 

4 c 

5 d 

6 c 

7 a 

8 d 

9 d 

10 a 

11 a 

12 b 

13 c 
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Module 3: Analyze Cost Effective Solution 

Learning Outcomes 

After completion of this learning module, you will be able to: 

 Add time in seconds to individual scenes of video sequence 

 Select the output file format, container, codec for motion video 

 Set optimal compression ratio for video file 

 Select output size of video file 

 Set resolution of video 

 Select optimal frame rate for playback 
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Learning Unit 1: Time Duration of Video Sequence 

Overview 

In this learning unit, you will learn calculation of time based on narration and audio in the 
scenes/visuals, length in seconds of audio clip for each particular scene for dialogues use, 
synchronization of music in scenes and computing of time duration of scenes. 

 

1. Calculation of Time Based on Narration and Audio  

The Timeline shows the chronological arrangement of clips and layered video 
and audio clip items, while the Canvas provides a single view that allows you 
to watch your sequence just as it will appear on a movie or television screen. 
Timeline contains tabs for all open sequences. Each sequence in the Timeline 
is organized into separate video and audio tracks, which contain clip items 
you’ve edited into the sequence from the Browser. You can quickly navigate 
through an entire edited sequence, adding, overwriting, rearranging, and 
removing clip items. 

 

Chronology is the 
science of arranging 
events in their order 
of occurrence in 
time. Consider, for 
example, the use of 
a timeline or 
sequence of events. 

Remember 

TVET RSP does not secure copyright of these pictures

TVET RSP does not secure copyright of these pictures
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The Timeline editing controls determine which tracks are selected and turned on for editing and 
playback. The controls are; 

 

 Source and Destination controls 

 Track Visibility control 

 Lock Track control 

 Auto Select control 

 

Vertical Multitrack Controls 

The vertical multitrack controls includes the following: 

 Tracks 

 Unused area 

 Vertical scroll bars and thumb tabs 

Final Cut Pro 
Software used here. 

Remember 
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Horizontal Time Controls 

They includes the following: 

 Ruler 

 Play head 

 Current Time code field 

 Zoom control 

 Zoom slider 

 

 

 

 

TVET RSP does not secure copyright of these pictures

TVET RSP does not secure copyright of these pictures
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2. Length in Seconds  

Material acquired via dual system recording i.e. video and audio are recorded simultaneously to 
different devices; you need to capture your audio and video separately and then synchronize them 
together in Final Cut Pro. 

After capturing, you can combine the corresponding video and audio clips into a merged clip. Merged 
clips work in the same way as other clips in Final Cut Pro, but they refer to separate video and audio 
media files. Following are the steps for learn and synchronize audio with scenes: 

 Open the video clip you want to synchronize in the Viewer. 

 Scrub through the beginning or end of the clip and find the frame where the clapper on top of 
the slate first closes.  

 

 Set an In point if the “clap” appears at the beginning of your clip, or an Out point if at the end. 

 Open each audio clip you want to merge in the Viewer, and repeat steps 1 through 3, 
identifying instead the frame of audio where you first hear the clap. 
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3. Synchronization of Music in Scenes  

Syncing music with the scene means the sound and the video matches with 
each other. Suppose in a video one person is asking a question from other but 
their lips are not matching the word and there is a delay. For synching music 
with scenes we have different options in Final Cut pro. Some of them are given 
below: 

 Each tab in the Timeline represents a sequence. 

 Multiple sequences open simultaneously, each with its own tab. 

 Controls in Final Cut Pro affect only the sequence whose tab is in 
front. Clicking another sequence’s tab brings it to the front. 

The beginning, end, and overall duration of a merged clip depends on the 
method you used to synchronize the original clips. 

 

 

Synchronization of original clips using In point 

 

Synchronization of the original clips using Out points 

Process of making 
two or more data 
storage devices or 
programs (in the 
same or different 
computers) having 
exactly the same 
information at a 
given time. 
 
Read more: 
http://www.business
dictionary.com/defini
tion/synchronization.
html#ixzz3kfIl5FHG 

Synchronization 

Gaps appear in a 
particular track if 
one or more items in 
a merged clip is 
shorter than all the 
others, but they 
cause no problems 

Remember 
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Synchronization of Original clips using Time code 
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Learning Unit 2: Determine Output Format, Container, 
Codec of Video Sequence 

Overview 

In this learning unit, you will learn about video file formats and codec. After completion of this learning 
unit, you will be able to select suitable video file format for your video, demonstrate the process of 
compression, use different codecs, select required bit rate for video and transcoding.  

 

1. Anatomy of a Video File 

An image is a two-dimensional array of intensity or color data. A camera outputs 
a one-dimensional stream of analog or digital data. The purpose of the frame 
grabber is to acquire this data, digitize it if necessary, and organize it properly 
for transfer across the PCI bus into system memory, from where it can be 
displayed as an image. To understand this process and be capable of 
troubleshooting display problems, you need to know the exact structure of the 
video signal being acquired.  

There is a wide range of video formats; in general, each format has the following 
characteristics:  

 Container type 

 Video and audio signal 

 Codec 
 

2. Characteristics of a Video Signal 

Every video file has some attributes that describe what makes up the video 
signal. These characteristics include: 

 

Interlaced 

Interlacing was invented as a way to reduce flicker in early mechanical and 
CRT video displays without increasing the number of complete frames per second, which would have 
sacrificed image detail to remain within the limitations of a narrow bandwidth. 

 

Color Space and Bits Per Pixel 

The number of distinct colors a pixel can represent depends on the number of bits per pixel (bpp). A 
common way to reduce the amount of data required in digital video is by Chroma subsampling. 

It is an analog 
computer display 
which uses streams 
of electrons that 
activate dots or 
pixels on the screen 
to create a full 
image. 

CRT Video Display 

High definition video 
has two resolutions: 
1920-by-1080 (Full 
HD) and 1280-by-
720 

Do you know! 
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Resolution  

This is the number of pixels in each video frame. A frame is one of many still 
images you view in quick succession to get the illusion of  

 

Frame Size 

This is the pixel dimension of the frame. 

 

Aspect Ratio  

This is the ratio of width to height. It describes the dimensions of video screens and video picture 
elements. Aspect ratio of a traditional television screen is 4:3 or 16:9 for HD television. 

 

Frame-Rate  

This is the speed at which the frames are captured and intended for playback. 

 

Bit-Rate  

The bitrate or data rate is the amount of data used to describe the audio or video portion of the file. It 
is typically measured in per second units and can be in kilobytes, megabytes or gigabytes per second. 
In general, the higher the bitrate, the better the quality. 

 

3. File Formats Concepts  

File Format 

File formats may be either proprietary or free. File formats are designed for very particular types of 
data. For example, PNG file stores bitmapped images using lossless data compression, the OGG 
format act as a container for different types of multimedia including combination of audio and video. 

 

Container 

Container format is a type of file format that contains various types of data compressed by standardized 
codec. Container formats are essentially wrappers in that they don't specify what codec the container 
format uses, but rather it defines how the video, audio and other data is stored within the container. 

To understand the difference between a container, a compression scheme, and a codec, first we need 
to break down the parts of a video file. Think of a video file as a bookshelf filled with books. It holds 
many tracks of audio and video just like a bookshelf can hold many books. Common Multimedia 
Containers are given below: 

A file format is a 
standard way that 
information is 
encoded for storage 
in a computer file. It 
specifies how bits 
are used to encode 
information in a 
digital storage 
medium. 

File Formats 
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 AVI 

 MPEG-4 

 FLV  

 MOV  

 OGG 

 OGM 

 OGV  

 MKV 

 VOB 

 ASF  

 

Codecs 

Codec is short for compressor/de-compressor. A codec is a piece of hardware or software that 
interprets an audio or video signal and compresses it. Every video file contains the video and audio 
data. This data is created by a piece of software called a codec. Codec act as a helper application that 
the program or the operating system uses to make or play the video file. Without the proper codec, a 
video file can’t be played by a computer. 

 

Common Multimedia Codec's  

 H.264 

 Spinoffs  

 DV 

 WMV 

 RM  

 DivX 

 Quicktime 6  

 Sorenson 3 

 Theora  
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4. Common Containers 

Audio Video Interleave (.avi) 

An AVI (Audio Video Interleaved) file is a sound and motion picture file that conforms to the Microsoft 
Windows Resource Interchange File Format (RIFF) specification. AVI files can hold different types of 
video and audio streams inside, they can display incredible video quality while maintaining a small file 
size. Basic structure of avi contains two thing, chunks and list. 

 

MPEG-4 

A graphics and video lossy compression algorithm standard that is based on MPEG-1 and MPEG-2 
and Apple QuickTime technology. MPEG-4 enables different software and hardware developers to 
create multimedia objects possessing better abilities of adaptability and flexibility to improve the quality.  

 

MKV (Matroska Video) 

MKV is a flexible, open standard video file format that has quickly become the 
preferred file extension for high definition video on the Internet. The MKV 
container can include video, audio, and features such as alternate audio 
tracks, multilingual subtitles and chapter points. 

 

OGG 

The Ogg bit stream format, spearheaded by the Xiph.Org Foundation, has 
been created as the framework of a larger initiative aimed at developing a set of components for the 
coding and decoding of multimedia content, which are available free of charge and freely re-
implementable in software.  

 

FLV 

Flash Video is a container file format used to deliver video over the Internet using Adobe Flash Player 
version 6 and newer. Flash Video content may also be embedded within SWF files.  
 

5. Codecs Available and Compatibility 

The large number of codecs in use makes video compatibility a very complicated area. You cannot tell 
what codec is used by the file extension, and your system software may only give you partial 
information. Your video editing software may be able to tell you what codec was used to make the file, 
or you may need to get some specialized software. 

 

 
 

SWF is a file 
extension for a 
Shockwave Flash 
file format created 
by Macromedia and 
now owned by 
Adobe. SWF stands 
for Small Web 
Format 

SWF File 
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6. Common Codecs  

MPEG  

(Moving Pictures Expert Group): three video formats, MPEG 1, 2, and 4. 

 

MPEG-1:  

Old, supported by everything (at least up to 352x240), reasonably efficient.  A good format for the web. 

 

MPEG-2:  

A souped-up version of MPEG-1, with better compression.  720x480. Used in HDTV, DVD, and SVCD. 

 

MPEG-4: 

A family of codecs, some of which are open, others Microsoft proprietary. 

 

MPEG Spinoffs 

MP3 (for music) and Video CD. 

 

MJPEG 

(Motion JPEG): A codec consisting of a stream of JPEG images.  Common in video from digital 
cameras, and a reasonable format for editing videos 

 

H.264 

H.264 is a popular standard for high definition digital video, and for good reason. A codec based on 
the H.264 standard compresses a digital video file so that it only uses half the space of MPEG. 

 

DV (Digital Video) 

Usually used for video grabbed via fire wire off a video camera.  Fixed at 720x480 @ 29.97FPS, or 
720x576 @ 25 FPS.  Not very highly compressed. 
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WMV (Windows Media Video) 

A collection of Microsoft proprietary video codecs.  Since version 7, it has used a special version of 
MPEG4. 

 

DivX 

An ASF (incomplete early MPEG-4) codec inside an AVI container; DivX 4 and later are a more full 
MPEG-4 codec. No resolution limit.   

 

Sorenson 3 

Apple's proprietary codec, commonly used for distributing movie trailers (inside a quick time container). 

 

Quick time 6 

Apple's implementation of an MPEG4 codec. 

 

RP9 

A very efficient streaming proprietary codec from Real (not MPEG4). 

 

WMV9 

A proprietary, non-MPEG4 codec from Microsoft. 

 

Ogg Theora 

A relatively new open format from Xiph.org. 

 

Dirac  

A very new open format under development by the BBC. 

 

7. Video Sampling Bit Rates and Quality Measured 

The bit rate, or data rate of a video file is the size of the data stream when the video is playing, as 
measured in kilobits or megabits per second (Kbps or Mbps). Bit rate is a characteristic of a file, it 
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specifies the minimum capabilities of the hard drive transfer rate or Internet connection needed to play 
a video without interruption. 

Higher bit rates can provide more information to describe the visual or audio data. Cameras typically 
record at a higher bit rate than can be optimized for delivery files to the Internet or optical disc. 

 16 kbit/s video phone quality minimum necessary for a consumer-acceptable "talking head" 
picture using various video compression schemes 

 128–384 kbit/s business-oriented video conferencing quality using video compression 

 400 kbit/s YouTube 240p videos (using H.264) 

 1 Mbit/s YouTube 480p videos (using H.264) 

 1.15 Mbit/s max  VCD quality (using MPEG1 compression) 

 2.5 Mbit/s YouTube 720p videos (using H.264) 

 3.5 Mbit/s type  Standard-definition television quality (with bit-rate reduction from MPEG-2 
compression) 

 4.5 Mbit/s YouTube 1080p videos (using H.264) 

 9.8 Mbit/s max  DVD (using MPEG2 compression) 

 8 to 15 Mbit/s type  HDTV quality (with bit-rate reduction from MPEG-4 AVC compression) 

 19 Mbit/s approximate  HDV 720p (using MPEG2 compression) 

 24 Mbit/s max  AVCHD (using MPEG4 AVC compression) 

 25 Mbit/s approximate  HDV 1080i (using MPEG2 compression) 

 29.4 Mbit/s max  HD DVD 

 40 Mbit/s max 1080p Blu-ray Disc (using MPEG2, MPEG4 AVC or VC-1 compression) 

 

8. Process of Transcoding  

The process of transcoding is given below: 

1. Transcoding is the process of changing some part of a video file format to another type.  

2. If you change frame size, or bit rate, or codec, or audio signal, you are said to be transcoding 
a file.  

3. The process of transcoding is generally pretty time-consuming, and can often add a significant 
hurdle to the production process. 

4. Transcoding also introduces the possibility of errors into the file. 
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5. If the video signal is being transformed in some significant way like change in frame rate.  

6. If you can accomplish your workflow without transcoding, you’ll generally save yourself time, 
money and storage costs. 

 

9. Compressed and Un-Compressed Videos 

Compressed Video 

Video signal requires a large amount of storage space and transmission bandwidth. To reduce the 
amount of data, strategies are employed that compress the information without negatively affecting the 
quality of the image. Some methods are lossless, but most are lossy. Some simple methods of data 
compression are: 

 Throw away pixels at regular intervals 

 Average several pixel values together (subsampling) 

 Throw away color channel information at regular intervals 

 

Lossless Codecs 

Intensive algorithms can be employed to reduce the amount of transmitted and stored image data. 
Mathematical algorithms can be used to encode and decode each video frame.  

 

Lossy Codecs 

Codecs lose some information in the video signal, the goal is to make this information loss visually 
imperceptible. When codec algorithms are developed, they are fine-tuned based on analyses of human 
vision and perception.  

 

Uncompressed Video 

Video that has no compression applied can be unwieldy, so it is only used for the highest-quality video 
work, such as special effects and color correction at the last stage of a project. Most professional 
projects have an offline phase that uses compressed video and then an online, finishing phase that 
uses uncompressed video recaptured at full resolution. Uncompressed video requires expensive VTRs 
and large, high-speed hard disks. 
 
 
 
 
 
 
 



 Module 3: Analyze Cost Effective Solution 

Teaching and Learning Material: Information Technology (Computer Graphics - Motion)                                                      | 123 

10. Storage Space or Size of Footage  

Video or footage format you choose for output affects the capture settings of your clips, your sequence 
settings, and the equipment you need. The most common output formats include: 

 

DV  

The DV format family includes DV, DVCAM, DVCPRO, DVCPRO 50, and DVCPRO HD. DV formats 
are compressed video formats designed with nonlinear video editing in mind.  

 

Uncompressed digital and professional analog video formats 

These are formats such as Betacam SP (analog), Digital Betacam, D-5, or HDCAM. VTRs for these 
formats support several different video interface connections, such as component analog (Betacam 
SP), SDI (Digital Betacam, D-5), and HD-SDI (HDCAM).  

 

Analog composite video output 

VHS and 3/4" U-matic are still the lowest common denominator for video distribution, even though 
these formats are being replaced by DVD, DV, and QuickTime movie files. 

 

11. Recording Device and Quality  

Digital media (especially high data rate video) makes your disks work harder, you should use dedicated 
disks for capturing and playing back your digital video. Depending on what kind of computer you are 
using, you may be able to use internal and external hard disks to store your media files. Each has 
benefits and drawbacks. 

 

Internal Disk 

 May be less expensive because they don’t have external cases or require their own power 
supplies. 

 Are inside your computer, causing less noise. 

 Are limited by the expansion capabilities of your computer and the heat buildup they cause. 

 

External Disks 

 Let you easily switch between projects by switching disks connected to the computer. 

 Let you move a project quickly from one computer system to another in a different location. 
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 May be more expensive because of external cases and power supplies. 

 May be noisy. 

Type of hard disk storage system appropriate for your needs, keep in mind the format and data rate of 
the video you’re capturing. Depending on whether you work as an independent video editor. The 
amount of storage you require and the bit rate of data transfer will be important factors to match up 
with your storage needs. 

Common choices include: 

 ATA 

 FireWire 

 SCSI 

 RAID and Fibre Channel 
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Learning Unit 3: Understand the “Trade of” between 
Quality and Size of a Video File 

Overview 

On completion of this learning unit, you will be able to understand compression methods available for 
media types, transmission channels, playback/ output platform, frames per seconds as fps, effect with 
increasing/decreasing FPS on video file, standard definition (SD), high definition (HD) and higher 
resolution yields bigger file. 
 

1. Compression Methods for Media Types  

Video footage has been recorded on videotape. As digital acquisition replaces analog technology, 
some camcorders now record footage as files on non-tape-based media such as hard disks, solid-state 
cards, and optical discs.  

 

SD: 

DV, DVCAM, DV25, DV50• 

MPEG-2@ML 4:2:0, I-Frame & Long • GOP 2-15 Mb/s 

MPEG-2 @ML 4:2:2, I-Frame & Long • GOP 4-50 Mb/s 

 

HD: 

MPEG-2@HL 4:2:0, I-Frame & Long • GOP 12-50 Mb/s 

MPEG-2@HL 4:2:2, I-Frame & Long • GOP 20-50 Mb/s 

XDCAM HD (18, 25, 35 Mb/s)• 

XDCAM HD 4:2:2 (50 Mb/s)• 

XDCAM EX 

 

2. Transmission Channels and Playback  

 Digital video technology has fundamentally changed the way visual information is processed 
stored and transferred. 

 Analog video with the emergence of various applications such as High Definition TV Video CD, 
Digital Versatile Disk, Digital Video Broadcasting and video conferencing. 

 

ATM is a dedicated-
connection switching 
technology that 
organizes digital 
data into 53-byte cell 
units and transmits 
them. 

Asynchronous 

Transfer Mode 
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Video Transmission over Broadband Networks 

 Public access networks are expected to provide transmission services for various forms of 
information. 

 Asynchronous transfer mode (ATM) networks are an example of a network architecture 
designed for broadband applications in public networks. 

Video Transmission over Burst-error Channels  

 Wireless connection can provide convenient tether less data access and mobility to users. 

 Video communication over wireless is challenging as the hardware and channel resources 
are very constrained. 

 

3. Effect of Increasing and Decreasing FPS  

Frame Rate 

 Movies on film are almost exclusively projected at 24 fps. 

 Television does not have an internationally accepted frame rate. 

 Converting video formats from one frame rate to another is technically challenging 

 There are often unwanted visual side effects.  

 This is especially true when the frame rates do not evenly divide.  

 

Example 

 Converting 30 fps to 60 fps is fairly easy to do. 

 Converting 29.97 fps to 25 fps is difficult. You have to make sure audio stays in sync throughout 
the conversion is yet another challenge. 

 

24 FPS  

This is the universally accepted film frame rate. Movie theaters worldwide almost always use this frame 
rate. Many high definition formats can record and play back video at this rate, though 23.98 is usually 
chosen instead. 
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23.98  

This is 24 fps slowed down by 99.9% (1000/1001) to easily transfer film to NTSC video. Many high 
definition video formats (and some SD formats) can record at this speed, and it is usually preferred 
over true 24 fps because of NTSC compatibility.6) fps. 

 

25 FPS 

The European video standard. Film is sometimes shot at 25 fps when destined for editing or distribution 
on PAL video. 

 

29.97 FPS 

This has been the color NTSC video standard since 1953. This number is sometimes inaccurately 
referred to as 30 fps. 

 

30 FPS 

Some high definition cameras can record at 30 fps, as opposed to 29.97 fps. Before color was added 
to NTSC video signals, the frame rate was truly 30 fps. However, this format is almost never used 
today. 

 

50 FPS 

This refers to the interlaced field rate (double the frame rate) of PAL. Some 1080i high definition 
cameras can record at this frame rate. 

 

59.94 FPS 

High definition cameras can record at this frame rate, which is compatible with 
NTSC video. It is also the interlaced field rate of NTSC video. This number is 
sometimes referred to as 60 fps, but it is best to use 59.94 fps unless you really 
mean 60 fps. 

 

60 FPS 

High definition equipment can often play and record at this frame rate, but 59.94 fps is much more 
common because of NTSC compatibility. 

 

 

In Europe, PAL and 
SECAM use 25 fps 
 
North America and 
Japan uses 29.97 
fps 

Do you know! 
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4. Resolution of Video as Defined by Number of Pixels 

Two major signal types recorded on videotape: NTSC and PAL. With the emergence of new high 
definition (HD) video formats, NTSC and PAL formats are now referred to as standard definition (SD) 
video formats.  

 

Standard Definition Video 

 National Television Systems Committee (NTSC) is the television and video 
standard used in most of the Americas, Taiwan, Japan, and Korea.  

 Phase Alternating Line (PAL) is the television and video standard used in 
most of Europe, Australia, India, Brazil, China, and many African countries.  

 SD formats almost always have an aspect ratio of 4:3 (1.33:1). 

 

High Definition Video 

 HD video formats were standardized in the United States by the Advanced Television 
Standards Committee (ATSC).  

 These HD video formats are the next generation of broadcast and recording video formats. 

 SD formats, which are restricted to fixed frame rates and numbers of lines per frame, HD video 
provides several options per format. 

 Increased flexibility is convenient 

 For HD format you have to define the frame size, frame rate, and scanning method of your HD 
format. 

Video frame is composed of lines. In digital video, each line is sampled to create a number of pixels 
(samples) per line. 

 

320*240 

Used for web distribution or offline video editing.(PAR 1:1 )(SAR4:3) 

 

640*480 

Standard for analog-to-digital video editing and an ATSC video specification.(PAR 1:1 )(SAR 4:3) 

 

 

SAR is the 
proportional 
relationship between 
its width and its 
height. 

Screen Aspect 

Ratio 
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720*480 

NTSC DV and DVD image dimensions. Also part of the ATSC video specification. (SAR 4:3) 

 

720*576 

PAL SD video dimensions used for digital formats DVD and DV. (SAR 4:3) 

 

1280*720 

An HD video format, capable of higher frame rates in exchange for smaller image dimensions. (PAR 
1:1 )(SAR 16:9) 

 

1920*1080 

An HD video format with very high resolution. (PAR 1:1 )(SAR 16:9)  

 

960*720 

Some 720p formats (such as DVCPRO HD and HDV) subsample 1280 pixels 
to 960 to minimize the data rate. (PAR 4:3)(SAR16:9) 

 

1440*1080 

Some 1080-line formats (such as HDV and DVCPRO HD) subsample 1920 
pixels to 1440 or even 1280 to minimize the data rate. (PAR 4:3 )(SAR16:9) 
 

5. Higher Resolution yields Bigger File 

Size of the file depends on certain parameters like color coding, fps and resolution of the file. 

 

Example: 

Suppose we keep frame rate and color coding constant and change the pixel values 

For 8-bit color coding and 25 FPS 

 

 

PAR is a 
mathematical ratio 
ratio that describes 
how the width of a 
pixel is compared to 
the height of that 
pixel 

Pixel Aspect 



Module 3: Analyze Cost Effective Solution 

130 |                                                      Teaching and Learning Material: Information Technology (Computer Graphics - Motion) 

Resolution  

720*576 

720 x 576 x 25 x 8 + 2 x (360 x 576 x 25 x 8) = 1.66 Mb/s (SD Video) 

 

1920x1080  

1920 x 1080 x 25 x 8 + 2 x (960 x 1080 x 25 x 8) = 605 Mb/s (HD Video) 

The above examples prove that by increasing the number of pixel size of the final video file will 
increase. 
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Summary of Module 

  Calculation of Time Based on Narration and Audio in the scenes/visuals is done by Vertical 
Multitrack Controls and Horizontal Time Controls. 

  Length is the length of in Seconds of Audio Clip for each Scene. 

  Synchronization of music in scenes using Synchronization of the original clips using out 
points, in point and time code and time duration is computed accordingly of scenes. 

  There is a wide range of video formats, in general, each format has the following 
characteristics: Container type, Video and audio signal and Codec.  

Interlaced, Color space and bits per pixel, Resolution, Aspect Ratio, Frame rate, Bitrate are 
characteristics of video signal. Study of file formats concepts (containers/ wrappers, and 
codecs) 

  AVI, MPEG-4, FLV, MOV, OGG, OGM, OGV, MKV, VOB, ASF are most common 
containers/ wrappers used. 

Codecs available and compatibility based on where the video file will be played or viewed 

  MPEG, MPEG 1,2,4, H.264, MPEG Spinoffs, MJPEG, DV, WMV, RM, DivX, Quicktime 6, 
Sorenson 3, WMV9, RP9, Ogg Theora, Dirac 

  SD and HD are compression methods available for media types. 

  FPS is frames per seconds and it effects video with increasing and decreasing fps on video 
file as increasing frame rate makes the video smother. 

  Resolution of video is defined by number of pixels present in the image. This determines if 
definition of the video file is standard definition (SD) or high definition (HD). Higher resolution 
yields bigger file 
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Frequently Asked Questions (FAQs) 

FAQ 1:  What is CODEC? 

Answer 
Container format is a type of file format that contains various types of data 
compressed by standardized codec 

FAQ 2:  How number of pixel effect the resolution? 

Answer 
Number of pixel on screen is called resolution. Thus by increasing the number of pixel 
resolution increases. 

FAQ 3:  SAR and PAR stands for? 

Answer Screen aspect Ratio and Pixel aspect ratio. 

FAQ 4:  Difference between compressed and uncompressed video? 

Answer 
Compressed video are smaller in size but of the same quality and uncompressed 
videos are of same quality but bigger in size. 

FAQ 5:  Minimum frame per second for video? 

Answer 24fps is the minimum standard to be called it a video. 

FAQ 6:  What is Container? 

Answer 
Container format is a type of file format that contains various types of data 
compressed by standardized codec. 

FAQ 7:  Factors that affects the quality of video?  

Answer 
Quality of video depends on color coding, frames per second and number of pixels on 
screen. 

FAQ 8:  Is there any standard frame size of video? 

Answer 
No, there is no such standard. Different countries use different standards like in 
Europe 25fps is stand and in north America its 29. 97. 

FAQ 9:  Which storage device is best? 

Answer 
Luckily there is no such standard. It depends on the size and bit rate of the video it the 
bit rate is big device should be high speed for smooth running of video and vice versa. 

FAQ 10:  What are the characteristics of video file? 

Answer Container, codec and video signal. 
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer 
Keys at the end of this module. 

1.  Video is represented as a series of images formally known as ____________. 

a.  Pics b.  Shots 

c.  Frames d.  Snaps 

2.  The faster the frames are displayed ____________. 

a.  The rougher the video appears b.  The smoother the video appears 

c.  It gets blurry d.  None of these 

3.  Number of pixel on screen is called ____________. 

a.  Frame b.  Resolution 

c.  Compression d.  Bit Rate 

4.  Which of the following is not a characteristic of video signal? 

a.  Interlaced b.  Resolution 

c.  Compression d.  Aspect Ratio 

5.  Minimum frame rate to be called it a video is ____________. 

a.  24 b.  25 

c.  23 d.  26 

6.  Screen aspect ratio for High Definition video is ____________. 

a.  16:9 b.  4:3 

c.  3:4 d.  9:16 

7.  Which of the following is a video format? 

a.  JPEG b.  MPEG 

c.  EMPEG d.  TIFF 
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8.  Characteristic of a video signal is known as ____________. 

a.  Frame Rate b.  Bit Rate 

c.  Resolution d.  All of Above 

9.  AVI stands for: 

a.  Audio Video Interleave b.  Auto Video interleave 

c.  Audio video Interface d.  Audio Video Interaction 

10.  Which of the following is NOT a HD resolution? 

a.  960x1280 b.  780x576 

c.  1920x1080 d.  780*1080 
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Answer Key 
MCQ Number Correct Answer 

1 c 

2 b 

3 b 

4 c 

5 a 

6 a 

7 b 

8 d 

9 a 

10 b 
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Module 4: Photo Editing and Graphic 
Development 

Learning Outcomes 

After completion of this learning module, you will be able to: 

 Edit photos through different editing software, tools and 
techniques available 

 Apply visual effects to a photo to enhance it, such as filters 

 Merge different photos to create one single photo 

 Identify the cost efficient solution based on number of pages and 
number of colours 

 Use of scanner and scanned photos 

 Identify sense of balance and alignment of objects in a layout on 
canvas 

 Use typography, create graphics/ objects 

 Use a good layout to allow better communication of complex 
information to the viewer 
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Learning Unit 1: Photo Editing and Scanning 

Overview 

In this leaning unit, you will learn the tools and techniques used in image editing software to make 
adjustments to the image. After the completion of this learning unit, you will be able to demonstrate the 
color correction techniques, adjust brightness, contrast, color tint, color saturation of the image as a 
whole, retouching, and removing dust. Also, you will be able to define transformation, correct lens 
aberrations, adjust the geometry by crop, rotate, use of filter, merging two photos into one and importing 
photos.  

 

1. Color Correction Techniques 

Color correction is the removal of unwanted color casts by neutralizing blacks, 
grays and/or whites. An adobe Photoshop, color correction can be done using 
two techniques. Using levels and using curves. Both techniques are explained 
below by correcting the same image. 

Color Correction using Levels on following Picture:  

Below are the steps for color correction: 

 
 

1- Open the image in Adobe Photoshop.  

 

 
2- Create a new level layer as: 

Layer->New adjustment Layer ->Levels 

A color cast is an 
unwanted tint in the 
image due to the 
lighting, the white 
balance of the video 
camera, or the type 
of film stock used 
given the lighting 
conditions during the 
shoot. 

Color Cast 

Adobe Photoshop 
can remove the color 
cast created by fog, 
dusty environment of 
light effects. 

Do you know! 



Module 4: Photo Editing and Graphic Development 

140 |                                                      Teaching and Learning Material: Information Technology (Computer Graphics - Motion) 

 

3- Double click at the black eyedropper on the left 

 

4- Color picker will appear, type 5 in the B text box as shown, press ok. 

 

5- Double click at white eyedropper.  
 

 

6- Type 95 in the B text box in the color picker and click OK. 
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7- Add Threshold layer as Layer-> New Adjustment Layer->Threshold. 

 

8- Move the slider towards right until the whole image becomes black. Now move the slider 
towards left a little bit. When a small white area appears Shift+click in the white area as shown 
below. Then move the slider towards left and slowly move towards right when a bit black 
appears Shift+Click in the black area. 

9- Now click at Cancel.  
 

   

10-  Click at New Layer button -> Levels.  

Threshold layer 
helps you to mark 
the lightest and 
darkest points in 
your image. 

Do you know! 
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11-  Click at white eyedropper and then click at marked point 1. 
12-  Click at black eyedropper and then click at marked point 2. 

       
13-  Click Ok. 

 
Before      After 

Color Correction Using Curves: 

1- Open the image in Adobe Photoshop. 
2- Add a curves layer as: 

Layer ->New Adjustment Layer ->Curves. 
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3- In the curves, click at the midpoint, one grid above midpoint and one grid below the midpoint.  

 

4- Move the lower point a bit low and the upper point a bit more up. 
5- Click ok. 

 

With Curves you can 
adjust any point 
along a 0-255 scale 
unlike making 
adjustments using 
only three variables 
(highlights, 
shadows, midtones). 

Curves 
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Before      After 
 

2. Adjustment of Brightness, Contrast, Color Tint, Color Saturation 

Changing Brightness, Contrast and color tint and saturation in Adobe Photoshop 

You can change brightness, contrast and color as. 

1- Open the image in Adobe Photoshop. 
2- Click at Image ->Adjustment ->Brightness/Contrast 

 

 

3- You can adjust the brightness and contrast by moving the sliders. 

 

4- To change color tint and saturation, Click at image->adjustment->Hue/Saturation. 
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5- You can change the color tint (lightness), saturation (intensity) and hue using the sliders. 

 
 

Changing Brightness, Contrast and color tint and saturation in Adobe Illustrator 

1-     Select all the artwork that you want to make less bright 
2-     Go to Edit -> Edit Colors -> Saturate... 
3-     Check the Preview check mark to see the results immediately 
4-     Decrease the intensity until the objects are less bright. 

 

3. Sharpening and Retouching for Removing Dust Specks and Scratches  

Retouching  

Retouching is the process of getting an image ready for final presentation. This can take a variety of 
techniques and process. It can be very simple or dramatic but every image that you see used in 
advertising will be subjected to some form of enhancement. 

Sharpening  

Sharpening enhances the definition of edges in an image. Whether your images come from a digital 
camera or a scanner, most images can benefit from sharpening.  

 
           Before             After 
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Sharpening image in Adobe Photoshop 

You can sharp the image in Adobe Photoshop as 

1. Open your image in Adobe Photoshop. 

2. Click at Filter->Sharpen. 

 

3. Now you can sharpen the image by using different options available in the menu. 

 

Removing Dust Specks and Scratches 

When you scan image from film, slides, or prints, you will face the problem of dust and scratches. You 
can use spot healing brush to remove dust and scratches as 

1- Open the image in Adobe Photoshop. 
2- Click the healing brush tool in the toolbox and then click at spot healing brush tool in the fly-out. 

 

. 

3- Make sure to have following settings for healing brush tool. 
 

a. Set the radius of the brush according to the spot size. 
b. Set Content Aware option. 

 

 
4- Now click at the spots one by one to have all the scratches removed. 

The Healing Brush 
tool lets you correct 
imperfections, 
causing them to 
disappear into the 
surrounding image 

Healing Brush 
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Remove Dust specks and scratches using Clone Stamp 

1- Select the clone stamp tool from toolbox. 

 

 

2- Select a clear point in the image as a source point. Alt+Click at that point. 

 

3- Click at the dust or scratch spot one by one like distorted number 2 in the above picture. 

 

 

4. Understand and Practice the Use of Visual Effects 

Visual effects includes filters which are used to enhance the image. Filters are used to change the 
appearance of an image, layer or selection in Photoshop. Below is the detail of the use of some 
common filters.  

Now we will apply different filters on the image below 

To remove dust 
specks and 
scratches in tight 
spaces like face or 
designs, use clone 
stamp. 

Remember 
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Before Filter effect 

Colored Pencil Filter 

1- Open image in Adobe Photoshop. 

2- Click at Filters->Artistic->Colored Pencil. 

 

3- The output image will be like. 

 

After Filter Effect 

As in the above example you can apply a number of artistic filter in the same way clicking at Filter-
>Artistic… 

Result of some of the filters is as shown below 

Cutout… 
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Dry Brush 

 
Film Grain 

 
Fresco 

 
Neon Glow 

 
 

Paint Daubs 
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Plastic Wrap 

 
 

5. Transformation and Styles 

Transformation 

In Photoshop, Transform is used to scale, rotate, skew, and just distort the 
perspective of any graphic. You can also apply transformations to a path, a 
vector shape, a vector mask, a selection border, or an alpha channel. 
Transforming affects image quality when you manipulate the pixels. The 
different types of transformation used in Photoshop are 

 

Scaling Graphics 

One of the most basic transformations Photoshop is capable of is scaling a graphic. Scaling allows you 
to enlarge or shrink a graphic around a reference point. 

 

Scaling Graphics 

Rotating Objects  

You can rotate an image at any angle in Photoshop. 

Skew, Distort, and Perspective Transformation 

Images or objects can be skewed, distort, and their perspective can be corrected using transformation. 

Warping an Object  

The Warp Transformation is quite a bit different compared to the other transformations. The entire 
shape of the object can be modified, making this transformation useful for several different effects. 

You can apply 
transformations to a 
selection, an entire 
layer, multiple 
layers, or a layer 
mask. 

Do you know! 
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Wrapping Objects 

Styles 

Photoshop provides a variety of effects, such as shadows, glows, and bevels 
that change the appearance of a layer’s contents. When you move or edit the 
contents of the layer, the same styles are applied to the modified contents. For 
example, if you apply a drop shadow to a text layer and then add new text, the 
shadow is added automatically to the new text. 

You can also create custom styles for your layer and can apply more than one 
styles to the layers.  

 

Layer with Multiple Styles 

Double click at the layer and layer style dialogue box will appear. 

 

 

Layer Style Dialogue Box 

Layer styles are 
linked to the layer 
contents. 

Remember 
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You can apply any style you want from the list in the dialogue box like drop shadow, inner shadow, 
outer glow etc. 
 

6. Correcting Lens Aberrations 

Aberrations 

In an ideal optical system, all rays of light from a point in the object plane would 
converge to the same point in the image plane, forming a clear image. The 
reasons which cause different rays to converge to different points are called 
aberrations. 

Lens Distortion/Aberrations  

Barrel distortion is a lens defect that causes straight lines to bow out toward the 
edges of the image.  

Pincushion distortion is the opposite effect, where straight lines bend inward. 

 

Barrel and Pincushion 

 
Chromatic Aberrations 

Chromatic Aberration, also known as “color fringing” or “purple fringing”, is a 
common optical problem that occurs when a lens is either unable to bring all 
wavelengths of color to the same focal plane, and/or when wavelengths of color 
are focused at different positions in the focal plane. 

Barrel distortion 
refers to the shape 
of a barrel and 
pincushion distortion 
refers to the shape 
of a cushion. 

Do you know! 

Chromatic 
aberration appears 
as a color fringe 
along the edges of 
objects caused by 
the lens focusing on 
different colors of 
light in different 
planes. 

Chromatic 

Aberration 
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Chromatic Aberration 
Correcting Lens Aberration 
 
You can correct lens aberration in Adobe Photoshop as 

1- Open image in Adobe Photoshop. 
2- Click at Filter > Lens Correction. 

 

3- Move the slider, drag it until it looks correct and then release. 

 

4- Feel free to fine tune as you see fit. 

             Most lenses only need values between +5 and -3, so go easy here. 

Correcting Chromatic Aberration 

1- Open the image in Adobe Photoshop. 
2- Click at Filter->Distort->Len Correction. Which gives you a new window with a preview and 

control sliders. 
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3- In the Chromatic Aberration box (towards the top) just move the two sliders until your image 
looks great. 

 

Correcting Light falloff  

Vignette is a defect that darkens the corners of an image due to light falloff around the perimeter of 
the lens. 

1- Open the image in Adobe Photoshop. 
2- Click at Filter->Distort->Len Correction. Which gives you a new window with a preview and 

control sliders. 

 

3- Move the lens Vignetting slider until the edges of image are lightened up. 

 

 

7. Adjustment of the Geometry by Crop, Rotate, Correct Perspective and 
Distortion 

Rotating an Image 

To Rotate an Object at any angel in Photoshop, 

1- Open the image in Adobe Photoshop. 
2- Click at Edit > Transform > Rotate.  
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3- Handles will appear but instead of dragging one of these, go just outside of the object until you 
see a curved arrow rotate icon.  

4- At this point, simple drag left or right to rotate the selected object. 

 

5- Press Enter to finish application of rotation. 
 

Cropping an Image 

To crop extra area from the image, 

1- Open the image in Adobe Photoshop. 
2- Select the crop tool from the tool box on the left. 

 

3- Click and drag over the desired area in the image. 

To rotate the image 
in increments of 15o, 
Press and hold Ctrl 
and rotate. 

Do you know! 



Module 4: Photo Editing and Graphic Development 

156 |                                                      Teaching and Learning Material: Information Technology (Computer Graphics - Motion) 

 

4- Press Enter. 

 
Correcting Perspective 

The Perspective transformation allows you to add perspective to an object. To correct perspective in 
Adobe Photoshop. 

1- Open the image in Adobe Photoshop. 
2- Click at Edit->Transform->Perspective. 

 

3- Click and drag the handles that appear on the edges on image to add perspective to the 
image. 

 

4- Press Enter to make the changes permanent. 
 

Correcting Distortion 

To correct distortion, 

1- Open the image in Adobe Photoshop. 
2- Click at Edit->Transform->Distort. 
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3- Click and drag the handles that appear on the edges of the image to distort it in the desired 
direction. 

 

4- Press Enter to make the changes permanent. 

8. Photo Enhancement or Manipulation through the Use of Filters  

Filters in Adobe Photoshop 

You can use filters to clean up or retouch your photos, apply special art effects 
that give your image the appearance of a sketch or Blurred painting, or create 
unique transformations using distortions and lighting effects. The filters 
provided by Adobe appear in the Filter menu. These filter are formed in 
following groups. 
 
Artistic Filter 

Filters from the Artistic submenu help you achieve painterly and artistic effects 
for a fine arts or commercial project. 

You can apply a 
filter to an individual 
channel, apply a 
different effect to 
each color channel, 
or apply the same 
filter but with 
different settings. 

Do you know! 
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Bursh Strokes 

Like the Artistic filters, the Brush Stroke filters give a painterly or fine-arts look using different brush 
and ink stroke effects. 

 

Distort Filter 

The Distort filters geometrically distort an image, creating 3D or other reshaping effects.  
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Sketch Filter 

Filters in the Sketch submenu add texture to images, often for a 3D effect. The 
filters also are useful for creating a fine-arts or hand-drawn look 

 

Stylize Filter 

The Stylize filters produce a painted or impressionistic effect on a selection by displacing pixels and by 
finding and heightening contrast in an image. It includes many filters like, diffuse, glowing edge, 
embose, extrude etc. 

 
 

Distort filters can be 
very memory 
intensive so these 
may occupy much 
space and make the 
design very heavy. 

Remember 
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Texture Filter 

Texture filters is used to simulate the appearance of depth or substance, or to add an organic look. 

 

 

9. Merging Photos 

Merging two or more different pictures allows you to create beautiful graphics in many fields. Photoshop 
lets you create special effects with merging photos. 

1- Open Adobe Photoshop. 
2- Open the two photos that you want to merge in photoshop. 
3- Create a new file by clicking at File-> New and enter the dimentions for the new file. 

 

4- Drag the other two photos in the new image file. 
5- Now remove the unwanted parts of image by selecting the eraser and and set up the size to 

145px and the Hardness to 15%. Set the Opacity to 30% so the Eraser tool will be less effective 
and easier to use. 

 

6- Erase the unwanted parts and use smaller sized eraser for narrow areas.  
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7- Select the Brush tool from the toolbox, set up the size to 100px, hardness 20% and Opacity to 
30% using color which best matches with your images. 

 

8- Use smaller size areas for fine details. 
9- Refine the results. 

 

 

10. Importing Scanned Photos in a Layout 

To import scanned images, either open TIFF files saved from separate scanning software, or use a 
TWAIN or WIA interface directly in Photoshop. In either case, make sure to install the software 
necessary for your scanner. 

 

To correctly erase 
the parts, you can 
also set up the level 
in mode to multiply. 
This way the layer 
becomes semi-
transparent and 
allows you to see 
what you have done 
in the level behind. 

Remember 
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Import Images from a Separate Scanning Application 

Most of the scanners come with softwares that you can run outside of the Adobe Photoshop. To import 
images in photoshop using these software, 

1- Place the image in the scanner. 
2- Start the scanning software, and set options as desired. 
3- Save the scanned image as .TIFF file. 
4- In Photoshop, open the saved TIFF files. 

 

Import images using a WIA interface 

1- Choose File > Import > WIA Support. 
 

 
 

2- Choose a destination on your computer for saving your image files. 
3- Click Start. 
4- Select Open Acquired Images In Photoshop (unless you have a large number of images to 

import, or if you want to edit the images at a later time). 
5- Select Unique Subfolder if you want to save imported images in a folder named with the current 

date. 
6- Select the scanner that you want to use. 
7- Choose the kind of image you want to scan: Color Picture, Grayscale Picture, or Black And 

White Picture or Text. 
8- To specify custom settings, select Adjust The Quality Of The Scanned Picture. 
9- Click Preview. If necessary, drag the handles of the bounding box to adjust the size of the crop. 
10- Click Scan. 

The scanned image is saved in BMP format. 
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Learning Activity 

Removal of Color Tint from an Image 

Description:  This activity consists of a practical session in which all students select image 
with a color tint for them and try o remove the tint using threshold layer and 
curves. 

Time Guideline: 30 min 

Purpose:  To practice the use of threshold layer and curves for removing color tint in an 
image 

Presentation: 
 

1- Browse Internet and collect some images having color tint.  
2- Give an image to each student and ask them to remove the tint in 

Adobe Photoshop. 
3- Check the performance of each student 
4- Encourage the learners for their try. 
 

Application of Filters to Image 

Description:  This activity consists of practical session in which students will learn about the 
effect of different filters on an image. 
 

Time Guideline: 30 min 
 

Purpose:  To differentiate between different filters in Adobe Photoshop. 
 

Presentation: 
 

1- Ask the students to select an image for them and apply different filters 
to those images in Adobe Photoshop. 

2- Ask them to label each filter effect. 
3- Assess the student’s performance. 
4- Encourage each students for his try. 
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Learning Unit 2: Create Layout 

Overview 

In this learning unit, you will learn how to develop a layout on canvas. After completion of this learning 
unit, you will be able to create media elements, graphs, tables, text and diagrams using the techniques 
and also applying colors to the developed objects. 

 

1. Create Objects on Canvas 

A layout is the starting point for a design. It may include media elements, graphics, tables, diagrams 
etc. it is important to keep in mind that all the elements in the design layout should be in balance with 
correct harmony. 

We can develop a layout in Corel Draw For example let’s develop a simple notepad as shown below. 
You can develop a simple notepad graphics on the canvas as. 

 

1- Open Corel Draw. 
2- Create a new file by clicking at File->New. 

 

3- Enter the dimensions for the new file. 
4- Select the "Rectangle Tool ", from the left toolbar, make a new box shape and then make the 

box shape resized into 885 x 635 pixel. 
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5- Select Shape Tool from toolbox and go to the upper toolbar there you will find corner shape 
option, set the type into Rounded Corner, and set the Corner Radius to 107 px, apply it on all 
corners. 

 

6- Select the box go to the "Fountain Fill Tool ", choose custom fill on the color blend and make 
the type Linear, fill the color with Gray on the left and white on the right. 
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7- Now create a tiny Circle Shape using “Ellipse Tool “in the left toolbar. 

 

8- Arrange the Circles on top of the Gray Box Shape, give it Orange color and copy it as picture 
below. 



 Module 4: Photo Editing and Graphic Development 

Teaching and Learning Material: Information Technology (Computer Graphics - Motion)                                                      | 167 

  

9- Create a line using “Bezier Tool “by left click and point. 

 
 

10- Shape it using “Shape Tool ", click on the middle of the line and find "convert to curves” in the 
top toolbar, drag the arrow on the corner in order to shape. 
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11- Make it outline strong arrange the shaped line on top of the Orange Circle.  

 

12- Create horizontal line and place them on top of notepad. 

 
Creating Graphs in Adobe Illustrator 

1- Open Adobe Illustrator. 
2- Create a new document and click at Graph Tool, Left click and drag, you will see a graph 

dimensions box, this is primarily how big your graph will be. 

 

3- You will see a table to put your data, enter all your data in the table. 
4- You will see a chart like in the picture (this illustrate is a Column Graph Tool). 

Develop all the 
elements of the 
layout in the same 
way and then 
integrate them with 
balance in the form 
of a layout. 

Remember 
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5- You can change the default graph by click on the graph (currently a bar chart), press the right 
click and select Type, let’s change its type to area graph. 

 

6- You can change your graph color or elements by use Direct Selection Tool. 

 

Creating table in Adobe Illustrator 

1- Open Adobe illustrator. 
2- Create a rectangle of desired size using rectangle tool. 

 

You can select the 
indivisual 
components of the 
graph and apply 
different formating. 

Remember 
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3- Click at your rectangle and choose Object at the main menu, scroll down to Path and select 
Split into Grid. 

 

4- Set the number in Gutter box to 0px, type the number of row and column in the boxes and click 
OK. 

 

 
5- You will get a table and can change the color, stroke or type a text in each box. 

 

 



 Module 4: Photo Editing and Graphic Development 

Teaching and Learning Material: Information Technology (Computer Graphics - Motion)                                                      | 171 

Creating table in Corel Draw 

1- Open Corel Draw. 
2- Create a new file as file->New. 
3- Click at graph paper tool in the flyout next to the polygon tool. 

 

4- Enter the number of rows and columns in the graph paper tool property bar. 

 

5- Click and drag to create the table of desired size. 

 

6- Just Ctrl+Click on cells to select and then specify the color or any other formatting.  
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7- Fill in the data into the table and you are done.  

 

Creating diagram in Adobe Illustrator 

Adobe Illustrator contains many tools which are helpful for creating professional diagrams. In the 
following steps we will draw a diagram in Adobe Illustrator. 

1- Open Adobe Illustrator. 
2- Create a new file as File->New and specify the height and width of the document. 

 

3- In our example we choose sketch of a hamburger. 
4- Now create a new layer, use the "Ellipse Tool" on the toolbar. set the fill on toolbar to "none" 

and set the stroke color to "black" and the stroke weight to 1. Place the shape on the sketch 
following the sketch. 

 

You can apply 
formatting to any 
group of or 
individual rectangle 
cell of the table 

Do you know! 
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5- Create the other shapes for your sketch. Use "Pen Tool" to create a tomato slice, cheese and 
bread. Use "Pencil Tool" to create the meat and vegetable fillings.  

 

6- Draw all the shapes for ingredients on Hamburger. 

 

7- A dd color to the ingredients. Use the "Gradient Tool" to add color to two all the layers. 

 

8- Add sesame seed on the top of burger using pen tool and you are done with the diagram. 

Draw a sketch by 
hand or you can 
draw sketch in 
adobe Photoshop 
and open that 
sketch in Adobe 
Illustrator. 

Do you know! 
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2. Apply Colors to Objects 

While applying colors to the layout, keep in mind the purpose and target audience of the layout design. 
As all the colors have special meaning so in order to have better communication of the complex 
information to the viewer, selection of right color scheme is vital. 

Colors scheme involves colors applied on various objects like, background, shapes, buttons, icons, 
typography, logo giving an overall sense of unity to the design 

 

Different color used for objects 

Appying colors in Corel Draw 

In Corel Draw, you can apply two types of color fills to the objects. 

1- Solid Color Fill 
2- Fountain Color Fill 

Solid Color Fill 

Solid color fill is a single color fill with a large number of shades available in 
corel draw. You can apply solid color fill as 

1- Click at the object you want to color, to select it. 

 

You can also use 
the texture, pattern, 
bitmap of different 
color to apply color 
to the objects. 

Do you know! 
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2- Click at the color in the color pallette to change the fill color and right click at the color to change 
the outline of object.           

 

Fountain Color Fill 

1- Click at the object to select it. 

 

2- Choose the Interactive Fill tool from the Interactive Fill flyout in the toolbox. 

 

3- Using the default settings you can get a gradient fill from black to white. From the 
toolbar you can choose what type of fill as shown below 

 
 

4- Drag and drop colors onto the handles of the fill to change the colors.  
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5- Move the drag handle on the fill to alter the gradients of the fill.  
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Summary of Module 

  Color correction is the removal of unwanted color casts by neutralizing blacks, grays and/or 
whites. An adobe Photoshop, color correction can be done using two techniques, Using 
levels and using curves. 

  
Retouching is the process of getting an image ready for final presentation. Sharpening 
enhances the definition of edges in an image. 

  
When you scan image from film, slides, or prints, you will face the problem of dust and 
scratches. You can use spot healing brush and clone stamp to remove dust and scratches. 

  
Visual effects includes filters which are used to enhance the image. Filters are used to 
change the appearance of an image, layer or selection in Photoshop. 

  
In Photoshop, Transform is used to scale, rotate, skew, and just distort the perspective of 
any graphic. You can also apply transformations to a path, a vector shape, a vector mask, 
a selection border, or an alpha channel. 

  
Photoshop provides a variety of effects, such as shadows, glows, and bevels that change 
the appearance of a layer’s contents. When you move or edit the contents of the layer, the 
same styles are applied to the modified contents. 

  
In an ideal optical system, all rays of light from a point in the object plane would converge 
to the same point in the image plane, forming a clear image. The reasons which cause 
different rays to converge to different points are called aberrations. 

  
You can use filters to clean up or retouch your photos, apply special art effects that give 
your image the appearance of a sketch or Blurred painting, or create unique transformations 
using distortions and lighting effects. 

  
To import scanned images in Adobe Photoshop, either open TIFF files saved from separate 
scanning software, or use a TWAIN or WIA interface directly in Photoshop. 
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Frequently Asked Questions (FAQs) 

FAQ 1:  Explain Colour theory? 

Answer 
Colour can play a large role in the elements of design and colour theory providing a 
body of practical guidance to colour mixing and the visual impacts of specific colour 
combination. 

FAQ 2:  Why do we use threshold to remove colour cast? 

Answer Threshold helps you to point the lightest and darkest area in your image.  

FAQ 3:  Enlist different Colour Modes? 

Answer 

1. RGB mode (millions of colours) 
2. CMYK mode (four-printed colours) 
3. Index mode (256 colours) 
4. Grayscale mode (256 grays) 
5. Bitmap mode (2 colours) 

FAQ 4:  Why do we use transformation? 

Answer 
Transformation is used to change the geometry of the objects. It rotates skews, 
distorts and adds perspective to the image. 

FAQ 5:  What barrel distortion? 

Answer 
Barrel distortion is a lens defect that causes straight lines to bow out toward the edges 
of the image. 

FAQ 6:  What is pincushion distortion? 

Answer Pincushion distortion is the opposite effect, where straight lines bend inward. 

FAQ 7:  What is chromatic aberration? 

Answer 
Chromatic Aberration is a common optical problem that occurs when a lens is either 
unable to bring all wavelengths of colour to the same focal plane, and/or when 
wavelengths of colour are focused at different positions in the focal plane. 

FAQ 8:  Describe Vegetating? 

Answer 
Vegetating is a defect that darkens the corners of an image due to light falloff around 
the perimeter of the lens. 

FAQ 9:  What are two ways to import scanned images in Photoshop? 

Answer 
1. Import images from a separate scanning application. 
2. Import images using a WIA interface 

FAQ 10:  Where to use clone stamp for removing dust specks and scratches? 

Answer 
In the tight spaces like face or design, dust specks and scratches should be removed 
using clone stamp. 

  



 Module 4: Photo Editing and Graphic Development 

Teaching and Learning Material: Information Technology (Computer Graphics - Motion)                                                      | 179 

Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key 
at the end of this module. 

1.  Color cast is caused by ______________. 

a.  Lens flaw b.  Software Mistake 

c.  Photographer Mistake d. Lighting, fog etc. 

2.  Tints are created by adding _______________ to a color. 

a.  White b.  Grey 

c.  Black d.  Red 

3.  Saturation means ___________ of a color. 

a.  Hue b.  Tint 

c.  Intensity d.  Shade 

4.  Sharpening __________. 

a. Makes an image brighter  b. Enhances definition of edges in image 

c. Makes image colors more intense d.  Develops tints of colors in image 

5.  The tools used to remove dust and scratches are _________. 

a. Healing Brush and Patch tool b. Color Brush and Patch tool 

c. Clone Stamp and Patch tool d.  Clone Stamp and Healing Brush 

6.  Which of the following is not a Filter group? 

a. Adjustment b. Texture 

c. Artistic d.  Sketch 

7.  Select the incorrect option, Transformation is used to _________. 

a. Skew b. Rotate 

c. Scale d.  Sharp 



Module 4: Photo Editing and Graphic Development 

180 |                                                      Teaching and Learning Material: Information Technology (Computer Graphics - Motion) 

8.  Chromatic Aberration is also called___________. 

a. Red Fringing b. Purple Fringing 

c. Blue Fringing d.  Green Fringing 

9.  The option for removing Aberration is present in _________. 

a. Filter->Distort->Lens correction b. Edit->Distort->Lens correction 

c. Filter->Sharpen->Lens correction d.  File->Sharpen->Lens correction 

10.  _________________ Filters are memory intensive. 

a. Artistic b. Brush Strokes 

c. Distort d.  Stylize 
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Answer Key 
MCQ Number Correct Answer 

1 d 

2 a 

3 c 

4 b 

5 d 

6 a 

7 d 

8 b 

9 a 

10 c 
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Module 5: Video Editing and Motion 
Development 

Learning Outcomes 

After completion of this learning module, you will be able to: 

 

 Learn and apply colour correction to the video using filters 

 Use filters to enhance video 

 Add effects and transitions with creativity to convey message to 
audience 

 Import and embed media assets into the project 

 Create motion 
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Learning Unit 1: Apply Colour Correction 

Overview 

In this learning unit, you will learn the techniques of applying colour correction to the video. After 
completion of this learning unit, you will be able to apply colour correction to the video using filters. 

1. Applying Colour Correction to Videos 

There are three key statements about colour correction that you need to 
understand in order to be successful with this filter: 

 “Grey” has two meanings: the colour grey and the grey-scale grey. 

 When you talk about the “grey-scale” value of grey, you are talking 
about how light or dark a particular image or pixel is. 

 When you talk about grey as a “colour,” you mean that the amount of 
red, green, and blue contained by that shade of grey are equal. 

NOTE: Colour in video is additive. Equal amounts of red, green, and blue 
equal grey.  

Red + green = yellow.  

Blue + green = cyan.  

Red + blue = magenta.  

There is no necessary relation between the grey-scale value of a colour (how 
light or dark it is) and the colour value of a colour. The two are adjusted 
independently. If an object in the frame that is supposed to be grey has more 
red (or yellow, or blue, or any other combination of colours), it is said to have 
a colour cast. 

The Fast Colour Correction filter measures the amount of red, green, and blue 
in an object that is supposed to be grey. It then adjusts the colour of the entire 
clip by adding or removing colours until that grey object is restored to equal 
amounts of red, green, and blue. At which point, both the object and the clip will look “normal”. 

2. Colour Correction in order to convey Feelings 

View 

Corrected Layer shows the results of the Change Colour effect. Colour Correction Mask shows the 

areas of the layer that will be changed. White areas in the colour correction mask are changed the 

most, and dark areas are changed the least. 

 

Hue Transform 

The amount, in degrees, to adjust hue. 

This is a really 
important point. In 
fact, much of colour 
correction hinges on 
a restatement of 
this: “If something 
is supposed to be 
grey. It must contain 
equal amounts of 
red, green, and 
blue.”  If it doesn’t, it 
has a colour cast. 

Remember 

It sounds complex, 
but this filter is 
designed to fix 
problems quickly. 

Do you know! 

The Change Colour 
effect adjusts the 
hue, lightness, and 
saturation of a range 
of colours. 

Do you know! 
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Lightness Transform 

Positive values brighten the matched pixels; negative values darken them. 

 

Saturation Transform 

Positive values increase saturation of matched pixels (moving toward pure colour); negative values 

decrease saturation of matched pixels (moving toward grey). 

 

Colour To Change 

The central colour in the range to be changed. 

 

Matching Tolerance 

How much colours can differ from Colour To Match and still be matched. 

 

Matching Softness 

The amount that unmatched pixels are affected by the effect, in proportion to their similarity to Colour 

to Match. 

 

Match Colours 

Determines the colour space in which to compare colours to determine similarity. RGB compares 

colours in an RGB colour space. Hue compares on the hues of colours, ignoring saturation and 

brightness—so bright red and light pink match, for example. Chroma uses the two chrominance 

components to determine similarity, ignoring luminance (lightness). 

 

Invert Colour Correction Mask 

Inverts the mask that determines which colours to affect. 

 

3. Procedure of Colour Correction 

The procedure of colour correction has the following steps: 

 

1. Open the project and sequence containing the clip(s) you want to fix, and 

select the clip with a colour problem. 

 

Here’s the problem: a very green clip. Not only does it look green to the eye, 

but the vector scope also shows a strong shift (called a “colour cast”) toward 

yellow/green. 

 

2. Go to the Effects Panel, twirl down Video Effects, twirl down Colour 

Correction and either double-click Fast Colour Corrector to apply it to all 

selected clips in the Timeline, or drag it on top of a clip that needs correction. 

Sequence clip 

Colour Problem 
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3. With the clip still selected, click the Effect Controls tab to display the Fast Colour Corrector 

controls. There are only a very few settings you need to adjust. 

 

 

The black areas are 
also grey (the 
colour), but when it 
comes to colour 
correction, we have 
the greatest latitude 
when we correct 
mid-tone (50%) grey 
values, rather than 
shades very close to 
white, or very close 
to black. And, never 
try to colour correct 
over-exposed 
sections of the 
frame. 

Do you know! 
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Using this filter is simple: find something in the frame that’s supposed to be grey and click it. 

 

4. Just above the colour wheel in this filter is the White Balance eyedropper. Click the eye-dropper 

to select it. 

 

 
 

Then, in the Program monitor, find something in the frame that’s supposed to be grey. This is 

the point where semantics start to get in the way, because “grey” is both a measure of 

brightness and a colour. In the sense of colour correction, white is a grey, black is a grey, and 

grey is a grey, because all three contain equal amounts of red, green, and blue. So, in this 

image, the car’s grey (the colour) should also be in rich colour (contain equal amounts of red, 

green, and blue.). But, in this case, it isn’t, it has a blue/green colour cast. 

 

5. To correct this clip take the eyedropper, which you just selected, and click it on something that 

should be grey, but isn’t. In this example, I’m clicking on the side of the car. Ideally, you want 

something which is not too light nor too dark. 

 

 
 

 Instantly, the picture looks better. 

 

You can repeat this process by clicking on different “should-be-grey’ elements in the frame, though 

after two or three more clicks, you won’t see any additional improvement. 

 

Making More Adjustments 

 

If you want to make additional colour corrections, then: 

 

6. Grab the white dot in the middle of the colour wheel and drag it in the direction you want the 

colours to move. 
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Colour Wheel 

 

If necessary, click one or two other parts of the car to improve the correction. You can see the results 

on the Vector scope with the body of the car very nicely. (The “outline” is the yellow line going up left 

at about 1030 on a clock.) 

 

 
 

7. If you need to adjust the black or white levels, switch your scope to display the YC Waveform 

monitor (click the Wrench icon) and be sure to uncheck Setup (7.5 IRE) and Chroma. 
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8. Then, adjust the Input Levels settings for black, mid-tone grey, and white.  

 

 
 

Here is a before and after of our image. 
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Learning Unit 2: Apply Visual Effects and Transition  

Overview 

In this learning unit, you will learn to add effects and transitions with creativity to convey message to 
audience. The software lets you edit uploaded or downloaded video in a variety of ways, including 
visual effects. You can also insert variety of effects to transition between 2 chronologically adjacent 
video clips in your project. This guide shows you how to choose and implement a transition in Adobe 
Premiere Pro. 

1. Use of Built in Filters for Adding Visual Effects 

Video Filters and Audio Filters can be applied to existing clips on your 
timeline. Drag a plug-in from the effects palette onto a clip to apply it. Premiere 
is known mainly as a video editor, a big part of making finished productions is 
ensuring that the audio side of things is nicely put together too. So Premiere 
has a number of built-in audio and video filters to help you work with sound in 
your projects, whether it’s location sound, foley, ADR or even music. 

1. In your Premiere project, select an audio clip in the timeline and then 
go to the Effects bin located in the bottom left corner of Premiere’s 
window. Click on the Audio Effects folder to expand it outwards: 

 

Audio Effects Folder 

 

Different filters can 
be used to convey 
different messages. 

Do you know! 

You can also give 
Visual effects as 
audio effects to your 
video. 

Do you know! 
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Video Effects Folder 

2. Locate an effect you want to use and drag and drop it onto the audio clip you want to apply it 
to. Then double-click on the clip and it should appear in the Source viewer window. Click on the 
Effect Controls tab to access the effect controls.  

 

 

3. Click on 'Custom Setup', you can open a dedicated 
control window for the effect. In this case it lets you set 
the threshold for de-essing a vocal track such as a 
voiceover. You can set a male or female voice, and 
tweak the threshold while playing back until you reach 
the correct level of de-essing. There’s a tiny button at the 
bottom of this window that lets you play back just the 
audio and not the video.  

4. To change an effect’s settings over time, go to the 
Individual Parameters field and click to expand it. Now 
you can use the key framing tool to put in different values 
at different points in time. This is a form of automation 
and is really useful when, for example, one part of a 
sentence needs heavy de-essing, but another part is 
muted by the same level of de-essing.  

Using key frames 
you could easily turn 
the threshold up and 
down over time. The 
same technique 
applies to any effect 
that needs to 
change over time, 
such as a reverb 
getting larger and 
larger in size to 
simulate the sound 
of someone getting 
further away.  

Remember 

http://macprovid.vo.llnwd.net/o43/hub/media/1093/6781/pic2.png
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5. To edit key frames you can simply click on them and then move or delete them. To remove an 
effect altogether, right-click on it and choose Cut or Clear. Click the tiny FX button to the left of 
an effect’s name to temporarily turn it off.  

    

6. As well as some good stock built-in effects like declicker, EQ and 
reverb, Premiere can also see third party audio plug-ins installed on 
your Mac. If you have any they should appear in the plug-ins list.  

    

7. You apply external plug-ins in the same way as you did Premiere’s own.  

Bear in mind that if 
Premiere won’t allow 
you to drop an audio 
effect onto an audio 
clip, it means that 
the two have 
mismatched 
formats. A stereo 
effect can’t be 
dropped onto a 5.1 
surround track, for 
example. If you 
need to do this for 
some reason you 
can always right-
click on the audio 
clip and choose to 
edit in Audition, then 
have it sent back to 
the Premiere 
project.  

Remember 
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8. Premiere sometimes has trouble displaying third party plug-in interfaces 
so if you need to do this you can always switch briefly to Audition. Otherwise, 
use the Individual Parameters lane to access each control and key frame it over 
time if you like.   

  

9. Most audio filters and plug-ins run properly in real-time but if you are experiencing problems 
you always have the option to render the audio clip down to a new file, complete with the effect 
applied to it. To do this, simply go to ….. 

Clip > Audio Options > Render and Replace 

Premiere will create a new copy so your original audio remains safe and unchanged.  

2. Use of Built-in Transition to Move from one Scene to Another 

A transition is the way one shot changes to the next. By default, if two clips are 
placed next to each other in the timeline, the transition is a cut. To make more 
interesting transitions such as dissolves, wipes and effects, use the transitions 
available in the Effects window.  

Premiere has default video and audio transitions which can be added to clips 
in various ways. This can be much more efficient if you use the same transitions a lot. By default, these 
transitions are Cross-Dissolve for video and Constant Power (crossfade) for audio. 

 

 

Try to place 
transitions so they 
make sense with the 
video you are 
editing. For 
example, a cross-
dissolve effect can 
be used to blend two 
scenes together, 
while a dip-to-black 
effect is more suited 
for the beginning or 
ending of an overall 
project, as it fades in 
or fades out to 
soften the visual 
impact on the 
viewer. 

Remember 

A transition gives 
the viewer sense of 
continuality. 

Remember 
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3. Procedure of Adding Transition 

The procedure of adding transition has the following steps:  

1. Select the "Effects" panel in the lower-left corner of the interface. 

   

2. Open the "Video Transitions" folder. 

   

3. Select the folder of the type of transition you want to use. The number 
and types of transitions depend on your version of Premiere Pro. 
Common transition types include dissolve, 3D motion, and slide. Each 
folder contains transitions that are stylistically similar but offer slightly 
different effects.  

   

4. Click and hold on the transition you want to use, then drag it over to your video clip panel.  

Don’t drop a 
transition in between 
two clips unless the 
clips are overlapped.  
 
Transitions will 
automatically be 
placed at the 
beginnings and 
endings of each clip 
if they aren't. Make 
sure to overlap the 
end of the first clip 
with the beginning of 
the second, allowing 
the transition to use 
the frames of both 
clips simultaneously. 
This will create a 
smoother effect. 

Remember 

When you play the 
video clips back, the 
transition may 
stutter and jerk, 
depending how 
much you shortened 
or lengthened the 
effect. It is signified 
by a red bar at the 
top of the video clip 
panel. Simply hit the 
"Return" key on Mac 
or "Enter" key on 
Windows to create a 
rendered video 
preview. This will 
make the video and 
transitions flow 
smoothly. 

Remember 
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5. Drop the transition into a position on the video clip bar. Transitions can be placed in between 
two overlapped clips, as well as at the beginnings and endings of each clip 

      

6. Click and drag the left and right edges of the transition to shorten it or 
extend it. Each transition has a default time length you can alter in this way.  

      

4. Brightness / Contrast Effect in Video Techniques 

You’ll learn how to maximize the brightness and contrast of your video in Adobe Premiere Pro using 
the Brightness, Contrast, and Gamma Correction controls for effective and balanced adjustments. 

5. Procedure of Adding Brightness / Contrast Effect 

The procedure of Brightness / Contrast Effect has the following steps: 

1. For adjusting the colour or brightness in a video in Premiere Pro, Click…..    Window   >   
Workspace, and select Colour Correction. 

Try to place 
transitions so they 
make sense with the 
video you are 
editing. For 
example, a cross-
dissolve effect can 
be used to blend two 
scenes together, 
while a dip-to-black 
effect is more suited 
for the beginning or 
ending of an overall 
project, as it fades in 
or fades out to 
soften the visual 
impact on the 
viewer. 

Remember 
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2. Customized the workspace, so it might look a bit different, but the main pieces you see in Figure 
(below) will be showing: The Waveform Monitor in the centre, the Effect Controls on the left, 
the Timeline below, and the video in the Program Monitor on the right.  

     

3. Click to select  The Waveform Monitor fly out panel > 

Composite Video or Alpha View.  

   

4. Click - All Scopes to see all the scopes available, shows an RGB parade, a YUV parade, a 
waveform, and a vector scope. Choose YC Waveform to return to just that view.  

Brightness 

& Contrast 

The reference 
monitor has many 
alternate views that 
you can access by 
clicking the flyout 
panel. 

Remember 

It shows us the 
brightness of the 
pixels at their 
respective location 
in the frame. 

YC Waveform 



Module 5: Video Editing and Motion Development 

198 |                                                      Teaching and Learning Material: Information Technology (Computer Graphics - Motion)      

 

5. Working with the YC Waveform 

 

You can see where the white and black areas of the image are represented in the waveform, but 
the levels aren't what they should be in either case. 

In a well-lit, well-contrasted scene, the whites should be up around 100 on the IRE (Institute of Radio 
Engineers) scale, which ranges from 0 to 100. As you can see, the whites start at about 80 and range 
up to about 95. 

Blacks, such as those you see on the bottom edge of the whiteboard--and directly below the cluster of 
whites in the waveform--should be right around 0 IRE. As you can see, the darkest pixels are 20 IRE 
or above, which is the cause of most of our contrast issues. 

The third region you examine when adjusting contrast are the pixels in the face, which should be 
between 65 and 75 IRE at their brightest. To get the best view of the brightness of the face, move the 
current-time indicator (CTI) to a spot on the timeline where there is movement in the subject's face, 
and drag the CTI back and forth. In this example, you can see that the bulk of the pixels are moving 
below 60 IRE. This means the face, which should be registering around 65-75 IRE, is too dark. The 
whites are close to where they should be (ranging 80-97 IRE or so), but the blacks are faded (bottoming 
out around 18), and that's why the image lacks in contrast. 

The effect control you'll use to solve this problem is the Brightness & Contrast control. Adjusting 
Brightness upwards doesn't just make the whites brighter--it moves up the levels of everything in the 
image. 

6. Drag the Brightness slider to the right, the Waveform Monitor shows that all the pixels move 
upwards in the waveform as the entire image becomes brighter.  
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7. The Contrast adjustment, by contrast, pushes the pixels further away from each other--
reflecting the definition of contrast as the difference between the brightest and the darkest pixels 
in an image. This pushes the whites toward 100 IRE and the blacks toward 0 IRE.  

 

8. Every video is different and your adjustment strategy will differ as well. 
If you adjust the Brightness down, and then adjust the Contrast to push 
the white and black levels towards the extremes. Now you have the 
whiteboard at or around 100 IRE. The black pixels are at or around zero, 
and the dinginess is gone.   

 

9. Crushing the detail by pushing the brightness down, this made the face darker. 

The Gamma 
Correction effect 
lightens or darkens 
a clip without 
substantially 
changing the 
shadows or the 
highlights. So, in 
theory, this should 
allow us to boost 
just the mid tones in 
the face without 
pushing up the 
whites or pushing 
down the blacks. 

Gamma Correction 
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Using Gamma Correction to Adjust the Mild Tones 

10. Toggle the effect on or off and get the result. After enabling Gamma Correction. Drag the slider 
to increase brightness in the midtones. If drag it to 9. You see that you're pushing some of the 
blacker pixels up off the 0 IRE, but you're seeing very little movement in the whites. 

 

11. Push the Gamma Correction effect further to the left, it crush the whites a bit, but not to the 
same degree as adjusting the brightness control directly. If dial Gamma Correction back to 8, It 
adjust the Contrast to keep the black pixels at 0 IRE. 

 

Flickering and the Shadow / Highlight Effect 
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12. One other effect that's useful for brightness and contrast adjustments is called the 
Shadow/Highlight effect. 

 

Before (Top) and After (Bottom) 
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6. Understanding of Other Effects 

Adding and Deleting Tracks: 

You can control the number of video tracks and the number and type of audio tracks by creating a 
custom pre-set. After you start editing, you can always add and delete tracks as needed. 

7. Procedure of adding a single Video or audio tracks / clips 

The procedure of adding a single Video or audio tracks / clips has the following steps: 

1. To add a single video track, Right-Click the video track header area  and then Click Add 

Track  

   

 Right-click the video track header area Choose Add Track.  

 

2. To Add a Single Audio Track, 

You can also create 
a new track by 
dragging a clip from 
the Project panel to 
the blank area 
above the video 
tracks and below the 
audio tracks. 

Remember 
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Right-Click the Audio Track Header Area  and then Click Add Track   

3. To Delete a Single Video or Audio Track / Clip 

To delete a single audio or video track,  

Right-Click the Track Header  and Click Delete Track.  

 

 To delete a single track, Right-Click the Track Header and Click Delete Track. 

When you use this 
option to add an 
audio track, 
Premiere Pro adds 
a standard audio 
track, which can 
accept only mono or 
stereo audio. If you 
need to add a 
different kind of 
track, use the 
technique described 
in “To add multiple 
tracks,” on the next 
page. 

Do you know! 
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4. To Add Multiple Tracks / Clips 

1. Right-click the track header area and choose Add Tracks.   

 

 Right-click the track header area. 

 

       Click Add Tracks. 

             Open the Add Tracks dialog. 
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2. Specify the number of video tracks to add, and choose their placement .  

 

  Choose the number and placement of video tracks. 

3. Specify the number, placement, and track type for audio tracks . 

 

 Choose the number, placement, and track type for audio tracks. 

4. Specify the number, placement, and track type for any audio submix tracks .  

 

 Choose the number, placement, and track type for submix tracks. 

5. Click OK to close the Add Tracks dialog and add the specified tracks. 

 

Audio Tracks in Premiere Pro 

Premiere Pro uses six different audio tracks. 
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 Standard: A standard track can contain both stereo and mono audio tracks and is the default 
for new audio tracks. 

 Mono: Contains one audio channel. If you drop a stereo file into a mono track, the stereo is 
converted to mono. 

 5.1: Contains only 5.1 surround sound tracks, which include three front audio channels (left, 
centre, and right); two rear channels (left and right); and one low-frequency subwoofer channel. 

 Adaptive: Can contain mono or stereo tracks, and are used when you need to map the source 
audio to different output channels. 

 Audio submix track: A synthetic track that contains no audio other than audio sent to the 
submix from other audio tracks. 

 Master audio track: Controls the combined output of all tracks in the sequence so, for example, 
you can adjust overall track volume via a single slider in the Audio Mixer. 

 

To delete multiple tracks 

1. Right-click the Track Header Area  and choose Delete Tracks. 

 

 Choose Delete Tracks to delete multiple tracks. 

2. To delete video tracks,  

Select the Delete Video Tracks check box and identify the tracks to delete in the associated 

drop-down menu .  
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  Identify the video tracks to delete. 

3. To delete audio tracks, select the Delete Audio Tracks check box and identify the tracks to 

delete in the associated drop-down menu.   

 

  Identify the audio tracks to delete.  

4. To delete audio submix tracks, select the Delete Audio Submix  

Tracks check box and identify the tracks to delete in the associated drop-down menu.  

5. Click OK to close the Delete Tracks dialog and delete the specified tracks.  

 

Creating Title Slides for Credits 

 Though static titles, graphics, and logos serves for some projects, many 
others require titles that move across the screen.  

 (Titles that move vertically over the footage are called Rolls. Titles that 
move horizontally are called Crawls.) 

Rolling titles are 
must for any 
professional film 
production.   

Remember 

Use the keyboard 
shortcut: CONTROL 
+ T (PC) or 
COMMAND + T 
(Mac).  

Do you know! 

The length of the 
title clip in a 
Timeline panel 
determines the 
speed of the roll or 
crawl. The more you 
increase the title clip 
length, the slower 
the movement. 

Do you know! 
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8. Procedure of Creating Title Slides for Credits 

The procedure of creating title slides for credits has the following steps: 

Titles can be created in a number of ways in Adobe Premiere Pro 

For a static title: 

1. Click the ‘new items’ button at the bottom of the project panel or access 
the title tool through the Menu bar – File > New > Title. 

For a rolling title: 

2. Menu bar choose Title > New Title > Default Roll. 

 

3. If you want to convert a static title into a rolling one click the Roll/Crawl option box 

 

…and select the ‘Roll’ option in the dialogue box that appears: 

 

 

Use the keyboard 
shortcut: 
CONTROL+T(PC) 
or 
COMMAND+T(Mac)
.. 

Do you know! 

The advantage of 
doing it this way is 
that it will create a 
new title with the 
right options in place 
for setting up the 
roll. 

Do you know! 
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Creating a Text Area in Premiere 

1. Selecting the text tool and starting to type. 

This will create ‘point text’ (text that continues off the screen and will not 
wrap around) – you need to create ‘area text‘. 

This can be done in one of two ways. 

Select the Area Type Tool 

2. Drag out an area from the top left of the inner box (called the title safe area) to the bottom right 
of the same inner box.  Simply click inside this area to add text. 

Another option is to drag the Standard Text Tool inside the box in the same way:  

 

 

Once text has gone off screen you get the little ‘+’ sign (shown in the image above) which is 
simply telling you that there is more text than shown. So, how do you show that text to create 
the rolling title? 

 

Rolling Titles  

1. Select the Text Tool. 

2. Hold the Control Key (on PC) or Command Key (on Mac), and drag the handle at the middle of 
the bottom of the scree until you can see the next text (as show below)…. 

 

Handles 

When you hit the Ctrl / Cmd key to create the rolling title choose the middle bottom ‘handle’. 

3. When you will get this up/down arrow. Click and hold your mouse button and drag down until 
you see all the text you have created so far.  

When you have 
finished the text 
cursor should be 
flashing.  
It isn’t, just click in 
the new area you 
have created with 
the standard ‘T’ text 
tool and you are 
ready to start 
creating your titles. 
Font, size etc. are all 
up to you. 

Remember 
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Drag Arrow 

4. Now it moves into a process of repeating the same thing over and over. Type the next names 
in until they go off screen and then hold the Ctrl / cmd key and drag down and let go when you 
can see all the text. 

 

After Dragging the Handle  

 

5. Lastly, when you’ve got all your list of credits into the title, hit return a few time then Ctrl / cmd 
drag down to a point where the names are off the top of the screen and you can type something 
like:  

 

Copyright 2012 All rights reserved 

1. Now you’ve set up the title, use that Scroll Bar on the right hand side to 
preview how your title will look.  

 

If you want the © 
symbol on a PC the 
shortcut is Alt + 
0169 on the main 
keyboard. For a 
MAC the shortcut is 
Alt + G. 

Remember 

If something looks 
wrong change it!  If 
a name is still on 
screen at the top 
when you get to the 
end of the scroll – 
add in another line. 
If the copyright 
notice is too low, 
Ctrl / Cmd + drag 
down just enough to 
get it in the right 
place – but be 
careful not to drag 
too much! 

Remember 
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2. Click on the Roll / Crawl Options. 

 

3. Timing (Frames) will open. 

            Let’s have a look at each of these options in detail.  

 

Reroll 

How long after the title appears do you want the title to wait before it starts rolling up the screen? 

Choose the ‘Start Off Screen’ option and have the title background appear first and then have the text 
start to roll up from below the bottom. 

However, if you want the text to start on the screen and then start to roll up choose a Preroll amount 
IN FRAMES – not seconds. Thus, if you wanted the text to stay put for 2 seconds before it started to 
roll you would type 60 (NTSC) or 50 (PAL) into the Preroll box. 

 

Ease-In 

How slowly do you want to text to start moving? For example, if you have 0 in this box the text will start 
to move at once with no ‘easing’ which can look very amateur! 

What you want (if you start with the text on the screen) is the text to smoothly start to scroll up the 
screen starting very slowly and getting faster. So, if you wanted it to accelerate over say 1 second you 
would type 30 (NTSC) or 25 (PAL) in the Ease-In box. 

End Off Screen means that the text will simply continue up off the screen without stopping at any 
point. However, for me, I like the copyright notice and any logo that I may have added to stop at the 
end of the roll and wait for a while before the title ends. To do this, you need to use both the Ease-Out 
and the Postroll functions. 

 

 

If you are working 
with NTSC (US and 
Japan) that would 
be 30 frames per 
second. For PAL 
(UK, Europe and 
much of the rest of 
the world) that would 
be 25 frames per 
second.   

Remember 
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Ease-Out 

Over what time would you like your title to slow down to a complete stop? 

You should choose 2 seconds for this which would mean adding 60 (NTSC) or 50 (PAL) into this box. 

 

Postroll 

How long do you want this title to stay still for at the end of your title roll? If you 
have an important notice or a copyright notice or a logo at the end you 
probably want to have it stay on screen for at least 3 seconds if not more. So 
in the Postroll box I would type 90 (NTSC) or 75 (PAL). 

So, a typical set up for the title starting off the bottom of the screen, then 
scrolling up and slowing down to a stop and waiting on screen for 3 seconds 
would look like this: 

 

Once you’ve made your choices, click OK and then shut down the title creation 
window. The new rolling title is now sitting in your project panel waiting to be 
added to your timeline like any other asset. 

 

Rolling Title Speed 

Now, the speed of your title – how fast it actually scrolls up the screen – is completely in your hands. 
You can trim the title in the normal way by adjusting the clip length. 

Title needs 5 
seconds to slow 
down and stop on 
screen because we 
chose 2 seconds for 
ease-out and 3 
seconds for postroll. 
This means that if 
the title is only 5 
seconds long on 
your timeline that all 
the names will go 
through so fast you 
won’t even notice 
them before the 
titles slow down and 
stop!  So, trim the 
length of your title 
out to the point 
whereby the names 
scroll up at the 
speed you want 
them to scroll up. 
You may need 20 – 
50 seconds for even 
a small number of 
names – so try it 
out. Trim and have a 
look to make sure 
it’s what you want. 

Remember 
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Trimming the Title  

Lastly, a couple of quick tips for rolling titles in Premiere Pro: 

1. When your titles come to an end, Premiere Pro will want to start from the beginning of your 
whole timeline which is a bit of a pain. So, trim your work area bar to just the length of your titles 
plus a little of the previous clip.  This will allow you to see the transition for clip to title without 
having to go back to the start of the timeline. 

2. Use a transition – perhaps the default Cross Dissolve – at the start and the end of your title. 
This will fade it in and fade it out for that professional look you’re after. 
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Learning Unit 3: Embed Video 

Overview 

In this learning unit, you will learn the techniques of embedding Video. This allows you to take your 
video. Or someone else's video and post it on a web page outside of online video portal. You can 
embed a video on your blog and then people can watch your video there without having to visit online 
video portal. 

1. Import Audio Files into PC from Recording Device 

After you have recorded you need to transfer the audio files from your digital recorder to your own PC 
or laptop, where you should store a copy of all the recordings.  

The process of transferring files to your computer is the same as you would use to copy files from a 
data stick / USB  

Simply connect the digital recorder to your computer via the built-in USB connector and copy the files 
to a pre-selected folder on your computer. A detailed description of how to transfer your audio files is 
given below. 
 

2. Procedure of Importing of Audio Files 

The procedure of Importing of audio files has the following steps: 

1. Locating your audio files for transfer. 
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2. Highlighting audio files on your digital recorder. 

 

3. Copying audio files to your computer by dragging and dropping highlighted files. 

    

4. Safely removing your digital recorder from your computer. 
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3. Import, Edit & Export Audio File 

When you import an audio file, Adobe Premiere conforms (converts) the file to the project's audio 
sample rate at 32-bit quality. This provides maximum quality and editing flexibility, and ensures that 
all audio in the project is consistent. 
 

4. Procedure of Importing Audio Files into Suitable format for the Project 

The procedure of Import audio files into suitable format for the Project has the 
following steps:  

1. Select File > Import from the main menu. 

2.  Locate and select the audio file, then click Open.  

The file will be immediately added to the Project window and 
conforms (converts) the file to the project's audio sample rate at 32-bit quality. 

 

3. Conformed files are stored in a folder called "Conformed Audio Files".  

The folder is located, Edit > Preferences > Scratch Disks.  
 

5. Edit & Export Audio Files into Suitable Format for the Project 

Exporting files for Further Editing 

You can export editable movie or audio files. Then, you can preview your work with effects and 
transitions fully rendered. Also, you can continue editing the files in applications other than Premiere 
Pro. Similarly, you can export a still-image sequence. Also, you can export a still image from a single 
frame of video for use in a title or graphic. 

After editing P2 MXF assets, you can export the sequence back to P2 MXF format. You can continue 
editing the resulting MXF files on other editing systems that edit MXF. 

Premiere Pro supports both direct export and Adobe Media Encoder export. Direct export generates 
new files directly from Premiere Pro. Adobe Media Encoder export sends files to Adobe Media Encoder 
for rendering. From Adobe Media Encoder, you can choose whether to render an asset immediately, 
or to add it to a render queue. 

 

It is recommend, 
that using the same 
location as the 
project, to keep all 
the files together. 
If you happen to 
delete or lose the 
conformed files it 
doesn't matter — 
they will be 
automatically 
recreated when 
Premiere realises 
they are missing. 

Remember 
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Exporting to Tape 

You can export a sequence or clip to videotape in a supported camcorder or VTR. You can use this 
type of export for archiving a master tape, or for delivering rough edits for screening from VTRs. 

 

Export Project Files for other Systems 

You can export project files, not just clips, to standard EDL files. You can import EDL files into various 
third-party editing systems for finishing. You can trim Premiere Pro projects down to their essentials 
and ready them, with or without their source media, for archiving. 
 

6. Procedure of Exporting Audio & Video files into suitable format for the 
Project 

The procedure of Exporting Audio & Video Files into suitable format for the 
Project has the following steps:  

1. In a Project panel, Source Monitor, or bin, select a clip. 

2. Choose File > Export > Media. Premiere Pro.  

3. Opens the Export Media dialog box. 

4. To crop the image, specify cropping options in the Source panel. 

5. Select the file format you want for your exported file. 

6. To customize the export options, click a tab (e.g., Video, Audio) and specify the appropriate 
options. 

7. Click Export. Adobe Media Encoder renders and exports the item immediately. 
 

7. Import Edited Images and Audio Files into Project 

Import Edited Images: 

Import PSD (Photoshop) files into Adobe Premiere Pro. 

 

8. Procedure of Import Edited Images into Project 

The procedure of Import Edited of Photoshop (psd) Images into Project has the following steps: 

1. Select File > Import from the main menu. Locate and select the PSD file, then click Open. 

2. There are three choices to make: 

To create PSD files 
the same pixel size 
as the Premiere 
project. The pixel 
size of the PSD file 
cannot exceed 4000 
x 4000 pixels. 

Remember 
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Import As 

 Footage: A single image repeated for the duration of the clip. 

 Sequence: The file's layers are converted to a sequence of frames. These appear as separate 
clips in a new bin. 

 

Layer Options 

 Merged Layers: All layers are merged into a single image. 

 Choose Layer: Select the name of a specific layer in the PSD file — only this layer will be 
imported. 

 

Footage Dimensions 

 Document Size: Resizes the PSD file to the size of the current project (as specified in Project 
> Project Settings). 

 Layer Size: Keeps the original size of the PSD file (or selected layer) 

 

9. Learn & Understand the Use of Timeline for Arranging and Placing Media 

Customizing the Timeline 

Customizing the Timeline and learning its features . 

Most attributes 
applied in 
Photoshop will carry 
over to Premiere, 
e.g. position, 
opacity, visibility, 
transparency, etc. 

Remember 
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 The Premiere Pro Timeline panel. 

You’ll briefly discuss many of the individual key features of the Timeline. 

 Snap (S). Controls whether items in the Timeline snap to each other when moved. Enabled 
by default. 

 Add Marker (M). Click to add a marker to the Timeline. 

 Playhead. Marks the current frame of the video shown in the Program Monitor. 

 Timecode. Displays the location of the playhead. 

 Timeline Display Settings. Opens the Settings menu. 

 Time ruler. The time display within the Timeline. Runs from left to right, usually starting at 
zero. 

 Track header. The area to the left of the Timeline track, where many track configuration 
adjustments are made. 

 Toggle Track Output. Turns the track on and off. When a track is off, its content is no longer 
displayed in the Program Monitor. 

 Toggle Track Lock. This button toggles locking on and off. Locking a track makes the content 
non editable. 

 Toggle Sync Lock. This button toggles Sync Lock on and off. Sync Lock keeps tracks in sync 
when certain edits are performed. 

 Mute track. Mutes that track’s audio during playback. 

 Solo track. Plays only that track’s audio during playback. 

 Timeline panel menu. Contains multiple configuration options for the Timeline. 
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Quick View Timeline 

The Quick view timeline contains the following tracks: 

Video:         Edit your video clips and images in this track 

Titles:          Add text titles to your clips here 

Sound:        Add background music and other sounds to your movie 

Narration:    Include recorded narrations for your movie here 

 

 The Quick view timeline displays each clip as a series of frames that span the entire clip length.  

 You can trim unwanted portions within individual frames and rearrange them.  

 You can also swap the position of a clip with another to make a coherent movie sequence. 

 

Expert View Timeline 

For more advanced editing, use the Expert view timeline. The Expert view timeline graphically 
represents your movie project as video and audio clips arranged in vertically stacked tracks. When you 
capture video from a digital video device, the clips appear sequentially as they occur. 

 

 The Expert view timeline uses a time ruler to display the components of your movie and their 
relationship to each other over time.  

 You can trim and add scenes, indicate important frames with markers, add transitions, and 
control how clips are blended or superimposed.  

 Compared to the Quick view, the Expert view timeline has more tracks. 

Customize Expert view timeline tracks to suit the needs of your project. 
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Add a Track to the Expert View Timeline 

1.   Choose Timeline   >   Add Tracks. 

2.  In the Add Tracks dialog box, type the number of tracks you want to add in the Add field for 
video or audio tracks. 

3.  To specify the placement of added tracks, choose an option from the Placement pop-up menu 
for each type of track added, and click OK. 

 

A. Current-time indicator   B. Time ruler    C. Zoom control 

D. Video track    E. Audio track 

 

Default tracks 

 

A. Video 2 track  B. Audio 2 track  C. Video1 track 

D. Audio 1 track  E. Narration track  F. Soundtrack 
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10. Knowledge of Various Settings for Importing Different Media Elements 

1. Click Add Media, and select Elements Organizer. The Elements Organizer application 
launches. 

2. In the Import panel of the Organizer workspace, locate the album or folder containing your 
media. 

3. From the Media view, drag one or more media files to the Quick view timeline or Expert view 
timeline in Adobe Premiere Elements. Alternatively, you can drag a media file to the Project 
Assets panel 
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Learning Unit 4: Prepare and Publish Artwork 

Overview 

In this learning unit, you will learn to prepare and publish artwork. After completion of this learning unit, 
you will be able to create motions in a project. 
 

1. Creation of Motion 

You can create animations, insets, and split screens by manipulating a clip directly in the Program 
Monitor and setting key-frames for the Motion effect. By adjusting a clip’s position and scale in the 
Program Monitor, you reveal clips in the tracks below it and can create interesting compositions. 

When you animate a clip’s position, the clip’s motion is represented by a motion path in the Program 
Monitor. Small white Xs represent key-framed positions, dotted lines represent positions at interpolated 
frames. 

The circular clip anchor point symbol represents a spot in the clip, its centre by default, at the current 
frame. The spacing between dots indicates the speed between key-frames……..wide spacing shows 
fast motion, while tightly spaced dots show slower motion. 

 

Pictures showing a motion path with fast motion (left) compared to slow motion (right) 

 To quickly apply Motion effect changes to a sequence clip. 

 Click the image in the Program Monitor and begin manipulation (without first clicking the 
Transform icon next to the Motion effect in the Effect Controls panel).  

 Adjust the position of the image, you can further refine its movement by using the Bezier 
keyframes. 

 

2. Procedure of Creating Motion 

When the Motion effect is selected in the Effect Controls panel, you can manipulate a clip in the 
Program Monitor. Create an animation by setting key-frames for one or more of the Motion effect’s 
properties (for example, Position). 
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The procedure of creating motion has the following steps: 

1. Select a clip in a Timeline panel. 

2. Apply one of the following: 

 Select the Motion effect in the Effect Controls panel. 

 Click the image in the Program Monitor. 

 Click the Transform icon  next to Motion in the Effect Controls panel. 

Handles appear around the clip’s perimeter in the Program Monitor. 

Note: If you don’t see the clip handles, change the Zoom Level in the Program Monitor to a smaller 
percentage so that the grey work area around the video frame appears. 

3. Move the current-time indicator to the frame where you want to start the animation—any frame 
between the clip’s current In point to its Out point. 

4. In the Effect Controls panel, expand the Motion effect and click the Toggle Animation button       
next to each property you want to define. A Key-frame icon appears at the current-time indicator 
for that property. 

5. In the Program Monitor, change the key-frame value by positioning the pointer near any of the 
clip’s eight square handles to use any of the following pointer tools: 

 The selection pointer      to set the position value. 

 The rotate pointer  to set the rotation value. 

 The scale pointer  to set the scale value. 

Note: If clip handles disappear, reselect the Motion effect in the Effect Controls panel. 

6. Move the current-time indicator in either the Timeline or the Effect Controls panel to the time at 
which you want to define a new value for the property (and thereby a new key frame). 

7. Manipulate the clip in the Program Monitor to set a new value for each property for which you 
set key frames in step 3. A new Key frame icon appears in the Effect Controls panel at the 
current-time indicator. 

8. Repeat steps 5 and 6 as needed. When you animate a clip, it can be useful to reduce the 
Program Monitor’s magnification level. This way, you can see more of the pasteboard area 
outside the visible area of the screen and can use it to position the clip off screen. 

9. In the Effect Controls panel, drag the Bezier handle for a Position, Scale, Rotation, or Anti-
flicker Filter property keyframe to control the acceleration of change for that property. 
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3. Settings and Preferences for Creating Motion 

Review Project Pre-sets, Settings and Preferences 

When you create a project, you can review the default pre-set and settings by clicking the Change 
Settings button in the New Project dialog. Adobe Premiere Elements automatically adjusts your project 
settings based on the type of media you import. 

1.  In Adobe Premiere Elements, select File > New > Project. 

2.  Click Change Settings. 
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Summary of Module 

 Knowledge of filters for applying colour correction to videos. 

 Knowledge of colour correction in order to convey message, e.g. white balance or unbalance 
to convey a feeling or emotion. 

 Understand the use of built in filters for adding visual effects. Different filters can be used to 
convey different messages  

 Use of built in transition to move from one scene to another. A transition gives the viewer sense 
of continuality.  

 Use of effects to produce results that cannot be achieved by normal techniques. A common 
effect used in video editing is brightness/ contrast effect to correct the scene.  

 Understanding other effects such as deleting unnecessary audio clip, or part of a scene.  

 Learn to import audio files, voice over into computer  

 from recording device  

 Learn and understand the use of timeline for arranging and placing media elements for the 
project. 

 Knowledge of various settings for importing different media elements.  

 Understand the creation of motion using video editing software once all media elements are in 
place on the timeline.  

 Understand the settings, properties, preferences for creating motion.  
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Frequently Asked Questions (FAQs) 

FAQ 1:  What is The Fast Colour Correction filter? 

Answer       
The Fast Colour Correction filter measures the amount of red, green, and blue in an 
object that is supposed to be grey. 

FAQ 2:  What does the change colour effect do? 

Answer A. It adjusts the hue, lightness, and saturation of a range of colours. 

FAQ 3:  Which two types of effects, you can give to your video? 

Answer Visual effects as audio effects. 

FAQ 4:  What is transition does? 

Answer A transition gives the viewer sense of continuality. 

FAQ 5:  Describe the YC Waveform? 

Answer It shows us the brightness of the pixels at their respective location in the frame. 

FAQ 6:  Describe the Gamma Correction effect? 

Answer 
The Gamma Correction effect lightens or darkens a clip without substantially changing 
the shadows or the highlights. 

FAQ 7:  What you call the Titles that move vertically and horizontally over the footage. 

Answer 
Titles that move vertically over the footage are called Rolls. Titles that move 
horizontally are called Crawls. 

FAQ 8:  Write down the formats which can be imported directly in Adobe Premiere. 

Answer These formats can be imported directly: AIFF, AVI, MOV, MP3, WAV.  
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FAQ 9:  What is the recommended pixel size of the PSD file? 

Answer The pixel size of the PSD file cannot exceed 4000 x 4000 pixels. 

FAQ 10:  How many tracks the Quick view timeline contains and explain them? 

Answer 

Video: Edit your video clips and images in this track. 
Titles: Add text titles to your clips here. 
Sound: Add background music and other sounds to your movie. 
Narration: Include recorded narrations for your movie here. 

 

  



 Module 5: Video Editing and Motion Development 

Teaching and Learning Material: Information Technology (Computer Graphics - Motion)                                                      | 229 

Test Yourself! 
 
Please mark the correct one from the given options. You can check your answer with the Answer Key 
at the end of this module. 
 

1.  Equal amounts of red, green, and blue equals to ………… 

a.  Red b.  Black 

c.  Grey d.  White 

2.  Different filters can be used to convey different…… 

a.  Colours  b.  Messages  

c.  Tones  d.  Hues 

3.  Gamma Correction controls ………………. adjustments. 

a.  Effective & Balanced b.  Balanced & Smooth  

c.  Attractive & Balanced d.  Plane & Balanced 

4. Rolling titles are …………… for any professional film production. 

a. Must b. Not require 

c. Partially required d. None of them 

5. The length of the title clip in a Timeline panel determines the speed of the ……. 

a. Moving  b. Movie 

c. None of them d. Roll or Crawl 
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Answer Key 
MCQ Number Correct Answer 

1 c 

2 b 

3 a 

4 b 

5 a 
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Module 6: Prepare for Rendering 

Learning Outcomes 

After completion of this learning module, you will be able to: 

 Export final project/ story using Adobe Premiere 

 Export final project/ story using Final Cut Pro 
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Learning Unit 1: Rendering and Exporting the Story in 
Adobe Premier 

Overview 

Rendering is the process of generating an image from a model, by means of a 
software program. It would contain geometry, viewpoint, texture and lighting 
information. Rendering is also used to describe the process of calculating 
effects in a video editing file to produce final video output. 

In this learning unit you will learn exporting project out of adobe premiere into 
a format (burning of a project disk for DVD players and a data disc (CD)) that 
can be viewed through other sources. 

1. Exporting Adobe Premiere Project   

You can export video from a sequence in the form best suited for further editing 
or for a viewing audience. Premiere Pro supports export in formats for various 
uses and target devices. 

1. Exporting Files for Editing 

You can export editable movie or audio files. Then, you can preview your work 
with effects and transitions fully rendered. Also, you can continue editing the 
files in applications other than Premiere Pro. Premiere Pro supports both direct 
export and Adobe Media Encoder export. Direct export generates new files 
directly from Premiere Pro.  

Adobe Media Encoder export sends files to Adobe Media Encoder for rendering. From Adobe Media 
Encoder, you can choose whether to render an asset immediately, or to add it to a render queue. 

2. Exporting to tape 

You can export a sequence or clip to videotape in a supported camcorder or 
VTR. You can use this type of export for archiving a master tape, or for 
delivering rough edits for screening from VTRs.  

3. Send to Encore  

You can send video from any sequence into Adobe for output to DVD, Blu-ray 
Disc (Windows only), or a SWF file.  

You can send content from Premiere Pro to Adobe Encore for creating an 
AutoPlay disc without menus. You can quickly create menu-based discs using 
the professional templates in Adobe Encore.  

Finally, you can use the deep authoring tools of Adobe Encore, Adobe Photoshop, and other 
applications, to author professional-quality discs. You can also export in formats appropriate for CD-
ROM distribution. 

Effects that are not 
real time must be 
rendered to play 
back properly. Once 
rendered, your 
sequence can be 
played in real time. 

Remember 

It is a transcoding 
and rendering app 
that lets you encode 
audio and video in a 
variety of formats for 
delivering video 
content for web, 
broadcast and 
cinema. 

Adobe Media 

Encoder  

It is an electronic 
device combining a 
video camera and a 
video recorder. 

Camcorder 

A video tape 
recorder (VTR) is a 
tape recorder 
designed to record 
video material on 
magnetic tape. 

VTR 
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4. Export project files for other systems 

You can export project files, not just clips, to standard EDL files. You can 
import EDL files into various third-party editing systems for finishing. You can 
trim Premiere Pro projects down to their essentials and ready them, with or 
without their source media, for archiving. 

5. Export formats 

Finally, using the Adobe Media Encoder, you can export video in formats 
suitable for devices ranging from professional tape decks to DVD players to 
video-sharing web sites to mobile phones to portable media players to 
standard- and high-definition TV sets. 

 

2. Exporting video from Adobe Premier Pro              

The procedure of exporting your video from Adobe Premier Pro has the following steps: 

1.  To export your video click on File Export Media. 

 

 

 

2.  A new window will open up. 

An edit decision list 
or EDL is used in 
the post-production 
process of film 
editing and video 
editing. The list 
contains an ordered 
list of reel and time 
code data 
representing where 
each video clip can 
be obtained in order 
to conform the final 
cut. 

EDL Files 
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3.  From here you need to select the export settings.  

 

4.  Once you have settled on the correct settings click “Ok” and a new window will open up 
where you can set the name and destination of your output file. Once you have set the 
destination click “Start Queue” and the file will begin Exporting.  

 

Once the loading bar has finished and disappeared your file is now exported and ready to 
watch from the destination folder you set it to. 

Nero is probably the 
most popular DVD 
burning program 
that will give you 
even more control 
over the burning 
speed. 

Do you know! 



Module 6: Prepare for Rendering 

236 |                                                      Teaching and Learning Material: Information Technology (Computer Graphics - Motion) 

3. Burning a DVD-Video Disc 

The procedure of burning a DVD-Video Disc with Nero Burning ROM has the following steps:  

1.  Download and install Nero burning software. Official download link is 
http://www.nero.com/eng/downloads/  

2.  Open Nero. This is the default window when Nero starts, if it doesn't come up just go to new 
button in the top left corner. 

 

3.  Here select DVD as the type of media you want to burn and then DVD-Video 

 

4.  Select a speed for DVD video discs and click new. 

You can use other 
software to burn 
CD/DVD e.g Power 
ISO etc. 

Do you know! 

Select a low burning 
speed like 4x for 
DVD video discs 
especially if your 
standalone player is 
a bit old. 

Remember 
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5.  Here just find the files that you want to burn in the DVD, select them all and drag them in 
the VIDEO_TS folder .It is important that you put all the files inside the VIDEO_TS folder 
and not in the DVD root. Then make sure DVD5 is selected and click Burn. 

 

6.  You can optionally select verify the disc after it is burned. It will take more time, but you are 
sure that you have a correct copy before you delete that DVD files off your hard disk. 
Remember about write speed in earlier step. When you are ready add a blank DVD and 
click burn. 

 

We are burning 
ready DVD files. If 
you have another 
type of video files, 
like avi or mkv for 
example you need 
to convert them to 
DVD format first. . 

Remember 
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That's all! Now just wait a few minutes and your DVD will be ready. 

 

4. Burning of a Data Disk  

The procedure of preparation and burning of a data disk (CD) to store all source files has the following 
steps: 

1.  Place an empty disc into your CD/DVD writable drive tray, face up. 

 

 

2.  Go to computer and double click at CD/DVD drive or wait for the dialogue box that appears 
automatically after inserting CD/DVD. 

Disk, US spelling 
of disc, also widely 
used in computing 
contexts. 

Do you know! 
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3.  In the Disc Name field, type a name for the disc and click at Next. 

4.  
Your disc will be formatted for burning. When finished formatting, an empty disc folder will 
open. 

5.  
Drag or copy the source files of the project into the empty disc folder. The files are copied 
as you drag them. 

 

6.  Click at close session that will make the CD/DVD ready for use on other computers. 
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Learning Activity 

Export a project out of Adobe Premiere 

Description:   This activity consists of an interactive session in the class about exporting 
project out of Adobe Premiere. 

Time Guideline: 30 min 

Purpose:  To be able to export a video out of Adobe Premiere. 

Presentation:  
 

1. Divide the class into groups. 

2. Brief the groups about the activity that each group will create and 
export a video out of Adobe Premiere. 

3. Groups will practice these tasks. 

4. Each group will present its task. 
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Learning Unit 2: Rendering and Exporting the Story in 
Final Cut Pro 

Overview 

In this learning unit, you will learn exporting project out of Final Cut pro. You have already learnt burning 
of a project disk for DVD players and a data disk (CD) to store all source in previous unit. On completion 
of this learning unit you will be able to export projects out of Final Cut Pro. 

1. Exporting Project Out of Final Cut Pro 

In Final Cut Pro you can export video in a variety of functionalities. You can export video at normal 
resolution which is a simple method, a low resolution video for YouTube and a high resolution video 
for a DVD. 

2. Procedure of Exporting Video in Final Cut Pro               

The procedure of exporting video in Final Cut Pro has the following steps: 

1.  After completing your video, in FINAL CUT PRO X. 

Go to FILE and then to SHARE. Then to MASTER FILE.  

 

2.  Once you click on SETTINGS, you will then see a menu that allows you to select many different 
formats for your video. Select the one that is best for you. 

Final Cut Pro is a 
simplest way of 
exporting video but it 
might take you 
longer to export the 
video. 

Do you know! 

Make sure that you 
are in the TIMELINE 
window. If you’re 
not, the menu boxes 
that you will need to 
share your video will 
be grayed out. 

Remember 
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Small format, for the smallest video size: 

FORMAT: Web Hosting. 

VIDEO CODEC: H.264 Faster Encode 

RESOLUTION: 842X480 

(Rest of stuff doesn’t matter). 

High-Res: 

FORMAT: Video and Audio 

VIDEO CODEC: Apple Pro-Res 422 

RESOLUTION: Whatever your video is shot at will show under “Resolution.” 

(Rest of the stuff doesn’t matter.) 

3. Exporting Video from Final Cut Pro X to be made into a DVD (HIGH-RES) 

The procedure of  exporting video from Final Cut Pro X to be made into a DVD (HIGH-RES) has the 
following steps: 

1.  Go to FILE and then to SHARE. Then, go to ADD DESTINATION. 

To decide format 
there are few things 
which you should 
need to know like 
how well the movie 
you are exporting 
will be used, what 
kind of device will be 
played on. 

Remember 
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2.  Once you see the menu (on the right) appear, double-click on COMPRESSOR SETTINGS. 

 

3.  You will get this menu. Select the APPLE folder. 
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4.  Then scroll to the ProRES folder. Open it up. Click on the FIRST setting – Apple ProRes 
422. Do not use the other Apple ProRes 422 settings (HQ, Proxy). Use the FIRST ONE. 

 

5.  This will add a new destination to the list in the SHARE. 

 

6.  Then go back to FILE  SHARE  Apple Pro-Res. 
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7.  Click on NEXT, give your file a new name, and then save it to your desktop or to a folder 
on your desktop. 

 

Then click “Next” on bottom right. This will create a .MOV file of a HUGE size.  

8.  Give your file a name – PREFERABLY WITH YOUR NAME IN THE FILE NAME – and 
save it to the desktop. 

 

After the video has been made, insert the finished video into DVD burning software to 
make a DVD. 
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Learning Activity 

Export a project out of Final Cut Pro (Low Resolution) 

Description:   This activity consists of an interactive session in the class about exporting 
project out of Final Cut Pro. 
 

Time Guideline: 30 min 

Purpose:  To be able to export a video for YouTube. 

Presentation:  
 

1. Divide the class into two groups. 
2. Brief the groups about the activity that each group will create and export 

a video out of Final Cut Pro. 
3. Groups will practice these tasks. 
4. Each group will present its task. 
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Learning Unit 3: Animation Using Adobe Flash 
Professional 

Overview 

In this learning unit, you will learn motion graphics designing using Adobe Flash. On completion of this 
learning unit you will be able to create motions, shapes and text animations.  

1. Adobe Flash Professional 

Adobe Flash (formerly Macromedia Flash) is a multimedia platform used to add animation, video, 
and interactivity to web pages. Flash is frequently used for advertisements and games. More recently, 
it has been positioned as a tool for "Rich Internet Applications" ("RIAs"). 
 

2. The Interface (Workspace)           

 

The TimeLine 

1. The Timeline controls and shows all of the elements of your project over time. It uses Frames 
and Layers to organize your work. 

2. The Playhead tells you which frame is currently displayed on the Stage Layer controls allow 
you to control your layers. You will learn about layers in more detail later in this tutorial 

3. Status Bar gives you information about the current frame, the number of frames per second 
(fps) and the elapsed time of your movie 

4. The Frame View is a drop down menu that lets you control the appearance of the Timeline. 

 

Originally developed 
by Macromedia, 
Flash was 
introduced in 1996, 
and is currently 
developed and 
distributed by Adobe 
Systems. 

Do you know! 

In 1996, Future 
Splash was acquired 
by Macromedia and 
released as Flash, 
contracting “Future" 
and "Splash 

Remember 
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A.    Playhead    B.  Empty keyframe  
C.    Timeline header   D. Guide layer icon  
E.  Frame View pop-up menu  F. Frame-by-frame  
                                                                       animation  
G.  Tweened animation   H. Scroll To Playhead button  
I.  Onion-skinning buttons J. Current Frame indicator  
K.  Frame Rate indicator   L. Elapsed Time indicator  

 

 

 

Layers allow you to organize your work. 

1. Layer name - the default is Layer 1, Layer 2 etc 

2. Insert layer - click to add a new layer 

3. Add motion guide - by clicking this you add a guide layer on top of your current one 

4. Insert Layer Folder - this adds a folder that can store other layers, this is useful in complicated 
projects to help organize your work 

5. Delete Layer - to remove a layer, drag it to the trash 
Show/Hide all layers - can hide a layer while you are working 

6. Lock/unlock all Layers - by clicking this it's impossible to edit a layer 

7. Outline view - displays solid shapes as outlines with no fill 
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3. Flash Drawing and Painting Tool 

 

 

The line tool creates straight lines. Try holding down the Shift key and you'll get 
lines that are at a 45 degree angle. Lines can be modified with the Ink Bottle 

 

The lasso tool allows you to select an object or a piece of an object by drawing 
around it 

 

The pen tool creates a straight or a curved line 

 

The text tool allows you to add text fields to your movie 

 

The oval tool creates circles and ovals. Hold down the shift key and you can 
create a perfect circle 

 

The rectangle tool creates squares and rectangles. Hold down the shift key and 
you can create a perfect square 

 

The pencil tool draws lines in three different modes: straighten; smooth; ink. Hold 
down the shift key and you can create perfect horizontal and vertical lines. 

 

The brush tool creates shapes with fills only. 

 

The free transform tool allows you to modify objects. You can scale, rotate; flip, 
skew. 

 

The fill transform tool allows you to change the size, direction or center of a 
gradient or bitmap fill 

 

The ink bottle tool can be used to change the color or width of a line or to add a 
stroke to a shape. It will not change the fill of a shape 

 

The paint bucket tool adds a fill inside of a shape or to change to color of a fill. 

 

The eye dropper tool is used to copy the fill or stroke attributes of an object and 
apply it to another object 

 

The eraser tool is used to remove unwanted areas on the Stage 

 

Scene 

 

Scene displays a list of all the scenes in your 
movie. You can add, delete, duplicate, name, or 
rename scenes in this panel 

Transform 

 

The Transform panel allows you to rotate, scale 
and skew an object numerically 
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Align 

 

The Align panel allows you to align objects 

Info 

 

The Info panel gives you numerical information 
about the size, position and color of the selected 
object. 

Color Mixer 

 

The Color Mixer allows you to create new colors 
in either: RGB; HSB; or HEX 

Color Swatches 

 

Color Swatches are the 216 Web safe colors 

 

Flash Animation 

Macromedia Flash is known as an animation tool. This tutorial will introduce you to the basics of 
Flash animation. 
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Keyframe Playhead 

Keyframes define the moment in the timeline 
where actions or animations occur. 

The playhead shows the current frame that you 
are viewing in the timeline. 

Layers Current Frame 

Layers organize your work from back to front on 
the stage so that one object can move in front of 
another one. 

This displays the current position of the playhead 

Blank Keyframe Frame View 

A blank keyframe is an empty location on the 
timeline that is ready to have content placed. 

The Frame View allows you to change how the 
timeline is displayed. 

Frame Rate Elapsed time 

This shows the number of frames per second 
(fps) your animation will play in the browser 

Shows the time elapsed from Frame 1 to your 
current position at the selected fps 

Representations of Animation in the Timeline 
Flash distinguishes tweened animation from frame-by-frame animation in the Timeline as follows: 
 

 A black dot at the beginning keyframe indicates motion tweens; a black arrow with a light blue 
background indicates intermediate tweened frames.  
 

 
 
 

 A black dot at the beginning keyframe indicates shape tweens; a black arrow with a light green 
background indicates intermediate frames.  
 

 
 

 A dashed line indicates that the tween is broken or incomplete, such as when the final keyframe 
is missing.  
 

 
 

 A black dot indicates a single keyframe. Light gray frames after a single keyframe contain the 
same content with no changes and have a black line with a hollow rectangle at the last frame 
of the span.  
 

 
 

 A small a indicates that the frame is assigned a frame action with the Actions panel.  
 

 
 

 A red flag indicates that the frame contains a label.  
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 A green double slash indicates that the frame contains a comment.  
 

 
 

 A gold anchor indicates that the frame is a named anchor.  
 

 
 

Tweened Animation 
Flash can create two types of tweened animation: 

 In motion tweening, properties are defined such as position, size, and rotation for an instance, 
group, or text block at one specific time, and change those properties at another specific time. 
A motion tween can also be applied along a path. 

 In shape tweening, a shape is drawn at one specific time, or it can be changed or another shape 
is drawn another specific time. Flash interpolates the values or shapes for the frames in 
between, creating the animation 

 
Motion Tween 

 Open a new flash file (Ctrl+N) 

 New Document window will appear 

 Select General panel and choose Type: Flash Document. Press OK. 

 If your timeline window is not open, press (Ctrl+Alt+T). 

 Now you can see a single Layer called "Layer1" in your timeline Window. 
 

 
 

 Select the first frame. Import your image onto stage, upon which you would want to implement 
motion tween.  

 File ImportImport to Stage, or just press (Ctrl+R). Or you can even draw your own object; 
you can either choose Rectangular tool or Oval tool from the tool box or draw your desired 
shape. 
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 Now select your object on the stage and press F8 to convert this image to a Symbol. Convert 
to Symbol window will pop-up. 

 

 

Name your Symbol whatever you like. Then select Graphic behavior and press OK 
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Note: You can create motion tween only on symbols. So any object upon which you would want to 
implement motion tween, First convert the object to a Symbol.  

 
 Right now your Symbol is in frame1 of Layer1. Select frame 20 and press F6 to insert a new 

keyframe. 
 

 
 

 

 Still keeping playhead on frame 20, move your Symbol to any other position other than the 
present one. 
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 Select any frame between, 2 to 19 and select Motion from the tween pop-up menu in the 
Property inspector. Now your Layer will look something like the one shown below.  

 

 
 Now press (Ctrl+Enter) to view your motion tween. 
 

Shape Tween 

 Open a new flash file (Ctrl+N). A new Document window will appear. Then, select General 
panel and choose Type: Flash Document and Press OK. 

 If your timeline window is not open, press (Ctrl+Alt+T). 

 Now you can see a single Layer called "Layer1" in your timeline Window. 

 

 Select the first frame. Now go to your working area and draw initially a short line. 

 Select frame 20 and press F6 to insert a new keyframe. 

 Still keeping playhead on frame 20, delete the object present in your working area. Now drawn 
a long line. 

 Select any frame between, 2 to 19 and select Shape from the tween pop-up menu in the 
Property inspector. Now your Layer will look something like the one shown below.  

 

 Now press (Ctrl+Enter) to view your motion tween. 

Example for Motion & Shape Tween Together with Multi Layers 

 Open a new flash file (Ctrl+N). A New Document window will appear. Then, 
select General panel and choose Type: Flash Document. Press OK. 

 If your timeline window is not open, press (Ctrl+Alt+T). 
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 Now you can see a single Layer called "Layer1" in your timeline Window. 

 

 Create a Shape Tween on Layer1.  

 Single click on add new layer button.  

 

 A new layer gets added. By default it will be named "Layer 2". 

 Create a Motion Tween on Layer 2. After creating two layers, your timeline will look something 
like the one shown below.  

 

 Now press (Ctrl+Enter) to view your motion tween. 

Fade in Effect Example 

1. Open a new file. Go to File >New. A Screen called New Document will appear. Select Flash 
Document and click on OK.  

2. Go to ModifyDocument and give a file size of 300px by 200px. This is the same size as the 
Bitmap pictures we required. 

3. Select the Bitmap pictures that you want to Fade in and Fade out from your picture file and 
bring it to the Flash Library. Select File>Import to Library from the Menu Bar.  

 
Tweening- Motion Text 
In tweening motion text can be added using the following steps: 



 Module 6: Prepare for Rendering 

Teaching and Learning Material: Information Technology (Computer Graphics - Motion)                                                      | 257 

1. Create a new file. On the Stage with the text tool write the phrase: My frog movie 

 

2. Select the text and choose: Modify  Break apart 

 

3. With all the text boxes selected choose Modify Distribute to Layers. This puts each letter on 
a different layer. With the arrow tool click on the M and in the Properties Inspector convert it to a 
Symbol with a Graphic Behavior. Name this M and click OK. Repeat this with all the letters. 

 

4. On the Timeline click on frame 20 and drag down all the layers that you've placed a symbol, now 
add a Keyframe. Notice how you've now added a keyframe to all the layers? Add an additional 
keyframe at frame 40 for all layers. Make sure that all your letters are deselected and with the 
Framehead on frame 40, drag the letters M and Y (the word My) off the Stage to the work area. 
 

5. In the Toolbox select the Free Transform and change the scale and rotation of the letters M and Y. 
In the Properties Inspector change the Alpha to zero. This will have these letters fade out. 

 

6. Change the position and scale of each of the letters in My Frog Movie. 
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7. Click on a frame between your two keyframes and drag down to select all your layers. Add a motion 
tween. In the Properties Inspector add a Ease of 80 out. 

 

8. Test your movie. 
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Summary of Module 

  Rendering is the process of generating an image from a model, by means of a software 
program. It would contain geometry, viewpoint, texture and lighting information. Rendering 
is also used to describe the process of calculating effects in a video editing file to produce 
final video output. 

  Final project can be exported out of Adobe Premiere into a format that can be viewed by 
others i.e. exporting files for further editing, exporting to tape, sending to Encore for DVD, 
Blu-ray Disc, or SWF file creation, exporting project files for other systems, and exporting 
formats for various devices and web sites. 

  Nero Burning ROM is used to prepare and burn a project disk which allows playback on 
regular DVD players. 

  A data disk (CD) is used to prepared and burned to store source files. 

  Export project out of Final Cut Pro into a format that can be viewed by others, with low 
resolution file for YouTube and a high resolution file for DVD.  
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Frequently Asked Questions (FAQs) 

FAQ 1:  Define Rendering? 

Answer 
Rendering is to process video and audio with any applied filters or transitions, and store 
the result on disk as a render file. 

FAQ 2:  What's the best export format or codec for Adobe Premiere? 

Answer 
There is no best export format for premiere pro rather best format depends upon your 
situation. To decide format there are few things which you should need to know like how 
well the movie you are exporting will be used, what kind of device will be played on etc. 

FAQ 3:  What is VTR? 

Answer 
A video tape recorder (VTR) is a tape recorder designed to record video material on 
magnetic tape. 

FAQ 4:  Why low resolution video formats are used? 

Answer Low resolution videos formats are used for you tube. 

FAQ 5:  Why high resolution video formats are used? 

Answer High resolution videos formats are used for DVD. 
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key 
at the end of this module. 

1.  
__________ is/are an electronic device combining a video camera and a video 
recorder. 

a.  VTR b.  TV 

c.  Camcorder d.  All of the above. 

2.  A high resolution file can be exported out of Final Cut Pro for __________. 

a.  CD b.  DVD 

c.  YouTube d.  Mobile playback 

3.  A low resolution file can be exported out of Final Cut Pro for __________. 

a.  DVD b.  YouTube 

c.  TV Transmission d.  None Of the above. 

4.  __________ is a tape recorder designed to record video material on magnetic tape. 

a.  Camcorder b.  Media Player 

c.  VTR d.  None. 

5.  
____________ is used in the post-production process of film editing and video 
editing. 

a.  .swf b.  story 

c.  project d.  EDL 

6.  
In Adobe Premiere a _________burning speed is used for DVD video discs if your 
standalone player is a bit old. 

a.  Low b.  High 

c.  Medium d.  None Of the above. 
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7.  
_______________ is to process video and audio with any applied filters or 
transitions, and store the result on disk as a render file. 

a.  Transitioning  b.  Color Correction 

c.  Rendering d.  None of the above. 

8.  
----------------------- is a transcoding and rendering application that encode audio and 
video in a variety of formats. 

a.  Adobe Premiere  b.  Final Cut Pro 

c.  Adobe Media Encoder d.  None Of the above. 
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Answer Key 
MCQ Number Correct Answer 

1 c 

2 b 

3 b 

4 c 

5 d 

6 a 

7 c 

8 c 
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Module 7: Perform Software and Hardware 
Maintenance 

Learning Outcomes 

After completion of this learning module, you will be able to: 

 Install relevant graphics software 

 Uninstall relevant graphics software 

 Install relevant Operating System (Windows and Mac OS) 

 Uninstall relevant Operating System (Windows and Mac OS) 

 Install and configure required driver 

 Install and configure input/output devices 

 Connect various devices using appropriate ports and cables 
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Learning Unit 1: Install and Upgrade Operating System 

Overview 

In this learning unit, you will learn the procedure of installation, uninstallation and up gradation of 
operating system. After completion of this unit you will be able to install/uninstall and upgrade 
operating system. 
 

1. Installing Windows 07 Operating System   

Following is the method of Windows installation using DVD:  
 

1. Turn on the computer 

2. Insert Windows 7 DVD in DVD Drive 

3. Press “F12” to launch boot menu 

4. Select CD/DVD-Rom drive as 1st boot device  and press enter key (to 
boot from CD)  
 

 
 

Boot Menu 
 

5. Wait for setup to initialize and load installation files 
 

 
 

Loading Setup File 
 

6. Select Language, Time, Currency format, Keyboard layout and click “Next” 
 

Operating system is 
system software that 
manages computer 
hardware and 
software resources 
and provides 
common services for 
computer programs.  

Operating System 

F12 and delete keys 
are mostly used to 
launch boot menu in 
many computers, 
but it can be 
different in some 
machine, Press on 
screen given key of 
your computer for 
boot menu 

Remember 

You can press F2 
(or delete) key to 
enter setup, there 
also you can change 
boot order to cd rom  

Do you know! 
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Language and Keyboard Layout Setting 
7. Click “Install Now” 

 

 
 

Initializing Installation 
 

8. Check the “I accept license term” and click “Next” 
 

 
 

License Terms 
 

9. Select “Custom installation” and click “Next” 
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Upgrade/Custom Choise Window 
 

10. Select the partition where you want your OS to install and click on “Drive option”  
 

 
 

Partition Selection Window 

11. Select “Format” and than click “Next” (it  will format the drive)  
 

 
 

Format Drive Option 

12. Setup will start copying files for windows setup.  

 
 

Upgrade option will 
upgrade your 
current installed OS, 
So click on custom 
installation if you are 
willing to install a 
new window 

Remember 

Format will erase all 
stored data in your 
hard disk 

Remember 

You can choose 
other options like 
delete in the drive 
options to recreate a 
partition. 

Do you know! 
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Copying Windows Files 

13. Setup will install other features and updates. 

 

 
 

Installing Windows 

14. Computer will restart automatically or click on “Restart now” to avoid further delay. 
 

 
 

Restarting Computer 

15. After restart setup will complete the installation and will restart your system again 
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Completing Setup 

16. Setup will prepare computer for first use of windows. 

17. Setup will check video performance. 

18. Type any user name and click “Next” 
 

 
 

User Name Window 

19. Set a password for your account if you want and click “Next” 

 

 
 

Password Window 

20. Type windows product key if you have or click “Next” without typing the key.  
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Product Key Window 

21. Select your desired option for windows update. 

 

 
 

Upgrade Options 
 

22. Set your country time and click “Next” 

 

 
 

Date and Time Setting 

23. If you are connected to any network than select its type or just click on “Home network” 

 

You can use 
recommended 
settings for windows 
update, which is 
used by many users. 

Do you know! 

Product key is 
necessary for your 
windows to work 
properly, if you do 
not have this key 
now, later on try to 
activate your 
windows online 
using internet 
connection 

Remember 
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Network Setting 

24. Setup will finalize your setting and will prepare your desktop. 

 

 
 

Windows 7 Desktop 
 

And there you have Windows 7 installed! 
 

2. Upgrade and Configuration of Operating System   

 
Following is the method of Upgrading Windows 7 to Windows 8:  
 

1. Insert the Windows 8 Installation Disk in your DVD Rom. 

2. Wait for the AutoPlay windows to appear.  

3. Click Run “Setup.exe” to continue. 

4. Windows 8 installation will be prepared. 

 

 
 

Preparing Installation 

It is one of the most 
common methods to 
move from one 
version of windows 
to another, new 
version will replace 
the older and you do 
not need to format 
the disk too, all other 
important files and 
software will remain 
same. 

Upgrade 
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5. Type the windows 8 product key if you have or click “Next” without typing it. 

6. Check “I accept the license term” and click “Accept”.  
 

 
 

License Terms 
 

7. Choose what kind of upgrade you want and click “Next”. 
 

 
 

Choose Files to Keep 
 

8. Windows will check if your system is ready to upgrade. 

9. Windows will notify you if any Microsoft program is not yet compatible with Windows 8. 
 

 
 

Incompatible Applications 
 

10. Uninstall the incompatible program (if any) and follow windows 8 setup instructions.  
 

Before upgrading 
windows, update 
your current 
windows programs 
from the control 
panel (using internet 
connection) 

Remember 
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Initalizing Setup 

11. Personalize setup (if prompted). 
 

 
 

Personalization 
 

12. Your upgrade is completed as the Windows 8 desktop appears. 
 

 
 

Windows 8 Desktop 
 

3. Un-Installing an Operating System  

 
You may want to uninstall an operating system for any reason or when you have a dual boot on the 
hard drive and you want to remove the only one operating system on the hard drive and reuse it in 
future. 
 
Following is the method of uninstalling window 8 
 

1. Turn on your computer. 
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2. Insert the windows CD/DVD, as required.  
3. Press “F12” or “Delete” or the key shown on the first screen of computer for boot menu. 

4. Select CD/DVD ROM as 1st boot device in the boot menu. 

5. Wait for setup to initialize. 

6. Follow on screen instructions. 

7. When hard disk partition windows appear, select the partition that contains the operating 
system which you want to uninstall.  

8. Click Drive Option. 
 

 
 

Drive Options 
 

9. Click “Format” (Warning dialog box will appear). 
10. Click “Yes” to confirm (format process will start and uninstall your operating system). 

 

 
 

Format Drive 
 

11. Now you can reuse this partition for any other Operating system. 
 

 

  

If you have only one 
OS running in your 
PC and you are 
practicing of 
installation, than 
after uninstalling, 
reinstall an 
Operating system. 

Remember 



 Module 7: Perform Software and Hardware Maintenance 

Teaching and Learning Material: Information Technology (Computer Graphics - Motion)                                                      | 277 

Learning Unit 2: Install Graphics Software 

Overview 

In this leaning unit, you will learn the installation process of various graphics software. After the 
completion of this learning unit, you will be able to install, configure and familiar with the work 
environment of Adobe Photoshop, Corel Draw, Adobe Illustrator, Adobe InDesign.  
 

1. Installation of Graphics Software  

Installation of Adobe Photoshop 
 
Following is the method of Adobe Photoshop Installation: 

1. Insert the Adobe Photoshop CD in CD drive and open the folder 
containing the Setup.exe file. 

2. Right click at setup and then click at Run as administrator. 
3. Wait for setup to initialize. 
4. There are 3 options: 1. Install with serial number, 2.start my subscription 

and 3. Install a trail.  
You can install a trial to use 30 days free. After that you can buy license and add key to active 
product. If you have a key, you should choose Install with serial number. 

5. Click “Accept” to agree the software license agreement. 
6. Select the Language and click “Install”. (Installation process will start). 
7. Click “Close” in new window after the installation is completed. 
8. To open adobe Photoshop, click “Start” button, navigate to “All Programs” and click “Adobe 

Photoshop”. 

 

Installation of Corel Draw 
 
Following is the method of Corel Draw Installation: 

1. Insert Corel Draw disc in your CD/DVD drive. (autoplay windows will 
appear). 

2. Double Click “Open folder to view files” (new window will appear). 
3. Double click on “Setup” file 
4. Setup will initialize the installation wizard. 
5. Accept the license terms and click “Next”. 
6. Type the user name (your name) and enter the serail key, (given in the installation folder. 
7. Click “Next” 
8. Select Typical installation and click “Next” (Installation process will start) 
9. Click “Finish” after the installation is completed 
10. To open CorelDraw, Click the “Start” menu button, navigate to “All programs” and click 

“CorelDraw” 
 

Installation of Adobe Illustration 
 
Following is the method of Adobe Illustration Installation: 

1. Insert Adobe Illustration CD in your CD/DVD drive. (autoplay windows will appear). 

Adobe Photoshop is 
a raster based 
graphics editor. 
Developed and 
published by Adobe 
Systems for 
Windows and OS X. 

Adobe Photoshop 

CorelDraw is vector 
based graphics 
design software, 
developed and 
marketed by Corel 
Corporation of 
Ottawa, Canada. 

CorelDraw 
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2. Double Click “Setup.exe” file (new dialog box will appear).  
3. Click “Run” in dialog box.  
4. Click “Install” in welcome windows. 
5. Click “Accept”  to agree the license agreement. 
6. Enter the serail number (provided in your installation folder). 
7. Click “Next”. 
8. Click “Sign in Later”. 
9. Set Language and Click “Install” (Installation process will start). 
10. Click “Close” after the installation is completed. 
11. To open adobe Illustration Click “Start” button, Navigate to “Áll 
Programs”, and Click “Adobe Illustration”. 

 

Installation of Adobe InDesign 
 
Following is the method of Adobe InDesign Installation: 

1. Insert Adobe InDesign CD in your CD/DVD drive. (autoplay windows will 
appear). 
2. Double Click “Setup.exe” file (new dialog box will appear). 
3. Click “Run”.  
4. Click “Install” In welcome dialog box. 
5. Click “Accept” to agree license agreement. 
6. Enter Serail Number (provided in your setup folder). 
7. Click “Sign in Later” (in next windows). 
8. Select Components and  language, and click “Install” (Installation 
process will start), if prompted for user account control, click “Yes”. 
9. Click “Close” after the installation is completed. 
10. To open Adobe InDesign, click “Start” menu button, navigate to “All 
Programs” and click “Adobe InDesign”. 
 
 
Installation of Final Cut Pro 
 
Following is the method of Final Cut Pro Installation: 

1. Insert the “Final Cut Pro 5” installation disc into your computer’s DVD 
drive. 
2. Double-click the “Install Final Cut Pro 5” icon, then follow the onscreen 
instructions. 
3. The Installer package runs a program to determine if Final Cut Pro can 
be installed. 
4. Click “Continue”.  

5. Read the Welcome information, then click “Continue”. 
6. Read the Software Licensing Agreement, click “Continue”,  
7. In the Licensing dialog, enter your first and last name. Entering an organization is optional and 

then click “Agree”. 
8. In the Serial Number field, enter the Final Cut Pro serial number then click “OK”.  
9. Select the startup disk, then click “Continue”. Your startup disk must have the latest version of 

Panther installed. 
10. Do one of the following: 

 

 To perform an easy installation, click “Install”. 

Adobe Illustrator is 
a program to create 
vector images. 
These images can 
be used for 
company logos, 
promotional uses or 
even personal work, 
both in print and 
digital form 

Adobe Illustration 

Adobe InDesign is 
desktop publishing 
software that can be 
used to create works 
such as posters, 
flyers, brochures, 
magazines, 
newspapers, and 
books. 

Adobe InDesign 

Final Cut Pro is the 
name given to a 
series of non-linear 
video editing 
software programs. 

Final Cut Pro 

Be sure that the 
serial number is 
accurately typed.  
You can find Serial 
Number from the   
installation disk. 

Remember 
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 To perform a custom installation, click the “Customize” button; 
select the optional items you want to install, and then click “Install” 
or “Upgrade”. 

 
11. A dialog appears requiring you to authenticate yourself, type “your name 

and password”. Click “OK” when finished. 
12. The Installer displays a progress bar to indicate its status. 

            A dialog appears once the installation is complete. 
 

 

2. Uninstalling Software from Computer 

The method of uninstalling software from computer is given below: 

1. Click “Start” menu button. 

2. Type “Remove” in search box (“Add or Remove program” will appear in search list). 

3. Click “Add ore Remove” Program (Add or Remove Program Windows will be displayed). 

4. Select and right click on the “Desired Software” which you to remove (popup menu will appear). 

5. Click “Uninstall” from the popup menu (wizard will start) OR 

6. Click “remove” button on the wizard window (uninstall process will start). 

7. Click “Finish” as the process completes uninstallation. 
 

3. System Configuration Required by Software 

 
System Configuration Required for Adobe Photoshop 
 

 Intel® Core 2 or AMD Athlon® 64 processor; 2 GHz or faster processor 

 Microsoft Windows 7 with Service Pack 1, Windows 8.1, or Windows 10 

 2 GB of RAM (8 GB recommended) 

 2 GB of available hard-disk space for 32-bit installation; 2.1 GB of 
available hard-disk space for 64-bit installation; additional free space 
required during installation (cannot install on removable flash storage 
devices)  

 1024x768 display (1280x800 recommended) with 16-bit color and 512 
MB of VRAM (1 GB recommended)* 

 Internet connection and registration are necessary for required software 
activation, validation of subscriptions, and access to online services. 

 
System configuration required by Adobe Illustrator 

 Intel Pentium 4 or AMD Athlon 64 processor 

 Microsoft Windows 7 with Service Pack 1, Windows 8, or Windows 8.1 

You can uninstall all 
other unwanted 
software from your 
computer by 
following the same 
steps mentioned in 
“Uninstalling 
software” section.  

Do you know! 

System 
requirement are the 
necessary 
specifications your 
computer must have 
in order to use the 
software or 
hardware. 

Do you know! 

GPU-accelerated 
computing is the use 
of a graphics 
processing unit 
(GPU) together with 
a CPU to accelerate 
scientific, analytics, 
engineering, 
consumer, and 
enterprise 
applications. 

Remember 
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 1 GB of RAM (3 GB recommended) for 32 bit; 2 GB of RAM (8 GB recommended) for 64 bit 

 2 GB of available hard-disk space for installation; additional free space required during 
installation (cannot install on removable flash storage devices) 

 1024 x 768 display (1280 x 800 recommended) 

 To view Illustrator in HiDPI mode, your monitor must support a resolution of 1920 x 1080 or 
more.  

 To use the new Touch workspace in Illustrator, you must have a touch screen enabled 
tablet/monitor running Windows 8.1. (Microsoft Surface Pro 3 recommended). 

 

System configuration required by CorelDraw 

 Microsoft Windows 8/8.1 (32-bit or 64-bit editions), Windows 7 (32-bit or 64-bit editions), all with 
latest service packs installed. 

 Intel Core 2 Duo or AMD Athlon 64. 

 2 GB RAM. 

 1 GB hard disk space (for installation without content). 

 Mouse, tablet or multi-touch screen. 

 1280 x 768 screen resolution. 

 DVD drive (required for box installation). 

 Microsoft Internet Explorer 8 or higher. 

 Internet connection required for Membership and Subscription services, installing updates and 
access to some features, including the Content Exchange, QR code tools and Concept Share. 

 

System configuration required by Adobe InDesign 

 Intel Pentium 4 or AMD Athlon 64 processor 

 Microsoft Windows 7 with Service Pack 1, Windows 8, or Windows 8.1 

 2 GB of RAM (8 GB recommended) 

 2.6 GB of available hard-disk space for installation; additional free space required during 
installation (cannot install on removable flash storage devices) 

 1024 x 768 display (1280 x 800 recommended) with 32-bit video card; supports HiDPI display 

 Adobe® Flash® Player 10 software required to export SWF files 
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 Internet connection and registration are necessary for required software activation, validation 
of subscriptions, and access to online services. 

 

System configuration required by Front Cut Pro 

 Intel Core 2 Duo (Apple) 

 Mac OS X v10.6.8 or OS X v10.7.5 or OS X v10.8.3 or later 

 2 GB of RAM (8 GB recommended) 

 2.6 GB of available hard-disk space for installation. 

 OpenCL-capable graphics card or Intel HD Graphics 3000 or later with 256 MB of Video 
Memory 

 Internet connection and registration are necessary for required software activation, validation 
of subscriptions, and access to online services. 

 

Other Requirements 

 Broadcast quality monitoring requires OS X v10.7.5 or later and compatible third-party device. 

 Some features require Internet access; additional fees may apply. Blu-ray recorder required 
for burning Blu-ray discs. 

4. Work Environment of Graphics Software  

Adobe Photoshop Work Environment 
 

 

Work Environment of Adobe Photoshop 
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1. Tool Box 

Tool box contains the tools that we use for our activity in Photoshop; we can see tools like brush, move 
tool, rectangular marquee, quick selection tools, magic erase tools and others. 

2. Menu Bar  

Menu bar contains the different menus like you can see file, edit, image, and other menus. 

3. Option Bar 

The options in the option bar change when you select a tool from the tool box. It contains the options 
and settings for the selected tool. 

4. Palettes 

A Palette shows you the information about a particular part of your image and helps you to modify that 
part. 

5. Image Window 

Image window contains your actual image. You can create and make changes to your image in this 
window. 

 
Adobe Illustration Work Environment 
 

 

Work Environment of Adobe Illustrtion 

1. Toolbox 

Toolbox contains different tool to be applied at the image like brush, move tool, pen, quick selection 
tools, magic erase tools and others. 
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2. Menu Bar  

Menu bar contains the different menus like you can see file, edit, image, and other menus. 

3. Control Palette 

Control palette controls the performance of a tool selected from the toolbox. 

4. Palettes 

Palettes in Illustrator tell you what is going on with specific parts of artwork you have created and help 
you to make changes to that artwork.  

5. Art Board 

Art board is your work space in Adobe illustrator; it contains your image or the illustration you can work 
upon. 

6. Status bar 

Status bar shows information and statistics about your document for example saving status, pages etc. 

 

Adobe InDesign Work Environment 

 

Work Environment of Adobe InDesign 

1. Menu Bar  

You can access any of the menu list options by clicking any of the word headings in the menu bar for 
example file, edit, layout etc. 

 

2. Application Bar 

View options, zoom percentage, screen mode, and arrange options are all available from the 
Application Bar drop-down lists. 
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3. Control Panel  

Options for the tool you currently have selected in the Tools panel always appear here. 

 

4. Tools Panel 

You can access any of the InDesign tools by clicking one of the icons shown in the Tools panel. 

 

5. Panels 

Panels can be accessed from the window menu in the menu bar. When you click at some panel it 
appears in the docked on the right side of your screen. 

 

6. Welcome Screen 

This dialog box appears only when you first launch InDesign. It contains links for opening recent 
documents, creating new documents, and accessing the InDesign community via the Internet. 

 

Adobe Premiere Work Environment 

 

Work Environment of Adobe Premiere 

Each workspace item appears in its own panel, and multiple panels can be combined into a single 
frame. Some items with common industry terms stand alone, such as Timeline, Audio Mixer, and 
Program Monitor. The main user interface elements are as follows: 

1. Timeline panel 

This is where you’ll do most of your actual editing. You view and work on sequences (the term for 
edited video segments or entire projects) in the Timeline panel.  

2. Tracks 

You can layer or composite video clips, images, graphics, and titles on an unlimited number of tracks. 
Video clips on upper video tracks cover whatever is directly below them on the Timeline. Therefore, 
you need to give clips on higher tracks some kind of transparency or reduce their size if you want clips 
on lower tracks to show through. 

TVET RSP does not secure copyright of these pictures



 Module 7: Perform Software and Hardware Maintenance 

Teaching and Learning Material: Information Technology (Computer Graphics - Motion)                                                      | 285 

3. Monitor panels 

You use the Source Monitor (on the left) to view and trim raw clips (your original footage). To view a 
clip in the Source Monitor, double-click it in the Project panel. The Program Monitor (on the right) is for 
viewing your sequence.  

4. Project panel 

This is where you place links to your project’s media files: video clips, audio files, graphics, still images, 
and sequences.  

5. Media Browser 

This panel helps you browse your hard drive to find footage. It’s especially useful for file-based camera 
media. 

6. Effects panel 

This panel contains all the clip effects, you will use in your sequences, including video filters, audio 
effects, and transitions (docked, by default, with the Project panel). Effects are grouped by type to 
make them easier to find. 

 

Effect Panel 

7. Audio Mixer 

This panel (docked, by default, with the Source and Effect Controls panels) is based on audio 
production studio hardware, with volume sliders and panning knobs. There is one set of controls for 
each audio track on the Timeline, plus a master track. 

 

Audio Mixer 
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8. Effect Controls panel 

This panel (docked, by default, with the Source and Audio Mixer panels, or accessible via the Window 
menu) displays the controls for any effects applied to a clip you select in a sequence. Motion, Opacity, 
and Time Remapping controls are always available for visual clips. Most effect parameters are 
adjustable over time, allowing you to animate effects. 

 

Effect Control Panel 

9. Tools panel 

 Each icon in this panel represents a tool that performs a specific function, typically a type of edit in a 
sequence.  

10. Info panel 

The Info panel presents information about any asset you select in the Project panel or any clip or 
transition selected in a sequence. 

11. History panel 

This panel tracks the steps you take and lets you back up easily. It is a kind of visual Undo list. When 
you select a previous step, all steps that came after it are also undone. 

 

Sound Forge Pro for Designing Art Work 

Sound Forge Pro is the application of choice for a generation of creative and prolific artists, producers, 
and editors. Record audio quickly on a rock-solid platform, address sophisticated audio processing 
tasks with surgical precision, and render top-notch master files with ease 
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Work Environment of Sound Forge Pro 

1. Menu bar 

Displays the menu headings for the available functions. 

2. Standard toolbar 

Provides quick access to some of the most common tasks in the application.  

3. Transport bar 

Provides quick access to basic audio transport functions.  

4. Status bar 

Help and processing information is displayed on the left side. The boxes on the right side display the 
playback sample rate, bit de path, channel configuration, length of the active data window, CD time 
remaining, and total free storage space. 

5. Workspace 

This is the area located behind the data windows. Audio selections dragged to the workspace 
automatically become new data windows. Windows such as the Regions List and Playlist can be 
docked along the edges of the workspace or in floating window docks. 

6. Channel Meters 

Displays the level of the output audio signal. These meters can be toggled on/off by choosing Channel 
Meters from the View menu. Right-clicking the channel meters displays a shortcut menu that allows 
you to precisely configure the appearance of the meter. 
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Learning Unit 3: Install/ Configure Drivers, Input/ Output 
Devices 

Overview 

In this leaning unit, you will be introduced to device drivers, installation and configuration of device 
drivers and input output devices. After the completion of this unit, you will be able to install and configure 
device drivers. 
 

1. Installation and Configuration of Drivers 

 
Following are the different methods of Device Driver Installation:  
 
1. Through Operating System Installation 

Drivers are automatically installed for all detected devices during installation 
of Windows in your computer. 

2. Windows startup 

Whenever the computer is started and window’s’ desktop appears, new 
devices are detected and their device drivers are automatically installed. 

 
3. Scanning for new hardware 

a. Click “Start” menu button and select Control Panel from the right panel of start menu.  

 

Start Menu 

b. Click “Add a Device” in the Control panel. 

 

Device driver is a 
type of system 
software that 
controls a particular 
type of device that 
is attached to your 
computer. There are 
device drivers for 
printers, scanners, 
CD-ROM readers 
and so on.  

Device Driver 
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Control Panel 

(Wizard will start searching new devices and create a list of drivers which can be installed) 

c. Select desired device from the list 

 
Add a Device 

d. Click next. (wizard will start installing device driver from the windows driver folder). 

4. Manual Installation of a device driver.  

a. Insert the CD/DVD containing the device driver or USB flash 
drive or open folder containing driver setup. 

b. Double click “Driver setup file” and follow the wizard’s 
instructions to install the driver. 

 

5. Auto Drivers 

a. Insert “Auto Driver” disk in CD/DVD rom  

b. Open “My Computer”  

c. Right Click on CD/DVD icon and select “Auto Play” 

d. Wizard will automatic detect and display the list of drivers to be installed 

e. Check required drivers to install and click “Install”  

You must have 
administrative 
permissions on the 
computer to install 
device drivers. 

Remember 

There are many 
disks available 
named Auto Driver, 
which are also used 
to install different 
device drivers. 

Do you know! 
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2. Configuring devices in Device Manager 

In Device Manage (DM) there are some icons which indicate the status of 
devices before configuring any device you must have knowledge of those 
icons.  
 

Indicator Icons are as follows: 

 Normal device icon indicates that the device driver has initialized 
successfully  

 Device icon having “Exclamation point”  on means that, this device 
is incorrectly configured  

 Device icon having “Stop sign”   on means that, this device could not be initialized due to 
hardware conflicts. 

 

3. Resolving Hardware Conflicts 

Follow the steps given below to resolve hardware conflicts:  

1. Click on “Start” menu button. 

2. Type “Device” in Search box (device manager will appear in the list). 

3. Click on “Device Manager” (from the program’s list). 

  
Start Menu 

4. Right click the device which you want to configure and select Properties from the popup list. 

5. Click the “Resources” tab on the Properties dialog box. 

6. Click the “Resource” to be changed and then clear the "Use automatic settings" checkbox. 

7. Click “Change Setting” and then change the value of the setting to the desired value. 
 

4. Updating Device Drivers 

Following is the method of updating a device driver: 
 

1. Insert device driver cd in CD/DVD rom (if your device has). 
 

2. Open “Device Manager”    (to open DM follow same steps 
                                                      Which you leaned in last section) 

Device Manager 
shows status of all 
devices installed in 
your computer. It 
shows a list of 
devices that were 
either detected and 
which drivers are 
installed. 

Device Manager 

Installation of a 
computer program 
(including device 
drivers and 
software), is the act 
of making the 
program ready for 
execution. 

Installation 
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3. Right click on the device which you want to update and select Update Driver Software (wizard 
will start) click any of the following option where you want to search driver. 
 

 
 

Device Update Wizard 
 

4. Driver’s update wizard will start searching for updated driver file from 
the cd or on those locations which you will mention and will upgrade 
your current device driver or if your device already has upgraded driver 
installed it will display following message 
 

 
Updated Status  

 

5. Removing Device Driver 

The method of removing device driver is as under: 

 

1. Open Device Manager. 

2. Right click the device which you want to remove. 

3. Click Uninstall (from the right click popup list). 

 

 

 
Device Manager 

If your driver update 
fails, you can roll 
back your driver to 
discard the changes 
made. 

Remember 



Module 7: Perform Software and Hardware Maintenance 

292 |                                                      Teaching and Learning Material: Information Technology (Computer Graphics - Motion) 

6. Installation and Configuration of Input / Output Devices 

Installation of Input Devices 

Input devices like keyboard, mouse are automatically installed when you 
connect those devices to your computer.  

 

Installing a Scanner 

Most scanners today connect to your computer with a universal serial bus 
(USB) cable. But don't plug it in yet! Some scanners require you to install driver 
software before connecting the USB cable, so always follow the setup 
instructions that came with your device. 

If your USB scanner didn't come with specific setup instructions, plug it in to 
your computer and Windows should automatically install it. If it's an older model, you might have to 
install it manually as: 

 

1. Connect the scanner to power supply and the computer 

2. Insert the CD/DVD containing the scanner driver that comes from manufacturer. Or download 
the driver from manufacturer website and open the folder. 

3. Double click at the setup file. 

4. Follow the instruction while installing. 

5. Now you will be able to use the scanner. 

 

Installation of Output Devices 

Output devices like monitor, speakers etc. are automatically detected and installed by the operating 
system. If your output device is not automatically detected you need to install that manually. 

 

Installing Printer 

The most common way to install a printer is to connect it directly to your computer. This is known as a 
local printer. If your printer is a universal serial bus (USB) model, Windows should automatically detect 
it and begin installation when you plug it in. If it's an older model that connects using the serial or 
parallel port, you might have to install it manually as:  

1. Connect the printer to power supply and computer. 

2. Click “Start” menu button. 

3. Click “Device and Printer” from the right panel of menu 

(Device and Printer window will open). 

4. Click “Add a Printer” on the top left corner of the window 

(installation wizard will start.) 

5. Click “Add a Local Printer” (in next window). 

6. Click “Next” (wizard automatic detect and set printer port). 

7. Select Printer Manufacturer and model from the list or click “Have a Disk” option (if you 
have printer device driver CD). 

Those devices 
which are used by a 
user to input data 
and instructions to 
the computer are 
called input devices. 
Examples are 
Keyboard, Mouse, 
scanner etc. 

Input Devices 

You can get the 
device driver either 
in the CD/DVD 
came with the 
device or can 
download from 
manufacturer 
website. 

Remember 
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8. Click “Next” (in upcoming windows, wizard will start          installing printer). 

9. Click “Finish” (when the installation is completed) 
 

7. Plug and Play Devices  

The user does not have to manually install drivers for the plug and play device 
or even tell the computer that a new device has been connected. Instead the 
computer automatically recognizes the device, loads new drivers for the 
hardware if needed, and begins to work with the newly connected device. 

For example, if you connect a Plug-and-Play mouse to the USB port in your 
computer, it will begin to work within a few seconds of being plugged in. A non-
plug and play device would require you to go through several steps of installing 
drivers and setting up the device before it would work. 

 

  

Those devices 
which are plugin and 
computer recognize 
that the device is 
there. The user does 
not need to 
manually install any 
driver for it. 

Plug and Play 

(PnP) Devices 
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Learning Unit 4: Connecting Devices to Ports using 
Appropriate Cables 

Overview 

In this leaning unit you will be introduced to various types of ports and cables used to connect different 
devices to the computer. After the completion of this unit, you will be able to recognize different types 
of connectors and will be able to differentiate between cables and port which connect the devices to 
the computer.   

 

1. Types of Connector  

Connectors generally have a male end with pins projecting from it. This plug 
is inserted into a female part also called a socket, which includes holes for 
accommodating the pins. However, there are "hermaphroditic" plugs which 
can act as either male or female plugs, and can be inserted into either one.  

 

Monitor Connectors 

HD15 

15 pins in three rows, pins are skinnier than a 
usual "DB" connector, thus it's got an "H" for 
High Density. Used for PC's SVGA video cards 
and monitor cables. 

DB15 

15 pins in two rows, pins are just like a DB9 or 
DB25. Used for Mac monitors. 

 
DB9 

9 pins in two rows, used on older monitors, and VGA's. PS/2 style Serial 
ports also use DB9 

 

Parallel/Printer Connectors 

CN36 (male) 

This is the connector used by most printer cables. 

 

Connectors normally 
called "input-output 
connectors are 
interfaces for 
connecting devices 
by using cables. 

Connectors 

Dot/ Point are the 
smallest and most 
basic element.  

Dot/ Point 

A line is a mark 
between two points 

Line 
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DB25 (male) 

This is used for parallel printers (and other parallel port devices) as well 
as SCSI and serial ports. If you see a male on the back of your 
computer, it is usually your COM2 serial port. 

 

Firewire Connectors 

4-pin.i.Link connector  

This is basically a 4-pin Firewire/i.link/ 
connector.  

 

IEEE-1394 connector 

This is a 6-pin Firewire/IEEE-1394 connector. 

 

USB Connectors 

USB type "A" connector 

USB type "A" connector connects to computer or USB Hub. 

 

USB type "B" connector 

USB type "B" connector connects to peripheral or to USB Hub. 

 

Mini USB 2.0 Connector 

Mini USB 2.0 connector used on many new USB digital cameras. 

 

Audio/Video Connectors 

S-Video Connector 

S-Video connector sometimes called S-VHS or Y/C video. There are 4 
little pins in it, it is called a DIN4. 

 

Fire-wire connectors 
were developed for 
high speed data 
transfer between 
computer and other 
devices. 

Do you know! 
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Standard Stereo Connector 

RCA (above) connector. Standard stereo connector.  

 

Fiber Optics Connectors 

ST connector 

SC connector, fiber optic network connector.  

 
ST connector, fiber optic network connector. 

 

MTRJ connector 

MTRJ fiber optic network connector  

 

2. Differentiate Between Different Types of Cables  

It is important for you to know about the difference between cables used in computer in order to make 
right decisions when choosing a cable for your computer. Following is the list of most commonly used 
computer cables. 

Video Graphics Array (VGA) 

VGA Cable 

VGA connection cable was the standard cable used to connect a 
computer to a monitor. VGA cable has 15 pins arranged in 3 row having 
5 pins each. Each row represents one of three basic colors used in 
display: red. Blue, green. 

Digital Visual Interface (DVI) 

DVI Cable 

The DVI connections have replaced VGA as technology moved away 
from analog towards digital. Digital displays, like LCD, proved to be 
higher quality, which soon became the market standard for home 
pictures. 

 

 

 

 

SC connector 
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High Definition Multimedia Interface (HDMI) 

HDMI Cable 

Unlike VGA and DVI, HDMI sends both video and audio signals 
together. The signals are digital only thus, HDMI is only compatible with 
newer devices. 

 

Universal Serial Bus (USB) 

 

From left to right: micro USB, mini USB, type B standard USB, and type A standard USB (both female 
and male) 

USB cable is most commonly used cable today. There are multiple versions of USB available: 

1. USB 1.0/1.1 can transmit data at speeds up to 12 Mbps. 

2. USB 2.0 can transmit data at speeds up to 480 Mbps and is compatible with older versions of 
USB. At the time of this article, USB 2.0 is the most common type found in the market. 

3. USB 3.0 can transmit data at speeds up to 4.8 Gbps. It is compatible with previous versions of 
USB. 

 

IDE (Integrated Drive Electronics) 

IDE Cable 

IDE cables were used to connect storage devices to a motherboard. The 
connectors on an IDE cable have 40 pins; the smaller 2.5” drive variety 
uses a form-factor version of the IDE that has 44 pins. 

 

SATA (Serial Advanced Technology Attachment) 

SATA Cable 

Newer hard drives will likely use SATA ports over IDE ports. Compared 
to IDE, SATA provides higher data transfer speeds. A standard SATA 
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cable can be identified by two connectors, each having 7 pins and an empty notch. It looks like a subtle 
L-shape. 

FireWire 

FireWire Cable 

The purpose of FireWire is similar to that of USB: high speed data 
transfer for computer peripherals.  

Ethernet 

Ethernet Cable 

Ethernet cables are used to set up local area networks. In most cases, 
they’re used to connect routers to modems and computers. 

 

3. Ports Used for Connection of Various Devices 

Port 

Port is computer is a physical docking point using which an external device can be connected to the 
computer. 

Characteristics of Port 

A port has the following characteristics: 

1. External devices are connected to a computer using cables and ports. 

2. Ports are slots on the motherboard into which a cable of external device is plugged in. 

Examples of external devices attached via ports are mouse, keyboard, monitor, microphone, speakers 
etc. 

Following are some important types of ports: 

 

Ports in Computer 
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Serial Port 

Serial Port is used for external modems and older computer mouse. It has two 
versions: 9 pin, 25 pin model. Data travels at 115 kilobits per second. 

Parallel Port 

Parallel Port is used for scanners and printers. It is also called printer port. It is 
a 25 pin model. 

PS/2 Port 

It is used for old computer keyboard and mouse. It is also called mouse port. 
Most of the old computers provide two PS/2 port, each for mouse and keyboard. 

Universal Serial Bus (or USB) Port 

It can connect all kinds of external USB devices such as external hard disk, printer, scanner, mouse, 
keyboard etc. It was introduced in 1997. Most of the computers provide two USB ports as minimum. 
Data travels at 12 megabits per seconds. USB compliant devices can get power from a USB port. 

VGA Port 

It connects monitor to a computer's video card. It has 15 holes. Similar to serial port connector but 
serial port connector has pins, it has holes. 

Power Connector 

It is a three-pronged plug which connects to the computer's power cable that plugs into a power bar or 
wall socket. 

Firewire Port 

It transfers large amount of data at very fast speed. It connects camcorders and video equipment to 
the computer. Data travels at 400 to 800 megabits per seconds. It is found in three variants: 4-Pin 
FireWire 400 connector, 6-Pin FireWire 400 connector and 9-Pin FireWire 800 connector. 

Modem Port 

It connects a PC's modem to the telephone network. 

Ethernet Port 

It connects to a network and high speed Internet. It Connect network cable to a computer. This port 
resides on an Ethernet Card. Data travels at 10 megabits to 1000 megabits per seconds depending 
upon the network bandwidth. 

Game Port 

It connects a joystick to a PC. Now replaced by USB. 

Digital Video Interface, DVI Port 

It connects Flat panel LCD monitor to the computer's high end video graphic cards. It is very popular 
among video card manufacturers. 

Almost every form of 
computer peripheral 
devices like 
keyboards, mice, 
headsets, flash 
drives, wireless 
adapters, etc. can 
be connected to 
your computer 
through a USB port. 

Do you know! 
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Sockets 

Connects microphone, speakers to sound card of the computer. 

 

4. Procedure of Installing a Printer with Computer   

The procedure of Installing a printer has the following steps:  

1. Connect the printer to power supply and computer. 

2. Click “Start” menu button. 

3. Click “Device and Printer” from the right panel of menu (Device and Printer window will open). 

4. Click “Add a Printer” on the top left corner of the window (installation wizard will start). 

5. Click “Add a Local Printer” (in next window). 

6. Click “Next” (wizard automatic detect and set printer port). 

7. Select Printer Manufacturer and model from the list or click “Have a Disk” option (if you have 
printer device driver CD). 

8. Click “Next” (in upcoming windows, wizard will start installing printer). 

9. Click “Finish” (when the installation is completed). 
 

  



 Module 7: Perform Software and Hardware Maintenance 

Teaching and Learning Material: Information Technology (Computer Graphics - Motion)                                                      | 301 

Summary of Module 

 You can install operating system in the computer by using Bootable CD/DVD, Bootable USB 
Flash Drive or Ethernet. 

 You may want to uninstall an operating system when you have a dual boot on the hard drive or 
when you want to remove the only operating system on the hard drive and reuse it in future. 

 Upgrading your operating system is useful when you want keep your application software and 
personal files and upgrade only the operating system. 

 In order to have good system configuration for graphics software like Adobe Photoshop, Adobe 
Illustrator, Adobe InDesign and CorelDraw, you can extend RAM, use GPU performance using 
1 GB of VRAM and higher resolution for monitor.  

 A palette in Adobe Photoshop and Adobe illustrator show you the information about a particular 
part of your image and helps you to modify that part. 

 Art board, Work space or image window is the space where you can create, edit and modify 
your image in graphic software 

 CorelDraw is a vector based drawing program or software that makes it easy to develop 
professional artwork from simple logos to complex technical illustrations. 

 A device driver is a program that controls a particular type of device that is attached to your 
computer. Device drivers can be configured, updated and removed in device manager. 

 The term Plug and Play, sometimes abbreviated as PnP is used to describe devices that start 
working with a computer system as soon as they are connected. 

 Connectors normally called "input-output connectors are interfaces for connecting devices by 
using cables. Port is computer is a physical docking point using which an external device can 
be connected to the computer. 
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Frequently Asked Questions (FAQs) 

FAQ 1:  What is dual boot? 

Answer Dual boot means having multiple operating systems installed on different partitions. 

FAQ 2:  What is operating system upgrade? 

Answer 
Upgrading means the new operating system will simply replace your previous 
installation, and you'll be able to keep all of your files and programs. 

FAQ 3:  What are Plug n Play devices? 

Answer 
These are the devices that start working with a computer system as soon as they are 
connected. The user does not have to manually install drivers for the device 

FAQ 4:  Why drawings of CorelDraw called vector based? 

Answer 
Drawings in Corel Draw are vector based because objects drawn are defined 
mathematically as a series of points (dots) joined by lines. Graphical elements in a 
vector file called objects. 

FAQ 5:  Which processor required for most of the graphic software? 

Answer Intel® Core 2 or AMD Athlon® 64 processor; 2 GHz or faster processor 

FAQ 6:  What is Tool Box in graphic software? 

Answer 
Tool box contains the tools that we use for our activity in graphic software; we can see 
tools like brush, move tool, rectangular marquee, quick selection tools, magic erase 
tools and others. 

FAQ 7:  What is status bar? 

Answer 
Status bar shows information and statistics about your document for example saving 
status, pages etc. 

FAQ 8:  What are connectors? 

Answer 
Connectors normally called "input-output connectors are interfaces for connecting 
devices by using cables. They generally have a male end with pins projecting from it. 
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FAQ 9:  What is the use of DVI (Digital Visual Interface)? 

Answer 
The DVI connections have replaced VGA as technology moved away from analog 
towards digital. Digital displays, like LCD, proved to be higher quality, which soon 
became the market standard for home pictures 

FAQ 10:  Which port is used to connect a network cable? 

Answer Use ehernal port to connect a network cable 
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key 
at the end of this module. 

1.  To Install an operating system using disk, 1st boot device must be set to ________. 

a.  Network b.  CD/DVD 

c.  USB Drive    d. Hard Disk 

2.  Disk Partition is used for: ____________________. 

a.  Formatting Drive b.  Dividing disk space 

c.  Deleting Disk d.  None of these 

3.  Upgrading Operating system means_________________. 

a.  
To upgrade older operating system 
with new one 

b.  To install dual operating system 

c.  To remove Operating system d.  None of these 

4.  Dual Operating system means _________________. 

a. Installing a new operating system b. 
Having more than one operating 
system 

c. 
 
Uninstalling operating system 
 

d. All of these 

5.  The user does not have to manually install drivers for ______________. 

a. Input Devices b. Output Devices 

c. Plug and Play Devices d.  None of these 

6.  Corel Draw is a _________ graphics software. 

a. Raster Based b. Vector Based 

c. Both of these d.  None of these  
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7.  VGA cable is used to connect  __________________. 

a. Computer Network b. Power Supply 

c. Connect Printers d.  A monitor to a computer  

8.  HDMI cable sends _________________________. 

a. Audio Signal b. Video Signal 

c. Both Audio and Video Signal d.  None of above 

9.  Device icon having “Exclamation point”  on means ____________. 

a. Device is not installed b. Device is working properly 

c. Hardware conflict d.  Device is incorrectly configured 

10.  Ethernet port connects ________________. 

a. Printer to computer b. Joy stick  

c. Network cable to computer d.  All of these 
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Answer Key 
MCQ number Correct Answer 

1 b 

2 b 

3 a 

4 b 

5 c 

6 b 

7 d 

8 c 

9 d 

10 c 
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Module 8: Communicating with Others 

Learning Outcomes 

After completion of this learning module, you will be able to: 

  Communicate with client, business owner and supervisor, and 
synthesize relevant information about all problems and 
understanding of their product/ service required 

  Develop a strategy for using communication skills 

  Interact with other professionals involved in design 
development through effective teamwork 
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Learning Unit 1: Communicate with Others 

Overview 

In this learning unit, you will learn different concepts involved in communicating with clients, business 
owners and other stakeholders. After completion of this learning unit, you will be able to demonstrate 
effective dealings with clients, business owner or supervisor and synthesize relevant information about 
all problems and understanding of their product/ service required. 
 

1. Communication and Interpersonal Communication 

The process of conveying your idea or thought to the audience in such a way; 
that is comprehensive is called communication. It can be one way process 
where information flows in one direction only for example lecture in the class, 
or a two way process of mutual understanding in which the participants share 
information, ideas, and new thoughts etc. with each other. Communication is 
the key element for a business. 
 

 
 

Illustration Showing Flow of Communication Process 
 
Interpersonal Communication 

Interpersonal communication is the process by which people exchange 
information, feelings, and meaning through verbal and non-verbal messages: it 
is face-to-face communication. 
 
 
 
Importance of Communication 

Communication plays a vital role in everyday life whether it is personal or business. In the business 
world, good communication is important for the daily operation of the company, but can also affect 
sales and profitability. Without good business communication, there will be no mutual exchange of 
thoughts, ideas, news and the internal and external structure of a business can face numerous 
challenges that can ultimately lead to its demise. 
 

Message

Reciever

Feedback

Sender

A stakeholder is an 
individual or group 
who has an interest 
in the outcome of 
body of work. 

Remember 

Interpersonal 
communication 
refers to the 
communication we 
do in our daily life at 
personal levels. 

Interpersonal 

Communication 

Medium is the 
channel or means of 
transmitting the 
message to the 
receiver. 

Medium 
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2. Skills Needed to Interact in a Social Environment 

Following are the skills we use to communicate and interact with each other in the social environment 
both verbally and non-verbally through gestures, body language and personal appearance.  

 

Skills Used for Interacting with Society 
 

1. Listening 

For a good communication, you need to be a good listener first. Active listening means paying close 
attention that what the other person is saying, asking question for clarification, and rephrase what the 
person says to ensure understanding. 

 

2. Non-Verbal Communication 

Non-verbal communication is a communication without words such as your body language, eye 
contact, hand gestures, and tone of voice which convey a clear message to receiver or listener.  

 

3. Clarity and Concision 

Try to convey a concise message as possible. Say what you want to say clearly and directly, whether 
you are talking to someone directly face to face, through phone or via email.  

 

 

Communication 
Skills

Listening

Non-Verbal 
Communication

Clarity and 
Concision

Friendliness

Confidence

Empathy

Feedback

Right medium  
Selection
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4. Friendliness 

In friendly communication, you can encourage other persons to talk and share their information with 
you easily and freely which improve your knowledge and skills. 

 

5. Confidence 

You should be confident in all communication and interactions with your colleagues. It also makes your 
communication credible. 

 

6. Empathy 

Always respect the other people’s point of view even when you disagree with an employer, co-worker, 
or employee.  

 

7. Feedback 

The final step of communication process is feedback. Feedback means receiver’s response to sender’s 
message. It increases the effectiveness of communication. It ensures that the receiver has correctly 
understood the message. Feedback is the essence of two-way communication. manager and 
supervisor should continuous take and provide a constructive feedback through phone, E-mail on 
weekly and monthly basis  

 

8. Picking the Right Medium 

Selection of a right medium to communicate with others is very important. Direct face to face and 
telephonic conversation is an appropriate communication but when you need to communicate with a 
busy person such as your boss, then you can email him without disturbing him. 
 

3. Gathering Requirements 

Gathering requirements is an essential part of any business provides offering 
a product or service to customers. A poor requirement gathering results in a 
situation that doesn’t meet customer’s requirements. In order to communicate 
attentively, you need to follow these rules. 

 Don't assume you know what the customer wants, always ask him 
about his requirement. 

 Get user involved from the start. 

 Define the scope of project and ensure customer is agreed. 

 Clarify if there is any doubt. 

After finalizing the 
required documents, 
get it signed by the 
customer that will 
save you and your 
company from many 
troubles. 

Remember 
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 Create a document that describes all the requirements clearly, concisely and thoroughly as 
acquired from the client. Share that document with the customer.  

 Confirm your gathered requirement from the customer by playing them back to him. 

 Don’t move ahead in the project until requirements are fully understood. 

 Create a prototype if necessary to confirm or refine the customers' requirements. 

4. Applying of Communication Skills 

The department/organization comes into daily contact with external stakeholders. It is vital to use your 
communication skills to have stakeholders a better understandability and enable them to take decision 
as partner.  

The following rules should help you in understanding the difference and mutual benefits of yours and 
the stakeholders.  

 Significance: Deal with issues of significance to stakeholders and the agency. 

 Completeness: Understand the concerns, views, needs and expectations. 

 Responsiveness: Respond coherently and appropriately 

 Communication: open and effective communication means listening and talking. 

 Transparency: Clear and agreed information and feedback processes. 

 Collaboration: Work to seek mutually beneficial outcomes where feasible. 

 Inclusiveness: Recognize, understand and involve stakeholders in the process. 

 Integrity: Conduct engagement in a manner that develops mutual respect and trust. 

In that way stakeholders will develop a sense of trust in organization that will enable him to make 
decision as partner with you. 
 

5. Oral and Written Communication 

Communication can be done in two ways, these have been described below: 

1. Oral Communication 

Oral communication is the process of verbally transmitting information and 
ideas from one individual or group to another. Oral communication can be either 
Formal or Informal. Example of Formal oral communication include: 

 Presentations at business meetings  

 Classroom lectures 

 Commencement speech given at a graduation ceremony 

Oral communication 
is the process of 
expressing 
information or ideas 
by word of mouth. 

Oral 

Communication 
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Examples of informal oral communication include: 

 Face-to-face conversations 

 Telephone conversations 

 Discussions that take place at business meetings 

For an effective oral communication, you need to follow following rules: 

 Words should be selected and framed properly and are delivered in the right pitch and tone.  

 Clarity, and right perception on the other hand are mandatory features of an effective oral 
communication system. Sentences used in communication should be clear in meaning and 
easy to understand. 

 

2. Written Communication 

Any communication that involves written or documented material from sender 
to receiver is called written communication. For example, letters, memos, 
research papers, reports, etc. 

It is a very concrete form of documentary evidence and can also be used for 
future reference purposes. As the information is written, it can be easily 
distributed to many people thus making it a bulk communication method. As the 
information does not change from person to person, the accuracy of the 
information conveyed is same across the entire audience. 

For effective written communication you need to keep the  following rules in 
mind: 

 There must be completeness, clarity and correctness in your writing.  

 As there is no immediate feedback that can be received, it is important that written 
communication is detailed and accurate to ensure that the write message is communicated. 

 Also remember to keep the communication simple and without any errors.  

 Replace Negative Words with Neutral or Positive Words. For example replace “Your 
argument that…” with “in your email you mentioned that …” etc. 

Using an active voice will strengthen your writing. Sentences that are written in the active voice will 
flow better and are easier to understand. Long, complicated sentences will slow the reader down. 
 

6. Synthesis and Presentation of Information 

Once all the information is gathered from client, it is then arranged in such a way that it can be 
presented and process further. Following steps help to leads gathered information towards the final 
product specifications: 

 

A communication in 
which some written 
or documented text 
is exchanged 
between sender and 
receiver is called 
written 
communication. 

Written 

Communication 
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1. Verification of Information 

All the information gathered from customer is rephrased and rechecked by the customer if it matches 
his needs. All the confusions are made clear. Corrections are made in case of any tweaks. This 
verification is very important because any loose end in the requirement gathering can lead to a product 
that doesn’t match customer’s need. 

2. User Requirement Document 

After customer verifies all the requirements and makes corrections where 
necessary, the gathered information is documented into user requirement 
document (URD) which is meant to spell out exactly what specification the 
product will have and becomes part of the contractual agreement. A customer 
cannot demand features not in the URD, while the developer cannot claim the 
product is ready if it does not meet an item of the URD. 

3. Setting Goals and Objectives 

From user requirement document, the objectives/goals are defined. Goals are 
the aims that need to be achieved for the completion of your project. The 
objectives defined should be clear and contain all the necessary details for what 
needs to be done within the available time and resources.A goal should be 
SMART:  

 Specific 

 Measureable 

 Achievable 

 Relevant 

 Time bound 
 
4. Feasibility Study 

After defining goals and objectives, feasibility study of objectives is done to 
know if objectives have ability to compete successfully taking into account, 
legal, economic, technological, scheduling and other factors. 

5. Final Product or Service 

As all the objective/ goals are finalized along with the details about resources used to complete the 
objectives and the time frame available to get it done. You will now be able to present the specification 
and final outcome of the product or services. This product will meet the customer requirements in all 
aspects.  

 

  

A specific result that 
a person or system 
aims to achieve 
within a time frame 
and with available 
resources.  

Goals/Objectives 

Sometimes people 
set a range of 
values as successful 
performance instead 
of a specific target. 
This is a wrong 
approach. An object 
should always be an 
exact and discrete 
target. 

Remember 

Feasibility study is 
an analysis of the 
viability of an idea. 

Feasibility Study 
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Learning Activities 

Understanding the Concept of Communication 

Description:  This activity consists of an interactive session in the class about the 
importance of communication and encouraging the learner to communicate in 
his own way. 
 

Time Guideline: 30 min 

Purpose:  To highlight the importance of communication in personal life and business 
environment. 

Presentation: 
 

1- Ask learners if they agree or disagree to the statement (purpose). 
2- Ask learners why they agree that communication is important. 
3- Ask learners to select a topic from daily life and try to communicate 

their ideas to the class. 
4- Encourage the learners for their try. 
 

Requirement Gathering through Communication 

Description:  This activity consists of an interactive session in the class about how to 
interview a customer with effective communication to gather all the 
requirements. 
 

Time Guideline: 30 min 
 

Purpose:  To highlight the importance of communication for gathering requirements in a 
project. 
 

Presentation: 
 

1- Select a volunteer in the class who can act as customer. 
2- Brief the volunteer about the requirement of the project 
3- Interview the customer utilizing all the communication skills. 
4- Present to the class all the collected information that can be used in 

future activities. 
 

  



Module 8: Communicating with Others 

316 |                                                      Teaching and Learning Material: Information Technology (Computer Graphics - Motion) 

Learning Unit 2: Communicating with Seniors, Peers and 
Subordinates 

Overview 

In this learning you will learn importance and different skills and techniques used to communicate with 
colleagues, seniors, junior, peers etc. After the completion of this unit, you will be able to demonstrate 
effective communication with your colleagues and Interact with other professionals involved in design 
development through effective teamwork. 

1. Communicating Effectively 

Communicating effectively with your colleagues decreases misunderstandings and increases work 
efficiency as much as possible. Effective communication also produces healthy working relationships, 
and allows you and your colleagues to resolve issues in a collaborative manner. Below are some ways 
to communicate better with your colleagues at work: 

Listen Actively 

Listening actively shows that you’re interested in what your colleague has to 
say and that you respect them. Listen to them closely, orienting your body 
towards them, and look at them directly as they speak.  

Speak with Discretion and Talk Face to Face 

Face to face communication helps through building trust and openness, and it 
enables you to sense and understand someone’s viewpoint and feelings.  
 
Offer Constructive Criticism 

When giving feedback, leave your personal feelings out of it and make sure 
your workmate fully understands what you’re telling them.  

Build and Earn Trust 

For effective communication, everyone must trust and respect each other. To 
build trust with your colleagues, it’s important that you act consistently and with 
integrity. To earn their trust, communicate clearly, collaboratively and 
confidentially with them while showing them respect.  

Get Personal but Don’t be too Casual 

Get to know your colleagues better by talking about your personal lives during 
breaks or after work. This is also a good way to build trust. However, it’s 

important that you don’t get too casual in your conversations, especially in the office, as it might make 
the other person uncomfortable.  

Communication Preference and Technology Etiquette 

Some people like communicating via email while others prefer talking on the phone, texting, or using 
social media or instant messaging. Use the method of contact that the other person prefers. 

Arms crossed and 
shoulders hunched, 
on the other hand, 
suggest disinterest 
in conversation or 
unwillingness to 
communicate. 

Do you know! 

People will judge 
your competency 
through your 
vocabulary. If you 
aren’t sure of how to 
say a word, don’t 
use it. 

Remember 

People will perceive 
you as nervous and 
unsure of yourself if 
you talk fast. 
 

Remember 
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Make your Message More Listenable and Relevant to Listeners 

Your communication is only relevant if it’s related to what the other person wants, needs, fears or 
desires.  
 

2. Monitor and Reflect Communication Skills Critically 

For effective monitoring of communication, it is a good practice to take leading 

role during discussions and emphasis on key points. Once you get the desired 

information about your work, you need to evaluate it to make a decision about 

your work. Your communication strategy should include the following: 

 Organise and clearly present relevant information, including your 
outcomes, illustrating what you say by making comparisons, 
providing examples that relate to the interests of the audience and using a range of methods 
to illustrate complex points. 

 Vary use of vocabulary and grammatical expression to convey particular effects, enable fine 
distinctions to be made and engage your audience. 

 Assess the effectiveness of your strategy, identifying factors that had an impact on the 
outcomes. 

 Identify ways of further developing your communication skills. 

 

  

Observe and check 
the progress or 
quality of 
(something) over a 
period of time. 

Monitoring 
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Learning Activity 

Understanding the Importance of Communication with 
Team Members and Colleagues 

Description:  This activity consists of a group assignment where class is divided into 
groups and groups are assigned some problems. The group members work 
together as a team and solve the problem.  
 

Time Guideline: 30 min 
 

Purpose:  To highlight the importance of team collaboration. 
 

Presentation: 
 

1- Divide the class into groups of five. 
2- Assign each group some graphic work like logo for institute on paper 

etc. and some time limitation. 
3- Ask learners to share ideas with group members and utilize your 

combined ideas to solve the problem. 
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Summary of Module 

  The process of exchanging information, thoughts and ideas is called communication. 

Interpersonal communication means interacting with people at personal level.  

  In order to interact with the social environment, one needs to learn skills like listening, non-

verbal communication, clarity and concision, friendliness, confidence, empathy, feedback 

and the selection of right medium for communication. 

  Requirement gathering is an essential step in every project. Through effective 

communication, requirements are gathered from the customer. Clearer the requirements, 

finer will be the product. 

  Every department is dealing with the stakeholders. Negotiating with stakeholders and letting 

them know about mutual benefits enables them to undertake decision as partners. 

  Communication can be performed in two ways, oral and written; oral communication is easy 

and has in-time response. Written communication contains concrete document that can be 

used for future reference. 

  All the gathered information from the customer is then documented, objectives are defined 

and final product specifications are developed. 

  It is important to use your communication skills to exchange ideas and collect information 

from your colleagues, seniors and juniors. It will develop healthy working relationships, and 

allows you and your colleagues to resolve issues in a collaborative manner.  

  Organize and clearly present the outcomes giving relevant examples which are in the 

interest of the audience.  
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Frequently Asked Questions (FAQs) 
FAQ 1:  Why is communication important for an organization? 

Answer 
Communication is important for an organization because without effective 
communication, there will be no mutual sharing of thoughts, ideas, news etc. 

FAQ 2:  What is the difference between communication and interpersonal communication? 

Answer 
The process of exchanging information or news etc. is called communication. 
Interpersonal communication refer to the communication we do in our daily life at 
personal levels. 

FAQ 3:  What does the communication skill empathy means? 

Answer 
Empathy means always respecting other people’s point of view even when you disagree 
with an employer, coworker, or employee. 

FAQ 4:  Why is requirement gathering important? 

Answer 
Requirement gathering is one of the most important task in deciding the success of a 
project because, a poor requirement gathering will result in a poor outcome thus 
useless. 

FAQ 5:  What are useful skills for exact requirement gathering? 

Answer 
Involve the customer form start, clarify the doubts, confirm gathered material by playing 
them back, and create a prototype to confirm the requirements. 

FAQ 6:  Who are stakeholders? 

Answer 
A stakeholder is an individual or group who has an interest in the outcome of body of 
work. 

FAQ 7:  What is goal or objective? 

Answer 
A specific result that a person or system aims to achieve within a time frame and with 
available resources.  

FAQ 8:  What is feasibility study? 

Answer 
Feasibility study is an analysis of the achievability of an idea keeping in view the 
resources and time available. 

FAQ 9:  What is the purpose of effective communication with colleagues? 

Answer 
Communicating effectively with your colleagues decreases misunderstandings and 
increases work efficiency as much as possible. 

FAQ 10:  How can you present your point clearly? 

Answer 
By making comparisons, providing examples that relate to the interests of the audience 
and using a range of methods to illustrate complex points. 
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Test Yourself! 

Please mark the correct one from the given options. You can check your answer with the Answer Key 
at the end of this module. 

1.  Select the non-verbal type of communication from the following: 

a.  Oral b.  Written 

c.  Gestures d.  Clues 

2.  Requirement are gathered through ____________________. 

a.  User involvement. b.  Pre assumption 

c.  Your perception d.  Documentation 

3.  Stakeholders are facilitated to increase understandability as ____________. 

a.  Showing them documentation b.  Presenting project specifications 

c.  Accepting their terms d.  
Telling them mutual benefits and 
negotiating. 

4.  Advantage of written communication is ____________. 

a. 
A written document that can be 
used for future reference 

b. Writing a document is easy 

c. 
Consumes less time in 
communication 

d.  
Increases understandability of the 
document. 

5.  Select the INCORRECT option, A goal set should be __________________. 

a. Relevant b. Broad 

c. Achievable d.  Time Bound 
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6.  Feasibility study keeps in account______________________. 

a. Time, resources, orders b. Resources, legalities, stakeholders 

c. Time, resources, legalities d.  Stakeholders, orders, time 

7.  Constructive criticism means __________________. 

a. Appreciate all type of work. b. Point out the negative points. 

c. 
Keep your personal feeling out 
while giving feedback. 

d.  
Keep yourself out of other’s work. 
 

8.  
You can monitor and reflect on your use of communication skills including 
___________. 

a. Obtaining feedback from others b. Making changes yourself 

c. Updating according to latest trends d.  Developing good relation with other 

9.  Assess the effectiveness of your strategy by ____________________. 

a. Looking at audience expressions b. 
Identifying the factors that had an Impact 
on outcomes 

c. From the evaluation results d.  Reviewing the planning 

10.  
Final product requirements that meets customer needs depends upon 
_______________. 

a. The resources b. Requirement gathering 

c. Customer behavior  d.  Times available 
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Answer Key 
MCQ Number Correct Answer 

1 c 

2 a 

3 d 

4 a 

5 b 

6 c 

7 c 

8 a 

9 b 

10 b 
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Module 9: Duties and Rights at a Work 
Place 

Learning Outcomes 

After completion of this learning module, you will be able to: 

 Understand and perform the mandatory standard for 
Responsibility, Respect, Fairness and Honesty 

 Identify tasks, their scheduling, define milestones, and learn 
optimal utilization of resources 

 Recognize the aspirational requirements of human rights in 
employment context 

 Understand the legal right granted to an author, composer, 
publisher, production, or any other artist’s work 

 Understand that unauthorized use or reproduction of copyright 
or patented material is illegal 

 Understand that you can’t give the design made for and sold to 
one client to the others 
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Learning Unit 1: Ethics and Professional Conduct 

Overview 

In this leaning unit, you will learn the four values that serve as the foundation for decision making and 
guidance to the action of the employees i.e. Responsibility, Respect, Fairness, and Honesty. After the 
completion of this learning unit, you will be able to identify and practice the mandatory standards for 
these four pillars. 

 

1. Responsibility 

“Responsibility” is our duty to take ownership for the decisions we make or fail to make, the actions we 
take or fail to take, and the consequences of those decisions and actions. The responsibility involves 
two types of standards working in a work place. These are described below: 

 

Aspirational Standards 

Working in an organization, following aspirational standards need to be 
followed. 
 

 Take decisions and perform actions which are in the best interests of the society, are not a risk 
for public safety, and beneficial for the environment. 

 Accept only those assignments that are consistent with your background, experience, skills, 
and qualifications so that you can fulfill the assignment with professional conduct. 

 Always fulfill the commitments that you undertake, you should do what you say you will do. 

 If you make errors or omissions, take responsibility and make corrections instantly. If you come 
to know that the errors or omissions were caused by others, communicate them to the 
appropriate person as soon they are discovered. Accept accountability for any issues resulting 
from your errors or omissions. 

 Protect proprietary or confidential information shared with you by the customer as a result of 
trust on you. 

 

Mandatory Standards 

Requirement standards that all the employees must fulfill include: 

 You should know and maintain the policies, rules, regulations and laws that control your work, 
professional behavior, and volunteer activities. 

 Report unethical or illegal behavior to appropriate management and, if necessary, to those 
affected by the manner. 

 Bring violations to these standards to the attention of the suitable body for resolution. 

 Only those ethics complaints should be filed which are validated by facts. 

 Follow disciplinary action against an individual who reacts against a person raising ethics 
concerns. 

 

The state or fact of 
having a duty to deal 
with something or of 
having control over 
someone. 

Responsibility 
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2. Respect 

Respect refers to show a high regard for ourselves, others, and the resources assigned to us. 
Resources entrusted to us may include people, money, reputation, the safety of others, and natural or 
environmental resources. 

An environment of respect creates trust, confidence, and performance excellence by raising mutual 
cooperation.  

 

Aspirational Standards 

The aspirational standards of respect include 

 Should inform ourselves about the rules and traditions of others and avoid engaging in 
behaviors they might consider disrespectful. 

 Listen to others’ points of view, in order to understand them. 

 Approach directly those persons with whom you have a conflict or disagreement. 

 Conduct in a professional manner, even when it is not replied the same way. 

 

Mandatory Standards 

The mandatory standards of respect are as follows 

 Negotiate in good faith. 

 Do not exercise the power of your expertise or position to influence the decisions or actions of 
others in orders to get benefit personally at their expense. 

 Do not act in a rude manner towards others. 

 Respect the property rights of others. 
 

3. Fairness 

Fairness is our duty to make decisions and act neutrally and objectively. Our 
conduct must be free from competing self-interest, bias, and favoritism. 

 

Aspirational Standards 

The aspirational standards for fairness are: 

 Always demonstrate transparency in your decision-making process. 

 Constantly re-examine your neutrality and objectivity, taking corrective 
action if necessary. 

 Provide equal access to information to those who are authorized to have that information. 

 Make opportunities equally available to qualified candidates. 

 

Mandatory Standards 

The mandatory standards for fairness are as under: 

 Fully disclose any real or potential conflicts of interest to the appropriate stakeholders. 

In the workplace, 
perceived injustice 
has been directly 
linked to burnout 
and job 
dissatisfaction. 

Remember 



 Module 9: Duties and Rights at a Work Place 

Teaching and Learning Material: Information Technology (Computer Graphics - Motion)                                                      | 329 

 If you realize that you have a real or potential conflict of interest, avoid engaging in the decision 
making process or otherwise attempting to influence outcomes until you have made full 
disclosure to the affected stakeholders. 

 Never hire or fire, reward or punish, or award or deny contracts based on personal 
considerations, bias, or favoritism. 

 Never discriminate against others based on gender, race, age, religion, disability, nationality, 
or sexual orientation. 

 Apply the rules of the organization (employer, Project Management Institute, or other group) 
without favoritism or prejudice. 
 

4. Honesty 

Honesty is our duty to understand the truth and act in a truthful manner both in our communications 
and in our conduct. 

 

Aspirational Standards 

Aspirational standards for honesty includes: 

 Sincerely try to understand the truth. 

 Always be truthful in your communications and in your conduct. 

 Provide accurate information in a timely manner. 

 Always make commitments and promises, unspoken or clear, in good faith. 

 Should strive to create an environment in which others feel safe and comfortable to tell the 
truth. 

 

Mandatory Standards 

Mandatory standards for honesty include: 

 Do not engage in or ignore behavior that is designed to deceive others, making misleading or 
false statements, stating half-truths, providing information out of context or withholding 
information that, if known, would render your statements as misleading or incomplete. 

 Do not engage in dishonest behavior with the intention of personal gain at the expense of 
another 
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Learning Activity 

Taking ownership of decisions made 

Description:  This activity requires all the students to plan a role play that will depict the 
importance of taking responsibility of decision made and their consequences.  

Time Guideline: 30 min 

Purpose:  To highlight the importance of responsibility 

Presentation: 

 

1- Call two volunteers from the class one who will act as customer and other 
as employee. 

2- Brief them about the role play that the employee will confess about a 
decision that caused some loss at client side and now he is ready to take 
the responsibility and make up for the loss. 

3- Encourage the students to give suggestions. 
4- Have a discussion with students, what did they learn from this activity. 
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Learning Unit 2: Plan the Business Process Activities 

Overview 

In this learning unit, you will learn about different concepts and activities involved in the planning of 
the business process activities. After the completion of this learning unit, you will be able to assist the 
in-line managers, define activities like specific life cycle methodologies, estimate time for activities, 
and perform breakdowns of the work and leveling the resources. 
 

1. Provide due Assistance to In-Line Manager 

While working at a workplace, it is important and adds to good list that you provide assistance to the 
managers. You can provide assistance in the following tasks. 

Coordinating Recurring Meetings 

It is important that every meeting run as smoothly as it can. But this is especially important for recurring 
meetings when the same group of people regularly gather to accomplish the same goal.  

 Schedule recurring meetings properly using software like outlook 
calendar, or some other good schedule software so that can be kept 
informed about schedule every time.  

 Organize the meeting venue  

 Inform the attendees about the schedule and make the agenda of the 
meeting clear to them.  

 Make sure that documents to be used and other equipment like 
computer etc. are ready to use. 

Intimate Resource Availability 

A project plan is considered to be good if tasks are as clearer as possible and 
resources needed to accomplish those tasks are readily available. Before 
assigning individuals to tasks, associate a task with a resource type. Then 
enter the expected duration of that task based on the resource chosen. This 
ensure the intimate resource availability. 

Create and Keep Documentation 

You can assist in-line managers by maintaining the documents about 
meetings, resource assignments, project assignments and completion status, client history etc. This 
involves the creation and updating of documentation. Documentation provides a great help as a written 
proof and for future consultations. 

Validate Applicable Company Defined Standards 

It is definitely important to validate and follow established company standards for the duration of your 
employment. Be honest to yourself about your conduct and make adjustments where necessary. You 
should be informed and understand all the company standards but pay particular attention to the ones 
that are specific to your job role in the company. Try to help other employees to understand and follow 
the company applicable standards. 
 

Resources needed 
to be available can 
be machinery, 
equipment, human 
or time 

Remember 

The agenda of 
recurring meeting 
depends upon the 
management 
decision. It may be 
to present status 
report to attendees 
or to plan for the 
next phase. 

Do you know! 
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2. Define Activities 

In order to perform good project management, you should be able to apply specific life cycle 
methodology to the project development. During a project development, the undergone activities 
belong to some specific phase. It is necessary to define what phase an activiy belongs to. Application 
of life cycle methodology help a company to deliver projects effectively. The different phases of life 
cycle are: 

Requirement Gathering 

Requirement gathering is the first and the most important phase of any project development. The 
specifications of the project results are an outcome of requirements gathered. The acivities involved 
in this phase include interviewing the potential users or employees of the company about their needs 
for the final product (in case of new system replacing an old one, interviewing them about the problems 
they face in the existing system), verfication of the gathered information, documentation of information 
for further development. 

Design Solution 

During this phase, the gathered requirements are analysed and assesed to find out the problem. The 
activities in this phase include plans are laid out concerning the physical construction, hardware, 
operating systems, programming, communications, and security issues.  

 
Prototype  

At this phase, instead of freezing the requirements before a design or coding 
can proceed, a prototype is built to understand the requirements. This 
prototype is developed based on the currently known requirements. By using 
this prototype, the client can get an “actual feel” of the system, since the 
interactions with prototype can enable the client to better understand the 
requirements of the desired system. 

Testing 

After the prototype is approved, the life cycle proceeds to the final product that fulfills the gathered 
requirements. This product is then tested throughly using series of testing techniques. Product should 
be tested from every aspect and in all the possible conditions and audience. If any problem arise 
during testing, should be corrected. 

Documentation 

In this phase, the activities performed include, preparing documentation of the various area that need 
to be documented. This documentation can be used as written proof, can be used as a help for future 
consultation if some problem arises. 

 

 

 

A prototype is an 

instance of a 

working product, 

representing all the 

specification of final 

project. 

Prototype 
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3. Estimate Time 

Whether you bill clients hourly or on a per project basis, a necessary step of all 
projects is estimating the time it will take. You need to estimate time accurately 
if you're going to deliver your project on time and on budget. Without this skill, 
you won't know how long your project will take, and you won't be able to get 
commitment from the people required to help you achieve your objective. Not 
only does the client want to have an idea of how much money they will be 
spending, but they also need to plan around an estimated timeline. And you 
need to be able to ensure you have the time and resources necessary to 
complete the project. 

Time estimation depends on a number of factors, including how much experience you have with the 
type of work you’re doing. 
 
Identify the Product Deliverables 

The first step is to identify the main project (i.e. Website Redesign), and then pinpoint the specific 
deliverables associated with the project. For example, upon completion of the redesign, you will be 
providing the client with a newly designed website by transferring the site files and sending the client 
a CD or USB drive with the working files. 

Breaking the Project in Sub Tasks 

Next, take the project and break it down into simple tasks. At the end of this step, you will have a list 
of activities that will take us to the deliverables. Now, list all of the activities you identified in the order 
in which they need to happen. 

Estimate Time for Each Step 

The next step is to estimate time in hour for each task or activity, rounding up. To begin with, estimate 
the time needed for each task rather than for the project as a whole. Then take the total time for all of 
the tasks and add in a buffer. The buffer can be anything, although I usually stick with a 10-25% 
addition. This helps to deal with any unexpected situations or challenges that arise. 

Things to Keep in Mind 

Following points need to be kept in mind while calculating total time required by a project 

 Project management time 

 All the constraints that are relevant, it will help to identify risks. 

 Consider calendar year official leaves,  
Work timings of the company. 

 Debugging 

 

 

 

 

Time estimation 
depends on a 
number of factors, 
including how much 
experience you have 
with the type of work 
you’re doing. 

Remember 
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4. Level Resource due to Work Load 

Research indicates that it is not just the amount of work that makes a difference in employee 
satisfaction and success, but also the extent to which employees have the resources (time, equipment 
and support) to do the work well.  

Resource leveling is a technique in project management that deals with resource allocation and 
resolves any possible conflict that can arise from wrong allocation. When project managers take a 
project, they need to plan their resources accordingly. This helps an organization to avoid any conflicts 
and being able to deliver the project on time. Resource leveling is considered one of the key elements 
to resource management in the organization. 

An organization starts to face problems if resources are not allocated properly i.e., some resource may 
be over-allocated whilst others will be under-allocated. Both will bring about a financial risk to the 
organization.  

Key Elements of Resource Leveling 

The main aim of resource leveling is to allocate resource efficiently, so that the project can be 
completed in the given time period. Resource leveling can be broken down into two main areas.  

 Projects that can be completed by using up all resources, which are available and projects that 
can be completed with limited resources. 

 Projects, which use limited resources can be extended for over a period of time until the 
resources required are available.  

Process of Resource Leveling 

Resource leveling helps an organization to make use of the available resources to the maximum. The 
idea behind resource leveling is to reduce wastage of resources i.e. to stop over-allocation of 
resources. 

Project manager will identify time that is unused by a resource and will take measures to prevent it or 
making an advantage out of it.  

By resource conflicts, there are numerous disadvantages suffered by the organization, such as: 

 Delay in certain tasks being completed 

 Difficulty in assigning a different resource 

 Unable to change task dependencies 

 To remove certain tasks 

 To add more tasks 

 Overall delays and budget overruns of projects 
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Learning Activity 

Proactive Approach 

Description:   This activity depicts the importance of taking extra responsibility to help others. 

The supervisor is busy doing a task with a tight deadline, and the employee 
finishes the assignment the supervisor had given.  

Instead of sitting and waiting for the supervisor to come and assign more work, 
employee finds something that needs to be done around the workplace and 
proactively completes the task.  

Time Guideline: 30 min 

Purpose:  To highlight the importance of proactive approach. 

Presentation:  

 

1. Call two volunteers from the class one who will act as supervisor and second 
as employee.  

2. Brief them about the role play that the employee finishes the assignment 
the supervisor had given, Instead of sitting and waiting for the supervisor to 
come and assign more work, employee finds something that needs to be 
done around the workplace.  

3. Encourage the students to step up to go beyond their assigned tasks. 
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Learning Unit 3: Awareness to Rights 

Overview 

In this learning unit, you will learn about their rights at the workplace. After the completion of this 
module, you will be able to define and know the importance of the policies, rules and regulations that 
administer the work and workplace, reporting the illegal conduct or illegitimate action to appropriate 
management and the importance of protecting the propriety or confidential information. 
 

1. Inform Ourselves and Uphold the Policies 

Policies, rules or regulations communicate an organization’s values and the 
organization’s expectations of employee behaviors and performance. 
Workplace policies support and clarify standard operating procedure in a 
workplace. They help organization to manage staff more effectively by clearly 
defining acceptable and unacceptable behavior in the workplace, and define 
the effects of not complying with those policies.  

A policy may also be required where there is a large number of interests and 
preferences, which could result in unclear and conflicting objectives among 
those who are directly involved.  

They set rules and guidelines for decision-making in routine situations so that 
employees and managers do not need to continually ask senior managers what to do. They help you 
to adopt a consistent and clear response across the company to continually refer to situations involving 
employee interaction.  

We should understand well and support these policies, rules, regulations and laws that govern our 
work, professional, and volunteer activities. These rules, regulation and policies protect business and 
workers and if correctly implemented and executed, create and maintain a better work environment for 
all. 

 

2. Report Illegal Conduct 

From time to time, workers may violate the policies or laws established for a 
business or company. Even if an employee breaks the rules with the best of 
intentions, the flow of the workplace can be impacted negatively.  

It is the responsibility of a worker to report illegal or illegitimate action to 
appropriate management. That needs to encourage employees to bring ethical 
and legal violations they are aware of to an internal or responsible authority so 
that action can be taken immediately to resolve the problem.  

It important to minimize the exposure of organization to the damage that can 
occur when employees circumvent internal mechanisms. For this purpose organization should let 
employees know the organization is serious about adherence to codes of conduct. 

The main barriers to lack of confidence in employees to report illegitimate conduct can be 

 A lack of trust in the internal system 

 Unwillingness of employees to be "informers" 

A policy is a 
statement which 
explains how human 
resource 
management issues 
will be dealt with in 
an organization. 

Policy 

In an organization a 
whistleblower is a 
person who raises a 
concern about a 
wrong doing in their 
workplace. 

Whistleblower 
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 Misguided union solidarity 

 Belief that management is not held to the same standard 

 Fear of revenge 

 Fear of isolation from peers  

It is the moral and social responsibility of the employees to report unethical or 
illegal conduct to appropriate management and if necessary to those affected 
by the conduct. If he sees any illegal behavior including but not limited to theft, 
fraud, corruption or bribery. Furthermore someone taking or abusing the 
property of others including intellectual property. 
 

3. Protect Propriety or Confidential Information 

Protecting confidential and proprietary business information, good will and 
relationships with clients, customers and key employees are matters of most 
important concern to any successful business. Theft of trade secrets, 
harassment of clients and customers, raiding of key employees, employee 
disloyalty and violations of trusty duties can cause irreparable loss. The 
Company’s confidential information falls into two main categories:  

a) Information developed and owned by Company.  
b) Information temporarily given to Company by its customers, collaborators and others.  

Every Company team member, whether a manager, employee or contractor, has a key role in 
maintaining the Company’s confidential information. Following policies can 
help to protect the company’s proprietary and secrets  

1- The Company should establish a written confidentiality protection guide 
and share it with all staff who interact with confidential information 
related to the Company. 

2- Upon hiring, each Company staff member should sign a contract that 
must include a confidentiality provision about their confidentiality 
promises. 

3- The staff member should refrain from disclosing a confidential 
information until management has provided clarification. 

4- A staff member should not disclose confidential information unless the staff member obtains 
authorization from management and the receiving party has signed a confidentiality agreement. 

5- Staff members should not store or keep open the confidential information on desktop or 
computer screen exposed to view when not actively used.  

6- A staff member should only share confidential information with only 
those staff members of other Company who need to know the 
information. 

7- The Company should prevent unauthorized user access to any 
electronic and physical areas containing confidential information.  For 
computers, staff members should password protect screensavers and 
password protect files. For hardcopy documents, staff members should 
limit the physical access to the document by locking the office door, 
locking a desk drawer, locking a filing cabinet, and / or restricting room 
access. 

8- A sender of an email should assume unauthorized readers will view the text and files contained 
in an unencrypted email.  A sender should not send sensitive data in an unencrypted email or 
file. 

It is unlawful to 
terminate an 
employee who 
reported, complains 
about some illegal or 
fraudulent conduct 
by an employer or 
co-workers. 

Do you know! 

All key staff 
members should 
read and become 
familiar with the 
guide.   

Remember 

Peer is someone at 
your own level. Peer 
comes from letin 
word “par” which 
means equal. When 
you are on par with 
some on you are 
peer. 

Peers 

Encryption is the 

conversion of data 

into a form that 

cannot be easily 

understood by 

unauthorized 

people. 

Do you know! 
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Learning Unit 4: Copyrights and Piracy 

Overview 

In this learning unit, you will learn about the concepts of copyright material, royalty free contents and 
things that can be used and that cannot be used. After the completion of this unit, you will be able to 
adapt and purchase copyright material and royal free contents and will develop a sense about what 
can be used and what cannot be used from internet or other resources.  
 

1. Purchasing Copyrighted Material 

There are many "authorized" services on the Internet that provide you the facility to purchase 
copyrighted material present online including music, ebooks, or motion pictures. By purchasing 
material through authorized services, you can avoid the risks of infringement liability. This will also help 
to avoid your exposure to other potential risks, such as viruses, unexpected material, or spyware, which 
are common in file sharing networks. 

 

Legitimate Providers of Copyrighted Material 

There are many Internet-based services that provide legal access to copyrighted material. They have 
contracted with the copyright holders to allow them to provide the material at a discounted or per piece 
price. Many of the services are also based on monthly subscriptions. It is the responsibility of the user 
to identify the legitimacy of a service. 

 

Using Copyrighted Material 

Many a times it becomes necessary for you to use copyrighted materials. You must assure permission 
in written to use the material from the copyright holder. If you know the copyright holder, you may 
contact them directly to get his permission for using his work. If you are not sure about the owner of 
the copyrighted material, you can request the information from the United States Copyright Office. 

 

2. Royalty Free Contents 

Royalty-free, means the right to use copyrighted material or intellectual property without paying the 
royalties or license fees for each use or per volume sold, or some time period of use or sales. In 
photography and the illustration industry, it means a copyright license where the user has the right to 
use the picture without restrictions based on one-time payment to the licensor. It doesn’t mean that 
you have bought the file outright. The user will pay for license once and use the image in many projects 
without a need to purchase additional licenses. Royalty Free licenses cannot be given on private basis. 
In stock photography, RF is one of the common licenses. 

A photo that is royalty-free might have licensed hundreds or even thousands of times, it might have 
appeared in different projects from major advertising campaigns to homemade postcards. 
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Advantages of Royalty Free License 

A royalty-free license helps you to: 

 To buy licensed contents, relatively inexpensive as compared to content shot expensive for 
your project. 

 Keep using the content again and again with no time limit. 

 Use the content in many different ways (i.e.: print, video, or on the web). 

Thing you can do with Royalty Free Files 

 Publish photos or text on websites or in web ads. 

 Use photos in print ads 

 Use these contents in printed promotional projects 

 Add video footage to commercial film and video 

 In books or on book covers, on CD and DVD covers, and in editorial content 

3. What to use and what not to use from Internet 

The biggest advantage of using the Internet as a research tool is the ease with which you can find 
information. The biggest disadvantage, then, is going through the crowd of information to find credible, 
reliable, accurate information. 

It is essential to evaluate online and other sources to assure that the material 
you take from them is credible, reliable, and accurate. 

Following points can help you to decide what is reliable at internet or other 
resources 

 If you fail to accurately evaluate your Internet and other information 
sources, it will question the credibility of your speech subject and require 
its intense scrutiny. 

 Consider the "age, depth, author and money" of every source you use from the Internet. 

 Top-level domain of a website can give you clues about the reliability of its contents. Generally, 
it's safe to trust information from sites with domain names that end in .edu, .gov and .ngo and 
sometimes .org. 

 While using and evaluating social media sources, you should be aware of sites that have a poor 
reputation for checking facts or moderating content. 

 

Social Media and Multimedia Sources 

The rapid growth of social media and its ability to distribute relevant information to multiple users based 
on shared interests and relationships has increased its importance in the world of Internet research. 
Wikipedia, one of the most popular research websites in the world, relies on scholarly material and is 
providing accurate, targeted, and comprehensive information to the users. 

Self-published media like e-books, newsletters, open wikis, blogs, social networking pages, Internet 
forum postings, or tweets should be used with caution. Self-published material may be acceptable 
when it has been produced by an established expert on the topic he has a good command on, and 
whose work in the relevant field has been previously published by reliable third-party publications and 
proved itself.  

 

  

The objective and 
subjective 
components of the 
believability of a 
source or message 
is called credibility. 

Remember 
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Summary of Module 

 If you make errors or omissions, take responsibility and make corrections instantly. If you come 
to know that the errors or omissions were caused by others, communicate them to the 
appropriate person as soon they are discovered. 
 

 Should inform ourselves about the rules and traditions of others and avoid engaging in 
behaviors they might consider disrespectful. 
 

 If you realize that you have a real or potential conflict of interest, avoid engaging in the decision 
making process or otherwise attempting to influence outcomes until you have made full 
disclosure to the affected stakeholders. 
 

 Do not engage in or ignore behavior that is designed to deceive others, making misleading or 
false statements, stating half-truths, providing information out of context or withholding 
information that, if known, would render your statements as misleading or incomplete. 
 

 You can provide assistance to the manager by coordinating meetings, intimate resource 
availability, creating and keeping documentation, validating company’s defined standards. 
 

 It is a professional approach to apply life cycle methodology to project and define its activities 
as phase like requirement gathering, planning design, prototype, testing and documentation. 
 

 You need to estimate time accurately if you're going to deliver your project on time and on 
budget. The first step is to identify the main project, take the project and break it down into 
simple tasks, estimate time in hour for each task or activity, then take the total time for all of the 
tasks and add. 
 

 Resource leveling is a technique in project management that deals with resource allocation and 
resolves any possible conflict that can arise from wrong allocation. 
 

 We should understand well and support these policies, rules, regulations and laws that govern 
our work, professional, and volunteer activities. 
 

 It is the moral and social responsibility of the employees to report unethical or illegal conduct to 
appropriate management and if necessary to those affected by the conduct. 
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Frequently Asked Questions (FAQs) 

FAQ 1:  
What are the four values that serve as the foundation of ethical and professional 
conduct? 

Answer These are Responsibility, Honesty, Fairness and Respect. 

FAQ 2:  What is meant by fairness? 

Answer 
Fairness is, our duty to make decisions and act neutrally and objectively. Our conduct 
must be free from competing self-interest, bias, and favoritism. 

FAQ 3:  What is recurring meeting? 

Answer 
Recurring meetings are where the same group of people regularly gather to accomplish 
the same goal. Its agenda may depend upon the company’s policy. 

FAQ 4:  What are the phases of life cycle? 

Answer 
The main phases of a life cycle are requirement gathering, design solution, prototype, 
testing and documentation. 

FAQ 5:  What is prototype? 

Answer 
A prototype is an instance of a working product, representing all the specification of final 
project. Prototype is developed to verify and asses customer’s needs about the final 
product. 

FAQ 6:  What is buffer in time estimate? 

Answer 
The buffer can be anything, although I usually stick with a 10-25% addition. This helps 
to deal with any unexpected situations or challenges that arise. 

FAQ 7:  What rule is used for work breakdown? 

Answer 
There is no hard and fast rule on how you should breakdown a task in work breakdown 
structure. Rather, the level of breakdown is a matter of the project type and the 
management style followed for the project 

FAQ 8:  What is meant by resource leveling? 

Answer 
Resource leveling is a technique in project management that deals with resource 
allocation and resolves any possible conflict that can arise from wrong allocation 

FAQ 9:  Why are policy important for an organization? 

Answer 
Workplace policies help organization to manage staff more effectively by clearly defining 
acceptable and unacceptable behavior in the workplace, and define the effects of not 
complying with those policies. 

FAQ 10:  What is copyright law? 

Answer 
Copyright is a law that protects any original creation, and grants the holder of the 
copyright exclusive control over when, how, and by whom their work may be copied, 
distributed, or exhibited. 
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Test Yourself! 
Please mark the correct one from the given options. You can check your answer with the Answer Key 
at the end of this module. 

1.  _____________ is our duty to take ownership for the decisions we make.  

a.  Respect b.  Honesty 

c.  Responsibility d.  Fairness 

2.  
 ____________________ refers to show a high regard for ourselves, others, and the 
resources assigned to us. 

a.  Respect b.  Honesty 

c.  Responsibility d.  Fairness 

3.  First step of life cycle methodology is _________________. 

a.  Design Solution b.  Requirement gathering 

c.  Testing d.  Prototype 

4.  Goal of work breakdown is _____________. 

a. 
Giving visibility to important work 
efforts. 

b. Giving visibility to risky work efforts 

c. 
Show clear ownership by task 
leaders 

d.  All of them 

5.  The idea behind resource leveling is ____________. 

a. Reduce wastage of resources b. Purchase resources 

c. Assign resources permanently d.  Estimate time for resources 

6.  Buffer in time estimate adds _________________ to time estimate. 

a. 30 – 40 % b. 25 – 35 % 

c. 5 – 10 % d.  10 – 25 % 

7.  Select the INCORRECT option: reasons to achieve work breakdown are: 

a. 
Accurate and readable project 
organization 

b. Point out the negative points in project. 

c. 
Indicates the project milestones and 
control points 

d.  
Helps to estimate the cost, time and 
risk. 
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8.  A policy is __________________. 

a. 
A statement which explains how 
human resource management issues 
will be dealt with in an organization. 

b. 
A rule that helps in estimating the time 
for project. 

c. 
A statement that describes the 
history concerns of the organization. 

d.  
All of them 
 

9.  
The unauthorized use or reproduction of another's work is called 
_________________. 

a. Copyright b. Royalty Free content 

c. Piracy d.  Trade Mark 

10.  Royal Free allows you to ______________. 

a. Purchase contents b. Change contents 

c. Purchase license d.  Both A and B 
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Answer Key 
MCQ Number Correct Answer 

1 c 

2 a 

3 b 

4 d 

5 a 

6 d 

7 b 

8 a 

9 c 

10 c 

 

 




